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Thank you for purchasing the drawing/editing software of ZM series for Windows95/NT (ZM-71SE).

This manual leads you to understand the outline and the functions of the drawing/editing software of ZM

series for Windows 95/NT (ZM-71SE) and to master it effectly, by making each example of each chapter.

Read this manual thoroughly to completely familiarize yourself with the operation according to the examples.

Keep this manual for future reference. We are confident that this manual will be helpful whenever you

encounter a problem.

• This module is made in accordance with Japanese domestic specifications. Its guarantee clauses
are described in a separate guarantee card (packed together with the module). When this module
is used outside Japan, these guarantee clauses are not applicable. In addition, the guarantee
should be understood as a guarantee of the delivered product as a single unit and every other
damages or losses due to damage or malfunction of the product will not be included in this guarantee.

• Should you have any questions and inquiries, please feel free to contact our dealers.
• The whole or partial photocopy of this booklet is prohibited.
• Contents of this booklet may be revised for improvement without notice.

Note

Note

• In this manual, ZM-70 and ZM-80 are expressed as follows.

Expression in this manual

ZM-70

ZM-80

Module name

ZM-41L, ZM-70D, ZM-70T, ZM-70L

ZM-42D/L, ZM-52D, ZM-72D/T, ZM-82D/T/TV



Color of ZM Series Monochrome Type

The following is the color list of ZM Series monochrome types.  Refer when editing a file.

*8-gradation colors may be flickering on ZM Series.  Using 2-gradation colors is
recommended.

*If the editing file which has 16 colors on the screen editing is changed into ‘8-
color’ editing file, each color is changed into the color of (     ).

Editing

Black (Gray)

Blue (Navy bule)

Red (Mahogany)

Magenta (Maroon)

Green (Pine green)

Cyan (Slate blue)

Yellow (Camel)

White (Silver-color)

ZM70L/41L ZM-42L

White

Blue

8-gradation

Black

White

8-gradation



Safety precautions

Read this manual and attached documents carefully before installation, operation, maintenance and
checking in order to use the machine correctly.  Understand all of the machine knowledge, safety
information, and cautions before starting to use.  In this instruction manual, safety precautions are ranked
into "danger" and "caution" as follows.

 Danger : Wrong handling may possibly lead to death or heavy injury.

 Caution : Wrong handling may possibly lead to medium or light injury.

Even in the case of Caution , a serious result may be experienced depending on

the circumstances.  Anyway, important points are mentioned.  Be sure to observe them
strictly.

The picture signs of Prohibit and Compel are explained below.

         : It means don’ts.  For example, prohibition of disassembly is indicated as ( ).

         : It means a must.  For example, obligation of grounding is indicated as ( ).

1) Installation

Caution

• Use in the environments specified in the catalog and instruction manual.
Electric shock, fire or malfunction may be caused when used in the environments of high
temperature, high humidity, dusty or corrosive atmosphere, vibration or impact.

• Install according to the manual.
Wrong installation may cause drop, trouble or malfunction.

• Never admit wire chips or foreign matter
Or fire, trouble or malfunction may be caused.

2) Wiring

Compel

• Be sure to ground.
Unless grounded, electric shock or malfunction may be caused.

Caution

• Connect the rated power source.
Connection of a wrong power source may cause a fire.

• Wiring should be done by qualified electrician.
Wrong wiring may lead to fire, trouble or electric shock.



3) Use

 Danger

• Don’t touch the terminal while the power is being supplied or you may have on electric shock.
• Assemble the emergency stop circuit and interlock circuit outside of the control terminal.

Otherwise breakdown or accident damage of the machine may be caused by the trouble of
the control terminal.

4)     Maintenance

 Prohibit

• Don’t disassemble or modify the modules.
Or fire, breakdown or malfunction may be caused.
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Opening and Closing a File

Opening and Closing a File

This chapter describes  how to open and close a file on ZM-71SE (screen editing

software for Windows 95/98/NT4.0).

11
Starting the Software

1. Double-click the program icon.  Or, click [Start] of Windows 95, and click

[Programs], [Zm-71s] then [ZM-71S].

2. The following ZM-71SE initial screen is displayed.

or
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or

Opening a New File
1. Click the [New] icon in the tool bar, or select [New] from the [File] menu.

2.  [Edit Model] dialog is displayed. Select the model name, then click [OK].

3. The [Select PLC Type] dialog is displayed.

Select as default (SHARP : JW series), then click [OK] to display [Screen [0]

Editing] window.

Opening a File
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When the type of the PLC was changed, [Communication Parameter] dialog is

displayed first, then [Screen [0] Editing] window is displayed.

4. The window can be adjusted to the desired size when necessary.

(Red frame size represents the size of the display of 800 x 600 dots.Red dotted line

represents the size of the editing model.)
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Or...

When [Editing Model: ZM-41 (320*240)] is selected, the following window will appear.
Screens should be editted within the dotted lines.

Opening an existing file
1. Click [Open] icon for [Open(O)] in [File(F)] menu.

2. A dialog to select the file will be displayed. Select a screen data file to be editted

then click [Open].
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Opening and Closing a File

2. Screen is closed.

If the modified data is not saved, the dialog appears to confirm whether the data

will be saved or not. Click either [Yes] or [No] to close the program.

Or...

Close button

3. Selected screen data file is open.

1. Click either [(Quit Application)] in [File(F)] menu or [Close] button.

Closing the software

En
d
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Creating a Screen Consisting of Characters and Bitmap Data

22 Creating a Screen Consisting of

Characters and Bitmap Data

You will create the following screen.

This is the initial screen to be displayed at start-up.

Procedure

1) Opening a new file • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • P2-2

Set up [Edit Model]  and [Select PLC Type].

2) Creating a screen title (screen editing) • • • • • • • • • • • • • • • • • • • • • • • P2-3

The [Text] icon in the draw tool bar is used.

3) Importing bit map data (screen editing) • • • • • • • • • • • • • • • • • • • • • • • P2-6

[Paste bitmap] in the [Tool] menu is used.

4) Creating logotype (pattern editing and screen editing) • • • • • • • • • • • • • P2-8

The [Text] icon in the draw tool bar is used for pattern editing.

The logotype is imported to the screen editing window using the draw tool

bar.

Pro
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Operation

Before Creating a Screen

After starting ZM-71SE, follow the procedure below:

1. Open a new file.

Click the [New] icon.  The [Edit Model] dialog and [Select PLC Type]  dialog are

displayed in sequence.  Set up as shown below:

Edit Model: ZM-82 (640*480 10.4 inches)

` Select PLC Type: SHARP: JW series

[Screen [0] Edit] window is displayed.

2. The draw tool bar is mainly used in this chapter.  Check the meaning of each icon.

Screen Color Change

At start-up, the screen color is black.  The color can be changed with the following

steps:

1. Click [Edit] menu.  The following pull-down menu is displayed.Click [Screen

Setting].  The [Screen Setting] dialog is displayed.

Line

Circle

Text

Pattern

Paint

Graphic Call

Bar graph scale

Dot

Trend graph scale

Pie graph scale

Screen Library
Multi Text

Box

Select

"ZM-70 (640*480) (16-

Color)" from "Edit Model".

ZM-70For
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2. In [Back Color], check blue for [F (foreground) ].  Click [OK].

3. The screen color is changed to blue.

Character Entry
1. Click [Text] icon in the draw tool bar.

The following [Screen Drawing] dialog is displayed.

The cursor blinks in the box.

2. Key in "Control Terminal".

Property Setting
1. Set up properties for "Control Terminal".

In the [Screen Drawing] dialog, check red for [Foreground] and yellow for

[Background].

The text image appears in the preview display.

Creating a Screen Title

O
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2. Enter "3" for [Enlarge X] and [Enlarge Y].

3. Set up the other options as follows:

Rotate: Normal     Transparent     Italic

Direction: RGT Normal 1/4        Bold Shadow

A variety of character types can be selected.

Transparent unchecked: Normal:

checked: 1/4(Invalid for 2-byte characters):

Italic unchecked: Bold:

checked: Shadow:

*  "Bold" is valid when Enlarge is X : 1 and Y : 1.

Background color

Placing the Text
1. Place the text on the screen.

Drag the mouse on the screen.

A dotted box of the text size is

displayed and moved with the mouse.

Control TerminalControl Terminal

Control Terminal

Control Terminal

Control Terminal

Control Terminal

Control Terminal

Control Terminal

Control Terminal

CC
Foreground Color

Background Color(Enlarged)

Drag the mouse on the screen.

A dotted box of the text size appears.

Drag

Preview display

Enlarge
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2. Upon releasing the mouse button, the text appears on the screen.

3. To adjust the text position, click the [Select] icon.   The mouse cursor changes

from a cross to an arrow.

Click the text.  Handles are shown

around the text.

Release the mouse button.

The text is displayed.Control TerminalControl Terminal

Click the text.

Eight handles are shown around the text.

Control TerminalControl Terminal

Control TerminalControl Terminal
[Select] icon

4. Drag the text to the upper center of the screen.

Control TerminalControl Terminal

To modify text properties (color or character type), click the [Detail/Prop. Change]

icon in step 3 (while handles are shown around the text) , or double-click the text.
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Bitmap File Import

With ZM-71SE, it is possible to import a bitmap file (extension: [.bmp]) to the screen

easily. Using this function, company logotype or graphics can be imported with ease.

Import the following bitmap data.

When ZM-71SE is installed, the bitmap data is also automatically installed into the

[\Zm-71s\Parts] folder under the file name of "panda.bmp".

1. When the [Screen [0] Edit] window is displayed, select [Paste Bitmap] from the

[Tool] menu.

The [Open a bitmap file] dialog is displayed.

2. Select [panda.bmp] from the "Parts" folder and click [Open].
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Drag the bitmap and release the mouse button.

The bitmap is placed in the position.

3. The dialog showing the bitmap is displayed.  When it is O.K., click the [Place]

button.

4. The above dialog disappears.  The cross cursor appears on the screen.  Drag the

cursor to the center of the screen.  A dotted box of the bitmap size also appears

with the cursor.

5. When the mouse is dragged to the center, release the mouse button.  The bitmap is

placed.

If the cross cursor is clicked without dragging after the [Place]

button is clicked, the bitmap is placed in the cursor position.  The

bitmap is placed on each click of the cursor.  To quit placing the

bitmap, click the [Select] icon and cancel the cross cursor.

Once a bitmap is placed on the screen, it is saved in the pattern edit file automatically.
Therefore, the bitmap is retained even if it is deleted from the screen.
By clicking the [Pattern] icon in the draw tool bar, bitmap data registered as patterns can
be checked.
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Creating Logotype

Characters in the desired font and size can be created and imported to the screen easily.

Such characters are created in the units of dots and saved in pattern edit file.

Create the logotype as shown below.

Entering the Dot Editing Area
1. Click the [Item] menu.  The following pull-down menu appears.  Click [Pattern].

Create this logotype.

2. The [Pattern] dialog for entering a pattern No. is displayed.  Check that "0" is

entered and click [OK].
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3. The [Pattern [0] edit] window is opened.

Check that the bitmap previously imported using [Paste bitmap] is registered as

pattern No. 0. Panda's ear

To delete the stored pattern (bitmap), open the window of the pattern number and select
[All delete] from the [Edit] menu.
Only the pattern in the opened window is cleared.

4. Store the logotype in pattern No. 1.  Click the [Next] icon in the tool bar to open

the [Pattern [1] Edit] window.

Click this icon.

Modifying the Dot Editing and Display Size
1. Adjust the editing area size to the text.

Select [Change Size] from the [Transform] menu.

O
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2. The following message appears.  Click [Yes].

3. The [Size Change] dialog is displayed.  Enter the desired values in dots as shown

below.  Click [OK].

X Size: 300

Y Size: 35 Color: 128-color

4. Decrease the [Zoom] value for convenient editing.

Select [Display Environment] from the [Display] menu.

The [Display Environment] dialog is displayed.  Select [200 %] and click [OK].

The window is decreased.

35dots

300 dots
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Matching the Area Color with the Screen Color
1. Click the [Paint] icon in the draw tool bar for pattern edit.

2. Because the screen color is blue, check blue for [Foreground] and click anywhere

on the dot editing area.  The area color is changed to blue.

Entering Text and Setting Text Properties
1. Click the [Text] icon. The [Pattern Drawing] dialog is displayed.

2. As done is the [Screen Drawing] dialog (Page 2-3), key in "ZM82 Series".

3. Set up text properties,such as font and size.Click [Font]. The following [font]

dialog is displayed.

Specified font image is displayed.

O
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In this example, set up as shown below:

Font:Times New Roman Style: Bold Size: 20

4. By clicking [OK], the [Pattern [1] Edit] window is displayed.

Select the desired colors.

Foreground: Red Background: Blue

5. Drag the mouse over the dot editing area.  The box of the text size is displayed.

Drag in this position.

6. Locate the mouse cursor in the center of the dot editing area, and click the mouse

button.   The text is displayed.  Now the text is registered as pattern No. 1.

Placing the Text on the Screen.
1. Click the "x" (close) button in the [Pattern [1] Edit] window.  The window is

closed and the [Screen [0] Edit] window is displayed.

Click in this position.

By selecting [Screen] from the [Item] menu, the [Screen [0] Edit] window is displayed
While the [Pattern [1] Edit] window is opened.

Click here to close the
[Pattern [1] Edit] window.
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4. Click the [Place] button.  The [Screen [0] Edit] window is displayed.

By dragging the mouse, the dotted box of the pattern size is displayed with cross

cursor.

Cursor appears here.

5. Move the cursor to the position as shown below and release the mouse button.

The text is displayed.

2. Click the [Pattern] icon in the draw tool bar.

3. The [Pattern List] window is displayed.

Select [0001].  The read cursor appears over [0001].

O
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Key in "Example1".

Saving the screen data

Save the created file.

1. Click the [Save] icon in the tool bar, or select [Save] from the [File] menu.

2. The following inquiry dialog appears.  Click [Yes].

3. The [Select a screen data to save] dialog is displayed.

Enter "Example1" in the text field and click the [Save] button.

Now this screen file is saved under the file name of "Example1.Z71".

Extension is [.Z71]

when a screen

data is saved.

ZM-70For
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33 Screen Data Transference

We will transfer the screen data (file name: "Example1.Z71") created in Chapter 2 to

ZM-70.

The process is different between ZM-70 and ZM-80. See P3-8 for the details.

 Operation

Before Data Transference

Start up ZM-70.

1. When the ZM-70 is turned on first (after being unpacked), the following screen is

displayed.

* The following screen is not displayed if screen data has already been

   transferred to ZM-70.

 Procedure

1) ZM-70 setup • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • P3-1

Turn on ZM-70 and connect it with a PC.

2) Connecting a PLC to ZM-70 • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • P3-2

Connect a PLC to ZM-70

3) Transferring the screen dat to ZM-70 • • • • • • • • • • • • • • • • • • • • • • • • P3-3

Transfer the screen dat from the PC to ZM-70

4) Communication start between ZM-70 and PLC. • • • • • • • • • • • • • • • • • P3-5

Press the [SYSTEM] key and [F 1] key of ZM-70 so that it start to run.

ZM
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D-sub 9pin

ZM Series

Personal Computer

ZM-82C

Modular�
8pin

MJ1

2. Connect ZM-70 to the computer with a data transfer cable "ZM-82C".  Screen data

transfer port on the ZM-80 side is "MJ1".

CN2

MJ2 MJ1

CN1

DC 24V
(＋)�
�

(－)�
�

TB1

Cable�
(Have a cable depending on PLC)

Connect the CN1 (D-sub 25 pin) of ZM-70�
with PLC using a communication cable.

PLC

Rear side of ZM-70

Adaptors are included in V6-CP set.
These adaptors are not necessary when DOS/V computer  is used.

3. Connect ZM-70 and a PLC in advance.

Match parameters such as baudrate or parity on the PLC side with

[Communication Parameter] on ZM-70 side.

4. Link ZM-70 to the PLC with a communication cable.

Communication connector on ZM-70 side is CN1 (D-sub 25 pin).

Have a proper communication cable for your PLC.

For the connecting instruction, refer to "Hardware Specifications" provided with

ZM-80.
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Transferring the Screen Data

1. On the ZM-71SE screen (on the computer), click the [Transfer] icon or select

[Transfer] from the [File] menu.

2. The [Transfer] dialog is displayed.

3. [Detail Setting ...] should be opened first.

Set as below :

[Serial port : (Select one to be used.) ]

[Baud Rate : 57600 bps]

4. Click [OK] to return to the [Transfer] dialog.

ZM
-70 O
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Maximum of the
baudrate varies
according to the
model of PC.
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7. "Main Menu" screen appears upon the completion of the data transfer.

I/F driver
This is a protocol file necessary for communication between ZM-70 and PLC or ZM-70 and a general-purpose

computer.  If the I/F driver does not conform to PLC connected to ZM-70, communication will not be executed

correctly.

5. Set up as shown below:

Transfer device : ZM-70

Transfer Data : Screen Data

    Use Simulator

    Read comments in data transfer

6. Click [PC->]. The [Transferring] dialog is displayed on the computer.

After the I/F driver data is transferred, the screen data is transferred.

Main MenuMain Menu

Screen Data �
    Information
Screen Data �
    Information
容量 :容量 :

PLC Type：SHARP JW Series�
Comment：�

       Error：Stop�
Time-Out：0.50 sec�
      Retry：3

 Connection：1:1　　　   Baud Rate：19200�
Signal Level：RS232C　 　  Data Length：7�
PLC Stat.No：0  　　　　        Stop Bit：1�
　　　　　　　　　　　             Parity：Even�
　　　　　　　　　　　   Send Delay：0msec

System InformationSystem Information
�
SYSTEM PROG. VER.1.000

FONT�
VER.1.000/1.000/1.000�
　　   ENGLISH

I/F DRV VER. 1.000�
　MELSEC JW

1998- 9- 1　07：23：30

Editor : MJ1
  I／O Test　�Memory-Card

ZM-72T

786432

The [Transferring] dialog on the computer. After the I/F drive data is transferred, the screen data is transferred.
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ZM-80  Operation Check

1. Make sure whether ZM-70 is connected to the PLC.  Press [SYSTEM] key.

The screen created on the PC appears.

If Communication between ZM-70 & PLC Is Not Successful:

ZM
-70 O
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S�
Y�
S�
T�
E�
M

M�
O�
D�
E

S�
Y�
S�
T�
E�
M

M�
O�
D�
E

The screen created on the computer is displayed.

Pi！�

PLC

If "Communication Error" Appears on the ZM-70 :

Communication Error

Time-Out
Screen No.：� Received Code No.：�

ＲＥＴＲＹ�
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The possible causes are as follows:

• An incorrect PLC type is selected.

Check if a correct PLC type is selected in the [Select PLC Type] dialog when a

new screen is opened.

• The cable is connected incorrectly.

Check if the cable is connected to the correct pins.

Check the cable for breakage.

• The communication parameters set up for PLC and ZM-80 are not in conformity.

Check the parameter contents.

If "Screen No. Error" Appears on the ZM-70 Screen:

Check if a screen number which does not exist is entered for the memory address "n+2"

of the read area.

Read area
[Read Area] is set up in the [Comm. Parameter] dialog.  To bring up the dialog, select [System Setting] from the

[Item] menu and click [Comm. Parameter].

Check

Screen No. Error

The read area is for transferring mainly screen display commands from an external

device (PLC, etc.) to ZM-70.

Three consecutive words are assigned to the read area.

(When [Buffering Area Setting] is used, more words are necessary.)

The contents are:
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When communication starts between PLC and ZM-70, the screen of the number stored

in the read area "n+2" is opened first.

If the screen number does not exist, the "Screen No. Error" message is given.

<Ex.>

D00000 is entered for [Read Area] for the file "Example1.Z71".

Therefore:

D00002 = 0  Screen No. 0 is indicated.

D00002 = 10 "Screen No. Error" is given.

(Because screen No. 10 is not included in the "Example1.Z71" file.)

The screen number displayed on the ZM-70 screen is written to the Write Area "n+2".

Write Area
[Write Area] is set up in the [Comm. Parameter] dialog.  To bring up the dialog, select [System Setting] from the

[Item] menu and click [Comm. Parameter].

The write area is for writing mainly screen status data from ZM-80 to an external device (PLC, etc.).

The contents of the three words and those of the write area are mostly in pairs.

The screen number to be displayed is commanded from the "n+2" Read Area to ZM-70,

and the screen number displayed on ZM-70 is written to the "n+2" Write Area.

ZM
-70 O
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n RCVDAT Sub command

Address Name Contents

n + 2

SCRN_COM Screen status commandn + 1 

SCRN_No External screen number command

Similar to the Read Area,  three consecutive words are assigned to the Write Area.

The contents are:

n CFMDAT Same as those in the read area "n"

Address Name Contents

n + 2

SCRN_COM Screen statusn + 1 

SCRN_No Display screen number
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ZM-70 Operation

ZM-70 Procedure

1) ZM-70 setup • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • P3-8

Bring up the "Main Menu" screen on ZM-70 and set in a stop.

2) Screen data transference • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • P3-10

Transfer the screen data from the computer to ZM-70.

3) Connecting ZM-70 to PLC • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • P3-12

Connect ZM-70 to PLC after transferring the screen data to ZM-70.

4) Communication start between ZM-70 and PLC. • • • • • • • • • • • • • • • • P3-12

Press the [SYSTEM] key and [F 1] key of ZM-70 so that it start to run.

POWER RUN

SYSTEM

F   2

F   3

F   1

F   4

F   5

F   6

F   7

Check

PLC I/F Driver not setting

SYSTEM

F   2

F   3

F   1

SYSTEM

F   2

F   3

F   1

S�
Y�
S�
T�
E�
M

M�
O�
D�
E

Pi !

S�
Y�
S�
T�
E�
M

M�
O�
D�
E

Press the SYSTEM key to call up the menu. Press the F1 key�
 while the "Mode" menu is displayed.

Start up ZM-70

1. When the ZM-70 is turned on first (after being unpacked), the following screen is

displayed.

2. Press the [SYSTEM] key and then the [F1] key on ZM-70.

Before Data Transference
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3. The "Main Menu" screen is displayed on ZM-70.

The following message appears in the left corner of the screen.

The message may be ignored because it means that ZM-70 is new and stores no

screen data yet.

ZM
-70 P

ro
c

e
d

u
re

POWER RUN

SYSTEM

F   2

F   3

F   1

F   4

F   5

F   6

F   7Memory-CardI/O Test

Main Menu�
Ver1.25　　1M

PLC Type:�
Comment:

  Signal Level: RS422�
   Connection: Multi-Link�
PLC Stat.No.: 31�
    Baud Rate: 38400�
  Data Length: 8�
         Stop Bit: 2�
            Parity: Even

       Error: Retry�
Time-Out: 42.94 sec�
       Retry: 255�
       Code: BCD�
Character: MSB -> LSB

Multi-Link NetworkMulti-Link Network
Own Stat.No.:
    ZM70 Total:
   Send Delay:       msec
              Retry:

ZM-70TZM-70T

ZM-70 ROM Version ZM-70 Type

FP-ROM Capacity�
("1M" appears for 1M byte.�
 Nothing appears for 512K bytes.)

PLC I/F Driver not setting

This message appears when a new ZM-70 is turned on first.

PLC I/F DRV.PLC I/F DRV.                                   Ver.�
Name: 1997-　4-　1　10:10:00

4. Connect ZM-70 to the computer used for screen editing using the screen data

transfer cable.  For a DOS/V computer, use our cable ZM-82CV.

*[ZM-82C]

ADP25-M

D-sub 25pinD-sub 9pin

ZM Series
ZM-82C

DOS/V computer

Modular�
8pin

POWER RUN

SYSTEM

F   2

F   3

F   1

F   4

F   5

F   6

F   7

*[ZM-82CV]

ZM Series
DOS/V computer

POWER RUN

SYSTEM

F   2

F   3

F   1

F   4

F   5

F   6

F   7

D-sub 25pin

ZM-82CV

D-sub 9pin
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Transferring the Screen Data

1. On the ZM-71SE screen (on the computer), click the [Transfer] icon or select

[Transfer] from the [File] menu.

2. The [Transfer] dialog is displayed.

Set up as shown below:

Transfer Device : ZM-70

Transfer Data : Screen Data

    Use Simulator

    Read comments in data transfer

Click [PC -> ].

When the screen data is transferred first, the I/F driver data is

also transferred automatically.

3. The [Transferring] dialog is displayed on the computer.  After the I/F driver data is

transferred, the screen data is transferred.

The ZM-70 screen also brings up the [Transferring] dialog.
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POWER RUN

SYSTEM

F   2

F   3

F   1

F   4

F   5

F   6

F   7

1997-　4-　1　10:10:00

Memory-CardI/O Test

Main Menu�
Ver1.25　　1M

PLC Type:�
Comment:

  Signal Level: RS422�
   Connection: Multi-Link�
PLC Stat.No.: 31�
    Baud Rate: 38400�
  Data Length: 8�
         Stop Bit: 2�
            Parity: Even

       Error: Retry�
Time-Out: 42.94 sec�
       Retry: 255�
       Code: BCD�
Character: MSB -> LSB

Multi-Link NetworkMulti-Link Network
Own Stat.No.:
    ZM70 Total:
   Send Delay:       msec
              Retry:

ZM-70TZM-70T

PLC I/F Driver not setting

PLC I/F DRV.PLC I/F DRV.                                   Ver.�
Name:

This window appears during transference.

Receive Send

POWER RUN

SYSTEM

F   2

F   3

F   1

F   4

F   5

F   6

F   7

1997-　4-　1　10:10:00

Memory-CardI/O Test

Main Menu�
Ver1.25　　1M

PLC Type: SHARP JW series�
Comment:

  Signal Level: RS232C�
   Connection: 1:1�
PLC Stat.No.: 0�
    Baud Rate: 19200�
  Data Length: 7�
         Stop Bit: 1�
            Parity: Even

       Error: Stop�
Time-Out: 0.50  sec�
       Retry: 3�
       Code: DEC�
Character: LSB -> MSB

Multi-Link NetworkMulti-Link Network
Own Stat.No.:
    ZM70 Total:
   Send Delay:       msec
              Retry:

ZM-70TZM-70T

PLC I/F Driver Version

PLC I/F Driver Type

PLC Type and Comment�
 included in the screen data

PLC I/F DRV.PLC I/F DRV.                                   Ver 1.45�
Name: MELSEC JW

Communication Parameters

Multi-Link Setting
* Displayed only for the �

  multi-link connection type.

4. Upon completion of transference, the dialogs disappear.

On the ZM-70 screen, the PLC type selected when creating the screen on the

computer is displayed.  This means that the I/F driver data has been transferred

normally.

The [Transferring] dialog on the computer. After the I/F drive data is transferred, the screen data is transferred.

ZM
-70 O

p
e

ra
tio

n
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TB2

TB1

CN1

CN1

S1

CN6

CN2

CN3CN4CN7CN5

Rear side of ZM-70

Connect the CN1 (D-sub 25 pin) of ZM-70�
 with PLC using a communication cable.

PLC

Cable�
(Have a cable depending on PLC.)

POWER RUN

SYSTEM

F   2

F   3

F   1

F   4

F   5

F   6

F   7

1997-　4-　1　10:10:00

Memory-CardI/O Test

Main Menu�
Ver1.25　　1M

PLC Type: SHARP JW series�
Comment:

  Signal Level: RS232C�
   Connection: 1:1�
PLC Stat.No.: 0�
    Baud Rate: 19200�
  Data Length: 7�
         Stop Bit: 1�
            Parity: Even

       Error: Stop�
Time-Out: 0.50  sec�
       Retry: 3�
       Code: DEC�
Character: LSB -> MSB

Multi-Link NetworkMulti-Link Network
Own Stat.No.:
    ZM70 Total:
   Send Delay:       msec
              Retry:

ZM-70TZM-70TPLC I/F DRV.PLC I/F DRV.                                   Ver 1.45�
Name: MELSEC JW

Communication Parameters

ZM-70  Operation Check

Connection and Communication with PLC

1. Set up the same communication parameters such as baud rate and parity for ZM-

70 and PLC.

For ZM-70, check the "Main Menu" screen data.

For PLC, set up the data while referring to the PLC manual.

2. Disconnect the cable (ZM-82CV) between the computer and ZM-70.

Connect ZM-70 and the PLC with a communication cable.

(Use the CN1 connector used for screen data transference.)

Have a proper communication cable for your PLC.

For the connecting instructions, refer to "Hardware Specifications" provided with

ZM-70.

For ZM-41, use the
CN2 connector.
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SYSTEM

F   2

F   3

F   1

SYSTEM

F   2

F   3

F   1

S�
Y�
S�
T�
E�
M

M�
O�
D�
E

Pi !!

S�
Y�
S�
T�
E�
M

M�
O�
D�
E

POWER RUN

SYSTEM

F   2

F   3

F   1

F   4

F   5

F   6

F   7

RUN lamp lights up.

The screen created on the computer is displayed.

PLC

3. Press the [SYSTEM] key and the [F 1] key.  The screen created on the computer is

displayed on the ZM-70 screen.  The "RUN" lamp in the lower left corner lights

up, indicating that ZM-70 and PLC are communicating normally.

ZM
-70 O
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Creating Switches

44 Creating Switches

You will place a standard switch which sets/resets the specified bit in the PLC memory

when it is pressed/released, and will place four copy switches.

Also, you will create a screen change switch on the previous screen.

Procedure

1) Setting up the [Switch] dialog

• Switch part selection • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • P4-4

• Color and characters • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • P4-8

• Output memory setting • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • P4-11

• Function • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • P4-12

2) Placing a switch • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • P4-6

3) Making switch copies and setting up the [Switch] dialog • • • • • • • • • • •P4-12

4) Creating a screen change switch • • • • • • • • • • • • • • • • • • • • • • • • • • P4-14

Function setting, color and part shape modification

5) Placing a screen change switch on the previous screen • • • • • • • • • • •P4-15

P
ro
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re
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Operation

Creating a New Screen

Click the [Next] icon to open a new screen.

[Screen Skip] icon [Next] icon

When the [Screen Skip] icon is selected, a new screen cannot be opened by clicking the
[Next] icon.

Screen Color

Select the desired screen color.

1. Select [Screen Setting] from the [Edit] menu.  The [Screen Setting] dialog is

displayed.

2. Check white for [F (foreground)].

3. Click the [OK] button to quit the [Screen Setting] dialog.

Now the screen color is changed to white.

When a new screen is opened, it has the data of [Screen Setting] (except [Item Select
Memory]) set up for the previous screen.
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Create the screen title "Switches and Lamps".

1. Click the [Text] icon in the draw tool bar.  The [Screen Drawing] dialog is

displayed.

2. Key in "Switches and Lamps".  Set up text properties and place the title in the

upper center of the screen.

Foreground : Black Background : Purple

Enlarge X : 3 Enlarge Y : 3

Rotate : Normal Direction : RGT Shadow

3. Click the [Select] icon to close the [Screen Drawing] dialog.

Creating a Screen Title

[Select] icon

3) Enclose the title using the mouse.  The coordinates are as shown below.  A dotted
box appears.

Switches and LampsSwitches and Lamps
(Coordinates   0 : 0)

(Coordinates   639:79)
Dotted Box

4) Select [Align] from the [Edit] menu and click [Vertical Align] or [Horizontal Align].
5) The title is placed in the center of the dotted box.
6) To prevent the box from appearing again in the next operation, uncheck the

[ Selected Area] box in the [Align Setting] dialog and click the [OK] button.

To place the title in the center:
1) Select [Align] from the [Edit] menu and

click [Align Setting].  The [Align Setting]
dialog is displayed.

2) Check that [ Equal] is chosen for [Pitch].
Check the [Selected Area] box( ) and
click the [OK] button.
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Create a switch as follows.

[Switch] icon

Create this switch.

ZM-70For

Selecting a Switch Part

ZM-70 screen components, such as switches, lamps, numerical data display areas, and

overlap display areas, are registered as parts.

The basic parts are stored in the "Std.z7p" file.

(The file is stored in the "Parts" directory when the software is installed.)

The "Parts_e.z7p" file is also provided.

There are two types of the switch parts: standard and non-standard.

Part types No. 0 to 3 in the "Parts_e.z7p" file are the standard.

The methods of changing switch color and part shape differ between the standard and

the non-standard parts.  Choose the standard type in this example.

Under total available memory capacity for one screen, a maximum of 500 switches can
be created.

1. Click the [Switch] icon in

the tool bar.   The [Switch]

dialog is displayed.

Basic parts are

registered in "Std.zmp".

Also our "Parts_e.z7p"

is provided.
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2. Click the [Parts Select] button.  [Switch List (Std.z7p) ] is displayed.

3. Click [Parts File] and open the "Parts_e.z7p" file.

4. Select [0002] from [Switch List], and click the [Select] button.

5. The selected part appears in the preview display.

Switch part No. 0002 appears.

Preview display

ZM-70For
Change [Files of type]

to [*.z7p] to select ZM-

70 parts file.

Select "Parts_e.z7p",

then click [Open].
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Placing the Switch

Place the selected switch part on the screen.

1. Check that "0" is entered for [Division No.].

2. Click the [Place] button in the [Switch] dialog.

3. The switch area as shown on the right appears.  Move it to the lower left corner of

the screen and click the mouse.  The switch is placed as shown below:

When the switch area is dragged, it is moved along the switch grids.

To bring up the switch grids:
1) Select [Display Environment] from the [Display] menu.  The [Display Environment]

dialog is displayed.

Place the switch in this position.
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2) Click [Grid].  The [Grid] tab window is displayed.

3) Set up as shown below:
Grid Dsp.

Grid Color: Red
Grid Type: Switch

  * Place switches on switch grids.

4) Click the [OK] button and close the [Display Environment] dialog.

5) The switch grids are displayed on the screen.  Refer to <Fig. 1> below.

* The [ Place switches on switch grid.] box is checked as default.
Placing, moving, and enlarging a switch area is carried out along switch grids.
When the [Place switches on switch grid.] box is not checked, these operations are
carried out in the unit of dots.(1)

About switch operating area
A switch can be activated only when it is
pressed within the operating area.

To bring up the switch operating area:
1) Select [Display Environment] from

 the [Display] menu.
The [Display Environment] dialog
is displayed.

2) Check the [Area] box for [Detail].
3) Click the [OK] button to quit the

dialog.
4) A dotted box is displayed on the

screen.
Refer to <Fig. 1>.

<Fig. 1>

ZM-70For

Minimum

switch size
Switch grids

The dotted boxes show switch operating areas.

Minimum switch size
Switch grids

The dotted boxes show switch operating areas.

(1)
When the [Place switches on switch grids.] box is not
checked, these operations are carried out in the unit of
dots.
However, the switch operating area is always based on
the switch grids, and the switch becomes invalid in the
non-active area.  Refer to the following explanation for
the switch operating area.
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1

1

1

Enlarging and Reducing the Switch

Enlarge the switch by one size along the grids in the X- and Y-axis directions.

To enlarge the switch, drag a handle using the mouse as above (1) or (2).

Text in Switch

Enter text to be placed in the switch.

Place "AUTO".

[Detail/Prop. Change] icon

1. Double-clicking the switch or selecting the switch (handles are shown) and

clicking the [Detail/Prop. Change] icon brings up the [Switch] dialog.

2. Click [Character].  The [Character] tab window is displayed.

or

Cursor

(1) (2)
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3. While the cursor is placed in text field No. 0, click [Char. Prop.].

The [Char. Prop. [No. 0]] dialog is

displayed. Set up as shown below:

Char. Type : Normal

Foreground : White

Transparent

    Italic

Rotate : Normal

Direction : RGT

Enlarge X : 2 Y : 2

The [Char. Prop.] dialog can be set up for text in each text field.

4. Key in "AUTO" in text field No. 0.

A maximum number of characters in a line depends on switch size and character size.

5. Click the [OK] button.  The text is displayed in the preview display in the [Switch]

dialog.

1. Click [Main] in the [Switch] dialog.  The [Main] tab window is displayed.

2. By clicking the [ON] or [OFF] button, the switch ON color and OFF color can be

checked.

3. Check that [XOR] is chosen for [Draw Mode].

4. When the [ON] or [OFF] button is clicked, the switch colors are changed as

follows:

OFF color    Blue ON color Red

OFF frame color    White ON frame color Green

OFF character color    White ON character color Green

Checking the Switch Colors in the [Switch] Dialog
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About XOR and REP
For a standard switch part
XOR: Switch frame and character colors are XORed with the selected colors.

For XOR, refer to "Chapter 17 Graphic Display: Graphic Colors" in the Reference
Manual.

REP: They are drawn in the selected colors.

Lamps in Switches (ON/OFF)

Choose whether the lamp of the switch lights up (in ON color)/goes off (in OFF color)

in internal process when it is pressed/released ([Lamp Memory] box unchecked) or the

lamp lights up/goes off with external commands from PLC ([Lamp Memory] box

checked).

In this example uncheck the [Lamp Memory] box.
AUTO

When the [Lamp Memory] box is checked and when 3-notch part is selected, it is
 possible for one lamp to use three patterns of OFF, ON, and P3.  The lamp memory
 uses 2 bits in this case.

PLC

M 0～15

M16～31

.....

PLC Memory

.....

STOP

The lamp is not turned on�
 even when the switch is pressed. The lamp is turned on when the lamp memory�

 bit in the PLC memory is set.

STOP

STOP READY RUN

To turn on/off the lamp of the switch with external commands from PLC, check the [Lamp
Memory] box.
When the lamp memory bit in the PLC memory is set, the lamp lights up (in ON color).
When the bit is reset, the lamp goes off (in OFF color).
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Switch Output and Output Action

Set the switch output action so that when it is pressed/released, the specified PLC

memory bit is set/reset.

1. Check the [Output Memory] box ( ).

2. Click .  The [Memory Input] dialog is displayed.

PLC memory is used.

ZM-70 memory is used.
(Refer to the Reference Manual.)

Constant is used
instead of memory.

Value in memory card
is used for memory.

Click here to indicate
available memory
devices.

Use this keypad to
set values.

3. Set up as shown below:

Type : PLC memory

Memory : 09000-0

Click [OK] and return to the [Switch] dialog.

4. Select the desired option for [Output Action] so that the output to PLC is executed

when the switch is pressed.

To set/reset 09000-0 when the switch is pressed/released in this example, select

[Momentary] for [Output Action].

"R" memory is bit-writable.

[Momentary], [Set], [Reset], [Alternate] or [Momentary W] can be selected for [Output
Action].

      Switch Action     Action output processing

Set When the switch is pressed, the specified bit is set (ON).

Reset When the switch is pressed, the specified bit is reset (OFF).

*Momentary When the switch is held down, the specified bit is set (ON),
 (Momentary W) and when it is released, it is reset (OFF).

Alternate Each time the switch is pressed, the specified bit is alternately
 set (ON) and reset (OFF).

* If the non-bit-writable memory is specified for [Output Memory], it is recommended to
select [Momentary W].  In this case, results are directly written in the one-word area of
the specified memory.

Available when
network is used.
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Switch Function

Set the function of the switch to be executed when it is pressed.

1. In this example, the switch should just set/reset the specified PLC memory bit

when it is pressed/released.  Therefore, no special function is required.

Check that [No Function] is selected for [Function].

To select a different option for [Function], click the [Change] button to bring up the
[Switch Function] dialog.  Select the desired one from the dialog.

2. Click [OK] to quit the [Switch] dialog.  The AUTO switch has been completed.

Copying the Switch

Make four copies of the switch (AUTO) and

complete them one by one.

1. Click the AUTO switch (handles are shown).

Click [Multi Copy] icon in the parts bar.

1st 2nd 3rd 4th 5th

Select [Multi Copy] from the [Edit] menu.

The [Multiple Copy] dialog is displayed.

2. Set up as shown below and click the [OK]

button.

Dot Direction: 
①②③
④⑤⑥

Interval

X Distance: 19 Quantity X: 5

Y Distance: 0 Quantity Y: 1

Memory INC

Switch Memory

09000-0 Step: 1

3. Five switches (the master switch

inclusive) are displayed.
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Completed

1st      2nd 3rd     4th           5th

4. Complete the MANUAL, RUN, and STOP switches.

(1) Double-click the 2nd switch.  The [Switch] dialog is displayed.

Open the [Main] tab window.  Set up as shown below:

Division No. : 0

Output memory : checked 09000-1

Lamp Memory :     unchecked

Output Action : Momentary

Function : No function

(2) Click [Character] in the [Switch] dialog.  The [Character] tab window is

displayed.

(3) "AUTO" is highlighted in the switch.  Key in "MANUAL".

(4) Click the [OK] button.  The switch is completed.

(5) For the 3rd switch, follow the same steps.

Bring up the [Main] tab window and set up as shown below:

Division No. : 0

Output memory : checked 09000-2

Lamp Memory :     unchecked

Output Action : Momentary

Function : No function

Bring up the [Character] tab window and key in "RUN".

(6) For the 4th switch, follow the same steps.

Bring up the [Main] tab window and set up as shown below:

As this switch is turned on/off with external commands from PLC, check the

[Lamp Memory] box.

Division No. : 0

Output memory : checked 09000-3

Lamp Memory : 09000-5

Output Action : Momentary

Function : No function

Bring up [Character] tab window and key in "STOP".

The MANUAL, RUN, and STOP switches have been completed.
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Creating a Screen Change Switch

 and Modifying Color and Part

Create a screen change switch "NEXT".

1st      2nd 3rd     4th           5th

Click [Screen].  Enter "2" for [Screen No.].  Click the [OK] button.

The [Main] tab window is displayed.  [Screen: 2] is entered for [Function].

1. Double-click the 5th switch.  The [Switch] dialog is displayed.

2. Set up the [Switch] dialog.

Division No.: 0

3. Although the [Output Memory] box is checked and "09000-4" is entered, uncheck

it.  Output is not made when the NEXT switch is pressed.

    Output Memory: unchecked

4. Lamp Memory: unchecked

5. When the [Output Memory] box is not checked, [Output Action] is ignored.

6. Click the [Change] button for [Function].

The [Switch Function] dialog is displayed.
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7. Change the switch color.

Click [Color] in the [Switch]

dialog.  The [Color] tab window

is displayed.

8. Set up as shown below:

Frame Color : Blue

ON Color : Yellow

OFF Color : White

9. Choose the desired type from the following standard switch parts.

No Frame Type 1 Type 2 Type3

Select [Type 3] for [Frame Type] in this example.

10. Change the switch text.

1) Click [Character] in the [Switch] dialog.  The [Character] tab window is

displayed.

2) To change character color, click [Char. Prop.] to display the [Char. Prop.]

dialog.

3) Check blue for [Foreground], and set enlargement to X:1, Y:2, then click the

[OK] button.

4) Key in "NEXT" in text field No.0.

11. Click the [OK] button.

12. For centering the characters on the switch,

select [NEXT] switch then select [Switch/

Lamp Centering] from [Edit] menu.

The NEXT switch has been completed.
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Place the screen change switch on screen No. 0.

[Previous] icon

1. Click the [Previous] icon to bring up the previous screen No. 0.

[Switch] icon

Add this switch.

2. Click the [Switch] icon in the tool bar.  The [Switch] dialog is displayed.

3. Bring up the [Main] tab window.  Set up as shown below:

Parts Select : No. 0002 in [Switch List Parts_e.z7p]

Division No. : 0

Output memory :  unchecked

Lamp Memory :  unchecked

Output Action : Momentary (to be ignored)

Function : Screen: 1

4. Bring up the [Character] tab window.  Key in "NEXT".

Set up properties as shown below:

Char. Type : Normal

Foreground : White

Transparent: checked  Italic : unchecked

Rotate : Normal

Direction : RGT

Enlarge X : 1 Y : 2

5. Bring up the [Color] tab window.  Set up as shown below:

Frame Color : White

ON Color : Red

OFF Color : Blue

ZM-70For

Select No.0002 from

"Parts_e.z7p"

Placing the Screen Change Switch

 on the Previous Screen
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[Save] icon

6. Click the [Place] button in the [Switch] dialog.

This step completes the NEXT switch.

7. Click the [Save] icon to save the created screen.

Switch operation check is explained in Chapter 5.
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55 Creating Lamps

On the screen created in Chapter 4, we will add lamps as shown below.

Procedure

1) Choosing a lamp part • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • P5-2

2) Placing lamps • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • P5-3

3) Lamp shape modification • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • P5-4

4) Setting up the [Lamp] dialog • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • P5-8

5) Color change • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • P5-10

6) Making lamp copies and setting up the [Lamp] dialog • • • • • • • • • • • • P5-11

Create these lamps.

Pro
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Operation

Selecting a Lamp Part

Create lamp ①� as shown below.

Similar to the switch parts, the lamp parts consists of two types: standard and non-

standard.

Part types No. 0 to 3 in the "Parts_e.z7p" file are the standard.

The methods of modifying lamp color and part shape differ between the standard and

the non-standard.  Choose the non-standard type in this example.

1. Click the [Next] icon and open screen No. 1.

2. Click the [Lamp] icon in the tool bar.  The [Lamp] dialog is displayed.

Create this lamp.

[Lamp] icon
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3. Click the [Parts Select] button.  [Lamp List Parts_e.z7p] is displayed.

4. Select [0015] and click the [Select] button.

5. The part appears in the preview display in the [Lamp] dialog.

Placing the Lamp

Place the lamp part on the screen.

1. Check that "0" is entered for [Division No.].

2. Click the [Place] button in the [Lamp] dialog.

3. The lamp area is shown.  Place it above the switch on the extreme left.

Under the total available memory capacity for one screen, a maximum of 500 lamps can
be created.

Place here.
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Part  Modification

Modify the lamp part as shown below:

The lamp part shape is modified in the [Modify Part] window.

When modifying the lamp which is off, check that [OFF] is chosen for [Switch/Lamp

Display].  When modifying the lamp which is on, check that [ON] is chosen for

[Switch/Lamp Display].

Lamp Modification for "OFF"
1. Check that the lamp displayed on the screen is off ([OFF] is displayed at the

bottom of the screen).

If not, select [Switch/Lamp Display] from

the [Display] menu and choose  [OFF].

2. Click the lamp part (handles are shown).  Click the [Change the setting of a part

placed.] in the tool bar.

Check here.

Place a circle on the lamp part.

3. The [Modify Part] window is displayed.
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4. Right-click the mouse.  The pop-up menu is displayed.  Uncheck [ON Grid].

5. Place a green circle on the lamp part.

1) Click the [Circle] icon in the draw tool bar.  The [Part Drawing] dialog is

displayed.

2) Uncheck the [Paint] box.  Set up as shown below:

Whether part color can be changed in the [Lamp] dialog is determined by an option
selection from [Frame Prop.].

* [Prop. Fixed] : Color cannot be changed in the [Lamp] dialog.
* [Frame] : Color can be changed by setting [Frame ON/OFF Color] in the

[Color] tab window opened in the [Lamp] dialog.
* [Area] : Color can be changed by setting [ON/OFF Color] in the [Color]

tab window opened in the [Lamp] dialog.

These options are also provided for the switch parts.

Foreground : Green
Line Type : No. 1

Select the desired option from
the [Frame] drop-down menu.

No. 1

6. Draw a circle and place it as shown on the right.

About enlarging the placed part
• The placed part can be enlarged by right-dragging the mouse

while holding down the CTRL key.

400 % zoom: 200 % zoom:
Drag as shown above. Drag as shown above.

• By pressing the [HOME CLR] key, the initial window display is
restored (the screen zero point: the top left corner; zoom: 100
%).

Drawn circle

Frame

Drag
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• Select [Zoom] from the [Display] menu.  Select the desired
option: 400 %, 200 %, 100 %, or 75 %.

7. Click the [Frame Auto Fit] icon.

[Frame Auto Fit] icon

Frame
This shows the part area.

[Frame Auto Fit] icon
When this icon is clicked, the part including the drawn figure is enclosed in the frame.

The circle is enclosed in the frame.

The OFF lamp has been completed.

8. Proceed to creating the ON lamp.

Select the lamp entirely by dragging the mouse.  While holding down the CTRL

key, press "C".  Or, select [Copy] from the [Edit] menu, or click the [Copy] icon.

The lamp is copied.

9. Select [Quit Part Modifying] from the [File] menu.  The window is closed and the

screen is displayed.

Lamp Modification for "ON"
Modify the lamp when it is on.

10. Select [Switch/Lamp Display] from the [Display] menu and choose [ON].

Frame

[Copy] icon

11. Select the lamp (handles are shown) for modification.  Click the [Change the

setting of a part placed.] icon.
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12. The [Modify Part] window is displayed.

13. Select the painted circle and delete it.

14. While holding down the CTRL key, press "V".  Or, select [Paste] from the [Edit]

menu, or click the [Paste] icon.  The lamp copied in step 8 is pasted.

When the list of placed parts should be referred to or when the desired part cannot be
clicked:

1 Select [Item List] from the [Tool] menu.  The [Item List] window is displayed.

[Paste] icon

Delete the painted circle.

2 When the part for modification is selected, the part in the [Modify Part] window is
also selected.

Selected.

Selected.

These marks mean as follows.
A: Area property
F: Frame
0: Division No.
(none): Fixed property

These are set in the [Part Drawing] dialog
for each part.  (Refer to page 5-10.)
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3 Select [Detail Setting] from the [Edit] menu. The dialog for the details of the part is
displayed. Modify the part as desired.
Modification of the [Lamp] dialog is not possible in the [Modify Part] window.
Return to the screen and make a modification.

4 Select [Quit Item List] from the [File] menu.

15. When [Quit Part Modifying] is selected from the [File] menu, the screen is

restored.

16. Select [Switch/Lamp Display] from the [Display] menu.  Select [OFF] so that

[OFF] appears at the bottom of the screen.

[Lamp] Dialog

[Detail/Prop. Change]
icon

Set up the [Lamp] dialog for the lamp.

1. Double-clicking the lamp or selecting the lamp (handles are shown) and clicking

the [Detail/Prop. Change] icon brings up the [Lamp] dialog.

2. Check that "0" is entered for [Division No.].

3. Select [Normal] for [Function].

4. Enter "09000-00" for [Lamp Memory].

5. Check that [REP] is selected for [Draw Mode].

6. Choose [High Speed] for [Process Cycle].
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Enter text to be placed in lamp.

1. Click [Character] in the [Lamp] dialog.  The [Character] drop-down menu is

displayed.

2. Check that [OFF] is indi-

cated as shown on the right.

3. Enter "1" for text field

No. 0.

Select [OFF].

4. While the cursor is placed in text field No. 0, click [Char. Prop.].  The [Char

Prop.[No. 0]] dialog is displayed.  Set up as shown below and click [OK].

Char. Type : Bold

Foreground : Black

Transparent

 Italic

Rotate : Normal

Direction : RGT

Enlarge X : 1  Y : 1

When [REP] is chosen for [Draw Mode], refer to the following.

Text for designating the lamp function
<When [REP] is chosen for [Draw Mode]>

1) Texts to be displayed when the lamp is on and off can be entered separately.
For the text for OFF, check that [OFF]
is chosen and enter the desired text.
For the text for ON, click [ON] and
enter the desired text.

2) Although [REP] is chosen for [Draw
Mode] in this example, the same text is
used when the lamp is on and off.
Therefore, after the text for OFF is
entered, entering the text for ON is not
necessary.
It is recommended that the lamp color and text color when the lamp is on are not
the same.

Click here.

Text in Lamp
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Lamp Color Change

Change the color of the lamp.

1. Click [Color] in the [Lamp] dialog.  The [Color] tab window is displayed.

2. Set up as shown below:

ON Frame Color : Yellow OFF Frame Color : Green

ON Color : Yellow OFF Color : Green

3. Click the [OK] button to quit the [Lamp] dialog.

<When [XOR] is selected for [Draw Mode]>
The same text is used when the lamp is on and off.  Enter the desired text for OFF.
The text for ON is displayed in a color determined by XOR operation.

About lamp color
Although lamp color is changed in the [Lamp] dialog, changing may not be possible in
certain cases.  Then bring up the [Modified Part] window and change color.
(Refer to page 5-7.)
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Copying the Lamp

Make four copies of lamp ①� and complete them one by one.

1. Click lamp ①� (handles are shown).

Click [Multi Copy] icon in the tool bar.  The [Multiple Copy] dialog is displayed.

3. Four lamps (the master lamp inclusive) are displayed.

4. Complete the 2nd, 3rd, and 4th lamps.

(1) Double-click the 2nd lamp.  The [Lamp] dialog is displayed.

Open the [Main] tab window.  Set up as shown below:

Division No. : 0

Function : Normal

Lamp Memory : 09000-01

Draw Mode : REP

Process cycle : High Speed

(2) Click [Character] in the [Lamp] dialog.  The [Character] tab window is

displayed.

(3) "1" is highlighted in the lamp.  Key in "2".

1st         2nd    3rd 4th

2. Set up as shown below and click [OK].

Line/Column

Interval

Direction: ①②③
④⑤⑥

X Distance: 5 Quantity X: 4

Y Distance: 0 Quantity Y: 1

Memory INC

Lamp Memory 09000-00 Step: 1
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ZM-70 Operation Check

(4) Click the [OK] button.

(5) For the 3rd and 4th lamps, follow the same steps.

Open the [Main] tab window and set up as shown below:

Division No. : 0

Function : Normal

Lamp Memory : 09000-02 (3rd) 09000-03 (4th)

Draw Mode : REP

Process cycle : High Speed

Open the [Character] tab window and key in "3" for the 3rd lamp and "4" for

the 4th lamp.

Now screen No. 1 has been completed.

Save the created screen.

While referring to "Chapter 3 Screen Data Transference", transfer the created screen

data to ZM-70 and check that ZM-70 operates correctly.

Used memory

   <Switch>
   No. Output memory        Lamp memory          OFF color          ON color
    1       M00000 None Blue Red
    2       M00001 None Blue Red
    3       M00002 None Blue Red
    4       M00003           M00005 Blue Red
    5         None None White Yellow

   <Lamp>
   No. Lamp memory           OFF color          ON color
    1       M00000 Green Yellow
    2       M00001 Green Yellow
    3       M00002 Green Yellow
    4       M00003 Green Yellow
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Screen Change Check

Screen No. 0 is displayed first.

Pressing the NEXT switch brings up screen No. 1.

• Changing the screen with an external command from PLC
Enter the desired screen number for the Read Area "n+2" (external screen number
command).  The Read Area is set up for [Read Area] in the [Comm. Parameter] dialog
(displayed by selecting [System Setting] from the [Item] menu.)

• Checking the screen currently being displayed in PLC
The Write Area "n+2" set up for [Write Area] in the [Comm. Parameter] dialog stores
the screen number currently being displayed.

• Notes on changing the screen by using both switch and PLC
Change the screen with an external screen
number command from PLC first.
Afterwards, the screen change switch is used
to change screens.
When the first screen should be displayed again
with a command from PLC, the command is
invalid because the read area "n+2" (external
screen number command) still stores the first
screen number.  In such a case, when bit 14
of "n+1" is set (0 -> 1), the screen of the number
stored in the read area "n+2" is displayed.

Screen No. 0

Screen No. 1

D001
D002

D000

5

Screen No. 5

No. 2

Screen No. 2

No. 0

Screen No. 0

No. 3

No. 2

No. 0

15　14　13　12　11　10　09　08　07　06　05　04　03　02　01　00

0　1　0　0　0　0　0　0　0　0　0　0　0　0　0　0
0　0　0 5

D000
D001
D002

Screen No. 5

No. 2

Read area "n+2" = 5
 = External screen number command

Screen forced switching (bit 14)

While screens are switched internally, 
"5" is still stored in the read area "n+2".

To bring up screen No. 5 again 
with an external command:

Set bit 14 (0 -> 1) of read area "n+1"
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2. Press the MANUAL switch.

The switch lamp lights up.

Lamp ②� lights up at the same time (M0001 is set).

When the MANUAL switch is released,

the lamp goes off automatically.

Lamp ②� goes off the same time (M0001 is reset).

3. Press the RUN switch.

The switch lamp lights up.

Lamp ③� lights up at the same time (M0002 is set).

When the RUN switch is released,

the lamp goes off automatically.

Lamp ③� goes off at the same time (M0002 is reset).

Checking Lamp Turning ON

1. Press the AUTO switch.

The switch lamp lights up.

Lamp ①� lights up at the same time (M0000 is set).

When the AUTO switch is released,

the lamp goes off automatically.

Lamp ①� goes off at the same time (M0000 is reset).

AUTO

1

1

M0000 ON

M0000 OFF

AUTO

MANUAL

2

2

M0001 ON

MANUAL

M0001 OFF

RUN

3

RUN

3

M0002 ON

M0002 OFF
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4. Press the STOP switch.

Lamp ④� lights up (M0003 is set).

When the STOP switch is released,

lamp ④� goes off (M0003 is reset).

5. Turn on the STOP switch lamp.

Set M0005 with a command from PLC.

The switch lamp lights up.

(Refer to "(6)" on page 4-13.)

STOP

4

4

M0003 ON

M0003 OFF

STOP

PLC

M 0～15

M16～31

.....

PLC Memory

.....

STOP

M0005

ZM
-80 O

p
e

ra
tio

n
 C

h
e

c
k



6-1

6

O
p

e
ra

tio
n

Creating PLC Numerical Data and Character Display Parts

Procedure

66 Creating PLC Numerical Data

 and Character Display Parts

You will create the following screen including PLC numerical data and character

display parts.

1) Setting up the [Num. Data Display] dialog

 and placing the numerical data display part • • • • • • • • • • • • • • • • • • P6-3

2) Making copies of the part and their modification • • • • • • • • • • • • • • • P6-7

3) Setting up the [Char. Display] dialog

 and placing the character display part • • • • • • • • • • • • • • • • • • • • • P6-10

4) Making copies of the part and their modification • • • • • • • • • • • • • • • P6-13

Operation

Creating a New Screen

Open  a new screen and place fixed texts.

1. Click the [Next] icon to open a new screen.

P
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Create screen No. 2.

2. Select [Screen Setting] from the [Edit] menu.  The [Screen Setting] dialog is

displayed.

Check white for [F (foreground)] and click [OK].

3. Click the [Text] icon in the draw tool bar.

4. Key in "Numerical Data and Character Display".   Set up text properties as shown

below and place it in the upper center of the screen.

Enlarge X: 2 Y: 2

Foreground : Black

Background : White

Rotate : Normal

Direction : RGT

 Transparent

 Italic

Normal

5. Click [Box] in the [Screen Drawing] dialog.  Set up as shown below:

Foreground : Yellow

Background : Black Paint

Frame Color : Black Frame

Tile : No. 0

Line Type : No. 1

[Next] icon

[Text] icon

Create this title.

6. Enclose "Numerical Data and Character Display" in a box.

7. Move the box to the back of the title.

Click the [Select] icon and select the box (handles are shown).  Click the [Move to

Back] icon.

No. 0

No. 1

[Select] icon
[Move to Back] icon



6-3

6

O
p

e
ra

tio
n

Creating PLC Numerical Data and Character Display Parts

8. Key in "<Numerical data display>" and "<Character display>".  Place them on the

left.  Set up properties as shown below:

Enlarge X: 1 Y: 1

Foreground : Black

Rotate : Normal

Direction : RGT

Transparent

 Italic

Normal

Creating Numerical Data Display Parts

Create the following numerical data display part.

[Num. Display] Dialog
1. Click [Num. Data Display] icon in the tool bar.  The [Num. Display] dialog is

displayed.

Create these texts.

Create this numerical data display part.

[Num. Data Display] icon

Preview display
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2. Click the [Parts Select] button.  [Num. Display List Parts_i.zmp] is displayed.

3. Select [0007] and click the [Select] button.

Part No. 0007 appears in the preview display in the [Num. Display] dialog.

[Main] Tab Window
1. In the [Num. Display] dialog, open the [Main] tab window.  Check that "0" is

entered for [Division No.].

2. The data stored in the assigned [Memory] is displayed on ZM-80.  Enter

"D00200" in this example.

[Type] Tab Window
1. Click [Type] in the [Num Display] dialog.  The [Type] tab window is displayed.

2. Select [No] for [Display Function].

"09200" entered for [Memory] in the previous step is displayed on the display part

on the screen.

3. Enter "4" for [Digits] and enter "0" for [Decimal Point].

Depending on the [Display Type] selection,
the available data range varies
as shown on the right.

Type Digits   Decimal point

 DEC 1 ~ 10        0 ~ 9

 HEX 1 ~ 8

 OCT 1 ~ 11

 BIN 1 ~ 32
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4. Select the code for displaying data that is read in the code specified by [Input

Type].  The available codes are: [DEC (w/o sign)], [DEC (w/- sign)], [DEC (w/+

sign)], [HEX], [OCT] and [BIN].  In this example, select [DEC (w/o sign)] for

[Display Type].

5. Choose either [BCD] or [DEC] for the code in the PLC memory.  Because

SHARP PLC is used in this example, select [DEC] for [Input Type].

6. Set up as shown below for other options:

Data Length 1-Word

Zero Suppress Flush R

• One numerical data display part can occupy two words at maximum.
The number of digits that can be displayed from one- or two-word memory depends on
the code selected.

• If the entered number of digits exceeds the specified range, extra digits from the right
are omitted.
<Ex.>

Data length: 1-Word No. of digits: 3
1234 ---> 123

This figure is not displayed.

  Code format        1-word range 2-word range

DEC (w/o sign) 0~65535 0~4294967295

DEC (w/- sign) -32768~32767 -2147483648~2147483647

DEC (w/+ sign) -32768~+32767 -2147483648~+2147483647

HEX 0~FFFF 0~FFFFFFFF

OCT 0~177777 0~37777777777

BIN 0~1111111111111111 0~11111111111111111111111111111111

[Char. Prop] Tab Window
1. Click [Char. Prop.] in the [Num Display] dialog.  The [Char. Prop.] tab window is

displayed.

2. Set up as shown below:

Char. Type : Normal

 Transparent

 Italic

Char. Size : 1-Byte

Rotate : Normal

Direction : RGT

 Spacing

Enlarge X: 2 Y: 2

Foreground : White

Background : Black

PLC in BCD format :OMRON C series; MITSUBISHI AnA/N series; FUJI H series, KOYO
                                 SU/SG
PLC in BIN format   : Models except the above
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[Detail] Tab Window
1. Click [Detail] in the [Num. Display] dialog.  The [Detail] tab window is displayed.

2. Uncheck the [Use Operation] and [Alarm] boxes.

3. Select [High Speed] for [Process Cycle].

Placing the Numerical Data Display Part
Place the numerical data display part.

Click the [Place] button in the [Num. Display] dialog.  A dotted box for numerical data

display area is displayed.  Drag the box to the desired position and click the mouse.

(Refer to the following figure.)

The numerical data display part has been completed.

The part has been completed.
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Copying the Numerical Data Display Part

Make seventeen copies of the numerical data display part.  In this example, consecutive

memory addresses are set up for the copies.

1. Click the placed numerical data display part (handles

are shown).

Select [Multi Copy] from the [Edit] menu.

The [Multiple Copy] dialog is displayed.

2. Set up as shown below and click the [OK] button.

Dot Direction

Interval

X Distance: 8     Quantity X: 6

Y Distance: 8     Quantity Y: 3

Memory INC

Num. Data Memory

09200 Step: 1

3. Eighteen numerical data display parts (the master inclusive) are placed.

18 parts are placed.

4. Check that the [Num. Display] dialog is set up as shown below for each copy.

Double-clicking each part brings up the dialog.

<[Main] tab window>

Division No.: 0

Memory: 09200 ~ 09242

In the [Multiple Copy] dialog, [             ] is selected for [Direction].

Therefore, memory addresses are allocated consecutively to the display parts

in the direction from left to right.

①②③�
④⑤⑥�

①②③�
④⑤⑥�
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<[Type] tab window> <[Char. Prop] tab window>

Display Function : No Char. Type : Normal

Digits : 4  Transparent

Decimal Point : 0  Italic

Display Type : DEC (w/o sign) Char. Size : 1-Byte

Input Type : DEC Rotate : Normal

Data Length : 1-Word Direction : RGT

Zero Suppress Flush R  Spacing

Enlarge X: 2 Y: 2

<[Detail] tab window> Foreground : White

 Use Operation Background : Black

 Alarm

Process Cycle : High Speed

Fig. 1

Memory data is displayed
on the computer screen.

Memory data can be displayed on a computer screen as shown in Fig. 1.
Select [Display Environment] from the [Display] menu.  The [Display Environment] dialog
is displayed.
Open the [Detail] tab window.  Select [Memory] for [Detail] and click [OK].

It is not necessary to allocate memory consecutively.

However, some PLC models can handle data more quickly when the

numbers are consecutive.
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Modifying Copied Numerical Data Parts

Modify the following numerical data parts.

1. Double-click the numerical data display part for modification.

2. The corresponding [Num. Display] dialog is displayed.

For the part allocated with 09236, choose [HEX] for [Display Type].

3. For the part allocated with 09240, enter "2" for [Decimal Point].

4. For the part allocated with 09242, enter "6" for [Digits], and consequently, choose

[2-Word] for [Data Length].

5. Because the last part assigned with 09242 overlaps with the adjacent part assigned

with 09240, drag the last part as shown below:

Modification has been completed.

[Display Type]: Choose [HEX].

[Decimal Point]: Enter "2".

[Digits]: Enter "6".
[Display Type]: Choose [DEC].
[Data Length]: Choose [2-Word]
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Character Display

Create the following character display parts.

[Char. Display] Dialog
1. Click [Char. Display] icon in the tool bar.  The [Char. Display] dialog is displayed.

2. Click the [Parts Select] button.  [Char. Display List Parts_i.zmp] is displayed.

3. Select [0007] and click the [Select] button.

Part No. 0007 appears in the preview display in the [Char. Display] dialog.

Create these character display parts.

[Char. Display] icon

Preview display
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[Main] Tab Window
1. Check that "0" is entered for [Division No.].

2. The data stored in the assigned [Memory] is displayed on ZM-80.  Enter "09250"

in this example.

[Type] Tab Window
1. Click [Type] in the [Char. Display] dialog.  The [Type] tab window is displayed.

2. Select [No] for [Display Function].

Only character display becomes valid.

3. Enter "8" (4-word) for [Bytes].

4. Choose [ Flush L].
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[Char. Prop] Tab Window
1. Click [Char. Prop.] in the [Char. Display] dialog.  The [Char. Prop.] tab window is

displayed.

2. Set up as shown below:

Char. Type : Normal

 Transparent

 Italic

Rotate : Normal

Direction : RGT

 Spacing

Enlarge X: 2 Y: 2

Foreground : White Background : Black

[Detail] Tab Window
Click [Detail] in the [Char. Display] dialog.  The [Detail] tab window is displayed.

Select [High Speed] for [Process Cycle].

The character display part has been completed.
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Placing a Character Display Part
Place a character display part.

Click the [Place] button in the [Char. Display] dialog.  A dotted box for character

display area is displayed.  Drag the box to the desired position and click the mouse.

Copying the Character Display Part

Make a copy of the character display part.

1. Click the character display part (handles are shown).

Select [Multi Copy] icon.  The [Multiple Copy] dialog is displayed.

2. Set up as shown below and click [OK].

Dot Direction

Interval

X Distance: 0 Quantity X: 1

Y Distance: 8 Quantity Y: 2

Memory INC

Char. Data Memory

09250 Step: 4

3. Two character display parts (the master inclusive) are placed.

Place the character display part here.

The character display part has been placed.

1 step = 1 word
8 bytes = 4 words

①②③�
④⑤⑥�
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4. Check that the [Char. Display] dialog is set up as shown below for the copy.

   <[Main] tab window> <[Char. Prop] tab window>

Division No. : 0 Char. Type : Normal

Memory : 09260  Transparent

 Italic

    <[Type] tab window> Rotate : Normal

Display Function : No Direction : RGT

Bytes : 8  Spacing

Flush L Enlarge X: 2 Y: 2

Foreground : White

         <[Detail] tab window> Background : Black

Process Cycle : High Speed

Screen No. 2 has been completed.

The following copy methods are available.

Copy by icons
Use the [Copy] and [Paste] icons in the edit tool bar.

Drag the switch while holding down the [CTRL] key.

Copy by [CTRL]+dragging
Click the part/figure.  While holding down the [CTRL] key, drag the part/figure to
the desired position and release the mouse.  The copy is placed in the position.

To place copies at equal intervals
Select [Multi Copy] icon in the tool bar.or select
[Multi Copy] from the [Edit] menu.
The [Multiple Copy] dialog is displayed.
Set up the dialog for the desired number of copies
and their spacing.
(Refer to page 6-7.)

[Copy] [Paste]

[Multi copy]
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ZM-70 Operation Check

Save the created screen.

While referring to "Chapter 3 Screen Data Transference", transfer the created screen

data to ZM-70 and check that ZM-70 operates correctly.

Used memory

<Numerical data display> <Character display>
No.     Memory   Code format Digits     Decimal point No. Memory    Bytes
  1        09200 DEC (w/o sign)     4 0   1          09220        8
  2        09202 DEC (w/o sign)     4 0   2          09222        8
  3        09204 DEC (w/o sign)     4 0
  4        09206 DEC (w/o sign)     4 0
  5        09210 DEC (w/o sign)     4 0
  6        09212 DEC (w/o sign)     4 0
  7        09214 DEC (w/o sign)     4 0
  8        09216 DEC (w/o sign)     4 0
  9        09220 DEC (w/o sign)     4 0
10        09222 DEC (w/o sign)     4 0
11        09224 DEC (w/o sign)     4 0
12        09226 DEC (w/o sign)     4 0
13        09230 DEC (w/o sign)     4 0
14        09232 DEC (w/o sign)     4 0
15        09234 DEC (w/o sign)     4 0
16        09236 HEX     4 0
17        09240 DEC (w/o sign)     4 2
18        09242 DEC (w/o sign)     6 0

Writing Numerical Data from PLC

Open screen No. 2 "Numerical Data and Character Display" and check with the

following steps.

1. By entering "0456" for "9200", "456" is displayed immediately.

2. By entering "1234" for "9202",  "1234" is displayed immediately.

3. By entering "9999" for "9204",  "9999" is displayed immediately.

4. By entering "4EA0" for "9236",  "4EA0" is displayed immediately.

SYSTEM

F   2

F   3

F   1

F   4

F   5

F   6

F   7

SYSTEM

F   2

F   3

F   1

F   4

F   5

F   6

F   7

0
0 0 0 0 0
0 0 0 0 0

0 0 0 0 0.00 0

0
0 0 0 0 0 0

0 0 0 0 0
0 0 0 0 0.00 0

<Numerical data display>

Numerical Data and Character Display

<Character display>

456

Numerical Data and Character Display

<Numerical data display>

<Character display>

ZM
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5. By entering "1289" for "9240",  "12.89" is displayed immediately.

6. By entering "0" for "9242" or "1" for "9244", "65536" is displayed immediately.

Writing Characters from PLC

When data is to be displayed in characters, it may be easier to illustrate memory

allocation by bytes.

Placing Multiple Numerical Data

A
B
C
D
E
F
G
H

LSB (0~7)

MSB (8~15)Memory "n"

Memory "n+1"

Memory "n+2"

Memory "n+3"

1st character
2nd character
3rd character
4th character
5th character
6th character
7th character
8th character

Memory "n"

Memory "n+1"

Memory "n+2"

Memory "n+3"

2nd character    1st character

B (42)               A (41)

2nd character    1st character

D (44)               C (43)

2nd character    1st character

F (46)               E (45)

2nd character    1st character

H (48)               G (47)

By entering "H4241" for "9220", "H4443" for "9222", "H4645" for "9224", and

"H4847" for "9226", "ABCDEFGH" is displayed immediately.

When displaying a greater amount of screen data, the display speed gets slower.

In such a case, the following methods should be effective.

1. To increase the display speed for all data:

Allocate memory in consecutive number.

2. To increase the display speed for the specified data:

For data which may be viewed slower when changed, choose [Low Speed] for

[Process Cycle].  Only for data which should be viewed in real time, choose [High

Speed] for [Process Cycle].

For details, refer to "Chapter 5 Screens" in the Reference Manual.
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77 Changing the PLC Memory Data

 through Keypad

You will create the following screen.

The desired values can be entered through the keypad to change the data in the PLC

memory.

Procedure

1) Setting up the display environment • • • • • • • • • • • • • • • • • • • • • • • • • • P7-3

Set up the display environment before placing parts.

2) Placing the keypad • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • P7-4

Use the entry mode parts tool bar.

3) Placing the entry target parts. • • • • • • • • • • • • • • • • • • • • • • • • • • • • • P7-6

Use the entry mode parts tool bar.

4) Placing the entry display parts. • • • • • • • • • • • • • • • • • • • • • • • • • • • • • P7-9

Use the entry mode parts tool bar.

5) Placing the maximum and minimum value display parts • • • • • • • • • • • P7-10

Use the entry mode parts tool bar.

6) Setting up entry mode • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • P7-11

Choose the [Detail] icon from the entry mode parts tool bar.

7) Checking the division number • • • • • • • • • • • • • • • • • • • • • • • • • • • • •P7-16

Check that the same division number is entered for 2, 4, 5, and 6.
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Operation

Creating a Screen Change Switch

On the previous screen No. 2, create a screen change switch to bring up the next screen.

1. Place a switch part as shown below.  Enter [Screen: 3] for [Function] in the

[Switch] dialog.

2. Click the [Next] icon to open the [Screen [3] Edit] window.

Screen Color Change

1. Select [Screen Setting] from the [Edit] menu.
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2. Check blue for [F] in [Back Color]

and Click [OK].

The screen color is changed to blue.

Setting Up Display Environment

Set up the [Grid] tab window so that screen parts can be placed with ease.

Grids
Grids are small dots placed at regular intervals on the screen for facilitating drawing or aligning.  [1-Byte (for

character)], [Switch (for switch)], [Mode (for overlap)] or [Free] can be selected for [Grid Type].

1. Select [Display Environment] from the [Display] menu.  The [Display

Environment] dialog is displayed.

2. Open the [Grid] tab window and set up as shown below:

Grid Dsp. ON Grid

Grid Color : White

Grid Type : Free

X Offset : 0    Y Offset: 0

X Pitch : 10    Y Pitch  : 10

Place switches on switch grids.

ON Grid
When this option is selected, a part/figure placed on the screen is snapped to the nearest grid.

However, an overlap part is moved by selecting [Mode] for [Grid Type] and a switch part is moved by selecting

[Switch] for [Grid Type], irrespective of the selection of [ON Grid].

(A switch part can be moved by selecting any other option for [Grid Type], but switch grids may be deviated.  It

is recommended to select [Switch] to move switches.)

[ON grid] can be selected also from the pop-up menu which appears by right-clicking the mouse.

3. Click [OK].  Grids are displayed on the screen.
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Creating a Screen Title

Placing a Keypad

1. Check that "0" is entered for [Division No.] at the top right of the screen.

When the above [Division No.] is set first, the same division number is automatically set
for the parts to be placed afterwards.
For information on the division number, refer to page 7-17.

2. Click the [Entry Mode] icon in the tool bar.

3. The entry mode parts tool bar is displayed on the right of the draw tool bar.  Click

the [Keypad] icon on the extreme left.

Numerical Data Entry Screen

1. Click the [Text] icon in the draw tool bar.  Key in "Numerical Data Entry Screen".

2. Set up text properties and place the text as shown below:

Foreground : Red Enlarge X: 2

Background : Light blue Enlarge Y: 2

Rotate : Normal     Transparent Italic

Direction : RGT Normal
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4. [Keypad List Parts_e.z7p] is displayed.  Click [0001] and [Select].

5. A keypad-size dotted box with cross cursor is displayed on the screen.  Drag the

box and click the mouse in the position as shown below.  The keypad is placed.

When the keypad has been placed, it is grouped.  To modify each switch position or
setting, click the keypad (handles are shown), and select [Ungroup] from the [Edit] menu
or click the [Ungroup] icon.

4 5 6 ▽�

7 8 9 △�

1 2 3 CLR

0 . +- ENT

Numerical Data Entry Screen

Drag the cross cursor
 and click it in the desired position.
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Placing a Numerical Data Display Part (Entry Target)

Place a numerical data display part to which data should be written.

1. Click the [Data Display] icon in the entry mode parts tool bar.

2. The following pull-down menu is displayed.  Choose [Numerical Data].

3. The [Num. Display] dialog is displayed.

Open the [Main] tab window.  Check that "0" is entered for [Division No.].

Open the [Type] tab window.  Check that [Entry Target] is selected for [Display

Function], and "0" is entered for [Order].

Order
This option determines the order of the cursor moving between data display parts.

The cursor appears at the numerical data display part specified with "0" when the screen is opened.

Data 1

Data 2

Data 3

Data 4

Data 5

1234

12

123.4

12.34

1234

4 5 6 ▽�

7 8 9 △�

1 2 3 CLR

0 . +- ENT

Max. value

Min. value

Entered value

1234

1234

1234
Place this part.
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4. Click the [Parts Select] button.  [Num. Display List] is displayed.

5. Click [0001] and

make sure that

the [Save setting]

box is checked.

Click [Select].

Part No. 0001 is

displayed in the

[Num. Display]

dialog.

When the [Save setting] box is not checked, the previously set data

for [Division No.], [Display Function], [Memory], etc. are cleared.

This should be noted whenever a part is selected from [Num.

Display List].

6. In the [Main] tab window, enter "09000" for [Memory].

Numerical data entered through the keypad is to be written to this address.

7. Set up the [Char. Prop.] tab window as shown below:

Char. Type : Normal Transparent Italic

Char. Size : 1-Byte

Rotate : Normal Direction: RGT Spacing

Enlarge X: 1 Y: 1

Foreground : White Background: Blue

8. Open the [Detail] tab window.  Set up the maximum and minimum values.

Check the [Alarm] box so that [Max.] and [Min.] setting becomes valid.  Set up as

shown below:

[Max.: 9999]

Max. Color Foreground: Red Background: Blue

[Min.: 0]

Min. Color Foreground: Red Background: Blue
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If an entered value is not in the range from specified min. value to max. value, the value
 is shown in the color selected for [Max. Color] or [Min. Color].  This function is valid only
when such a value is entered from PLC.  When a value not within the range is entered
through the keypad, the entry is rejected.

9. Place the numerical data display part as shown below by clicking the [Place]

button.

About transparency
For a numerical data or character display part, note the setting of [Transparent].

When a painted box is placed behind a part, the [Transparent] box must be checked.

4 5 6 ▽�

7 8 9 △�

1 2 3 CLR

0 . +- ENT

Numerical Data Entry Screen

1234

1234 1234

1234 11112222

Painted box

Without transparency

Background color

Foreground color
With transparency

Foreground color

Painted box

Background color

Foreground color Only Foreground color

When a part consists of only foreground and background colors without a painted box (for example, part No.

0001 in [Num. Display List Parts_i.zmp]), the [Transparent] box must be unchecked.
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Placing a Numerical Display Part (Entry Display)

Place a part for displaying the data keyed in through the keypad (before being written to

the memory).

1. Click [Entry Display] icon in the entry mode parts tool bar.

2. Choose [Numerical Data].  The [Num. Display] dialog is displayed.

Open the [Main] tab window.  Check that "0" is entered for [Division No.].

Open the [Type] tab window.  Set up as shown below:

Display Function : Entry Display

Digits: 4

Zero Suppress

Flush R

4 5 6 ▽�

7 8 9 △�

1 2 3 CLR

0 . +- ENT

Numerical Data Entry Screen

1234

1234

Specify the maximum number of digits for the placed entry target parts.  In this example,
enter "4" for [Digits].

3. Open the [Char. Prop.] tab window.  Set up as shown below:

Char. Type : Normal  Transparent  Italic

Char. Size : 1-Byte

Rotate : Normal Direction: RGT  Spacing

Enlarge X: 1 Y: 1

Foreground : White Background: Black

4. Place as shown below by clicking the [Place] button.
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Placing Max. and Min. Value Display Parts

Place max. and min. value display parts.

1. Place a max. value display part.

Click the [Max. Display] icon in the entry mode parts tool bar.

5. Place a min. value display part.  Click [Min. Display] icon.

Set up the [Num. Display] dialog and place the part as shown below:

[Main] tab window Division No.: 0

[Type] tab window Display function: Min. Display

[Char. Prop] tab window As same as the setting for the max. value display part

1234

1234

1234

4 5 6 ▽�

7 8 9 △�

1 2 3 CLR

0 . +- ENT

4 5 6 ▽�

7 8 9 △�

1 2 3 CLR

0 . +- ENT

1234

1234

1234

1234

2. The [Num. Display] dialog is displayed.  Set up as shown below:

[Main] tab window Division No.: 0

[Type] tab window Display Function: Max. Display

Digits: 4 Decimal Point: 0

Specify the maximum number of digits for the placed entry target parts.  In this example,
enter "4" for [Digits].

3. Set up the [Char. Prop.] tab window as shown below:

Char. Type : Normal  Transparent  Italic

Char. Size : 1-Byte

Rotate : Normal Direction: RGT  Spacing

Enlarge X: 1 Y: 1

Foreground : Yellow Background: Red

4. Place the part as shown on the

 right by clicking the [Place]

 button.
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Setting Up Entry Mode

Set up entry mode for controlling the screen.

1. Click [Detail] in the entry mode

 parts tool bar.

The [Entry] dialog is displayed.

2. Set up as shown below:

[Main] tab window [Detail] tab window

Division No. : 0 Use Graphic

Type : Data Display Default to 0

Command Memory : 09310         Process Cycle : Low Speed

Info. Output Memory: $u16340

Reverse

Target Memory Direct

Input Item Select Internal

     ZM-30 Compatible

Type: Data Display --- Data display parts for entry targets are placed on the base screen.
Command Memory: 09310 -------This is used as a control memory for releasing the

 keypad interlock, etc.
Info. Output Memory: $u16340 ---The selection order of the numerical data display part

 currently selected by the cursor is written.  (When it is
 not necessary, select [Internal Mem.].)

Reverse =  This option determines whether to highlight the data display area (in
 reverse video) currently selected as the entry target.

Target Memory: Direct  = Data in the selected data display area is written directly to the
    specified memory address.

Input Item Select: Internal = Up/Down switches on the screen are used to move the
      cursor.

Bit 15 of the command memory (Writing enabled/disabled)
Writing is disabled by default for the keypad in the entry mode (any keys other than UP
and DOWN do not work) because bit 15 of the command memory is off.
To use the keypad, set bit 15 (= H8000) of the memory.

3. Click [OK].

The [Entry] dialog is reduced to an icon and stored in the [Part] auxiliary tool box

in the lower left corner of the screen.  This step completes setting up entry mode.
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Copying the Numerical Display Part (Entry Target)

Make four copies of the numerical data display part to which data should be written.

1. Click the numerical data display part (for which

[Entry Target] is selected for [Display Function]).

Handles are shown around it.

2. Select [Multi Copy] icon in the tool bar.  The [Multiple Copy] dialog is displayed.

3. Set up as shown below:

Dot Direction

Interval

X Distance : 0 Quantity X : 1

Y Distance : 14 Quantity Y : 5

Order INC

Memory INC

Num. Data Memory   09310 Step: 1

4. Click [OK].  Four copies are placed under the top

 part vertically.

1234

1234

1234

1234

1234

1234

①②③�
④⑤⑥�
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5. Check the memory addresses allocated to the display parts.

Select [Display Environment] from the [Display] menu.  The [Display

Environment] dialog is displayed.

Open the [Detail] tab window.  Check the [Memory] box and click [OK].

6. Check that 09310 ~ 09320 are entered for the five parts respectively.

Changing the Display Format for Entry Targets

Open the [Main] tab window for each part and set up as shown below:

  Display Type Digits Decimal Point

1st part DEC (w/o sign)    4 0

2nd part DEC (w/o sign)    2 0

3rd part DEC (w/o sign)    4 1

4th part DEC (w/o sign)    4 2

5th part DEC (w/o sign)    4 0

Changing the Max. and Min. Values

 for Entry Targets

1. In the [Detail] tab window for each part, the [Alarm] box is checked, "9999" is

entered for [Max.], and "0" is entered for [Min.].

2. Change the data for [Max.] and [Min.] in each window.

     [Max.]       [Min.]

1st part 9999 0

2nd part 99 22

3rd part 5555(=555.5) 1111(=111.1)

4th part 7777(=77.77) 3333(=33.33)

5th part 9999 0

When the [Alarm] box is not checked in the [Detail] tab window,

[Max.] and [Min.] are not set up.  However, the max. number of

digits for the numerical data display part is set up for [Digits].
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Placing a Painted Box Behind the Parts

Drawing a Painted Box
Draw a painted box in the position as shown below:

1. Click the [box] icon in the draw tool bar.  The [Screen Drawing] dialog is

displayed.

2. For drawing a painted box in this example, open the [Box] tab window and check

the [Paint] box.  The following options appear in the window.

3. Set up as shown below:

Foreground : White

Background : Light blue

Frame Color : White

Tile : No. 1 (2nd from the extreme left)

Line Type : No. 1 (thick line: 2nd from the extreme left)

Painted box

Max. value

Min. value

Entered value

1234

1234

1234

Numerical Data Entry Screen

Paint type Line type
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4. Drag the cross cursor and draw a dotted box to enclose the placed parts on the

screen.  A painted box is drawn as shown below:

5. The parts are placed behind the painted box.

Click the [Select] icon and click the box (handles are shown).  Click the [Move to

Back] icon.  Now the parts appear on the painted box.

Numerical Data Entry Screen

Draw a dotted box to enclose the parts.

Click the [Move to Back] icon.

1234

1234

1234

The parts appear on the box.Click the box (handles are shown).

ta Entry Screenta Entry Screen
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Creating Texts
Create the following texts.

1. Click the [Text] icon in the draw tool bar.  The dialog for text entry is displayed.

2. Set up as shown below and place the texts as shown in the above figure.

Division Number Check

Check that the division number is set up correctly.

1. Select [Display Environment] from the [Display] menu.

Data 1

Data 2

Data 3

Data 4

Data 5

1234

12

123.4

12.34

1234

4 5 6 ▽�

7 8 9 △�

1 2 3 CLR

0 . +- ENT

Max. value

Min. value

Entered value

1234

1234

1234

Numerical Data Entry Screen

Foreground

Enlarge X 

Enlarge Y

Rotate

Direction

Transparent

Italic

Char. Type

Text
Prop. "Max. value"

Red

1

1

Normal

RGT

checked

unchecked

Bold

"Min. value"

Red

1

1

Normal

RGT

checked

unchecked

Bold

"Entered value"

Blue

1

1

Normal

RGT

checked

unchecked

Bold

"Data 1 (~5)"

White

1

1

Normal

RGT

checked

unchecked

Normal
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2. The [Detail] tab window is displayed in the [Display Environment] dialog.  Check

the [Div No.] box and click [OK].

3. The division number is entered for each part on the screen.

Check that all parts on the screen and the icon in the [Part] auxiliary tool box have

the same division No. 0.

If not, correct data setting so that all division numbers are set to "0".

Division number
A maximum of 256 divisions(No. 0 to 255) can be set up for the base screen and each overlap respectively.  You

can imagine that 256 transparent sheets are laid on top of each other.

When several parts (switch, numerical data display, display area) are combined to establish a function, such as

an entry mode, relay mode, and sampling mode, the parts must be set to the same division number.

Because the same division number is entered for the placed parts (keypad, max. value display part, etc.) in the

above example, they are linked with the entry mode and can function correctly.

The "Numerical Data Entry Screen" has been completed.  Save the file and transfer the

screen data to ZM-70.

Set all division numbers to "0".
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ZM-70 Operation Check

Opening Screen No. 3

1. Connect ZM-70 to PLC, and start communication.  Screen No. 0 including the bit

map data is displayed.

2. Press the NEXT switch.  Screen No. 1 is displayed.  Press the NEXT switch on the

screen.  Repeat these steps until screen No. 3 "Numerical Data Entry Screen" is

displayed.

Releasing the Keypad Interlock

When the keypad interlock is on, the keys make an error sound (beep) when pressed

and do not work.

Data 1

Data 2

Data 3

Data 4

Data 5

4 5 6 ▽�

7 8 9 △�

1 2 3 CLR

0 . +- ENT

Max. value

Min. value

Entered value

1234

1234

1234

Numerical Data Entry Screen

0

9999

0

0.0

0.00

0

0

0

The extreme right digit blinks.

Cursor is displayed.
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However, the upward and downward cursor keys are valid to move up/down the cursor.

By moving the cursor along the "Data" parts using the cursor keys, the max. and min.

values entered for each part are indicated.

To release the keypad interlock, follow these steps:

1. Check that in the [Main] tab window of the [Entry] dialog, "D150" is entered for

[Command Memory].  Click the [Entry] icon in the [Part] auxiliary tool box and

click the [Detail] icon in the entry mode parts tool bar.   The [Entry] dialog is

displayed.  Check the [Command Memory].

09310 is used to release the keypad interlock.

Data 1

Data 2

Data 3

Data 4

Data 5

4 5 6 ▽�

7 8 9 △�

1 2 3 CLR

0 . +- ENT

Max. value

Min. value

Entered value

0

9999

0

0.0

0.00

0

0

0

Any keys in the enclosed area
 do not work.

Data 1

Data 2

Data 3

Data 4

Data 5

4 5 6 ▽�

7 8 9 △�

1 2 3 CLR

0 . +- ENT

Max. value

Min. value

Entered value

Data 1

Data 2

Data 3

Data 4

Data 5

4 5 6 ▽�

7 8 9 △�

1 2 3 CLR

0 . +- ENT

Max. value

Min. value

Entered value

0

9999

0

0.0

0.00

0

0

0

Pi !

22

99

0

0.0

0.00

0

0

0

The max. and min. values for the selected part are indicated.Pressing the     key moves down the cursor.

ZM
-80 O

p
e

ra
tio

n
 C

h
e

c
k



Changing the PLC Memory Data through Keypad

7-20

2. Bit 15 of the memory D150 is the writing enabled/disabled bit.  Set bit 15 (D150 =

H8000).  Now the numerical keys and ENT keys of the keypad work.

3. Locate the cursor on the "Data 1" part.  Press "1" on the keypad.  "1" is entered for

"Entered value".

Press "5".  "15" is entered for "Entered value".

4. Press the ENT key.  "15" is written to "Data 1".  Check that "15" is written to

D160 (at [Memory] in the [Num. Display] dialog set up for "Data 1")

Data 1

Data 2

Data 3

Data 4

Data 5

4 5 6 ▽�

7 8 9 △�

1 2 3 CLR

0 . +- ENT

Max. value

Min. value

Entered value

1234

1234

12340

9999

0

0.0

0.00

0

0

0

All keys on the keypad become valid.

Pi !

Set bit 15 of D150.

D150

By pressing "5", "15" is entered for "Entered value".

Data 1

Data 2

Data 3

Data 4

Data 5

4 5 6 ▽�

7 8 9 △�

1 2 3 CLR

0 . +- ENT

Max. value

Min. value

Entered value

1234

1234

12340

9999

1

0.0

0.00

0

0

0 Data 1

Data 2

Data 3

Data 4

Data 5

4 5 6 ▽�

7 8 9 △�

1 2 3 CLR

0 . +- ENT

Max. value

Min. value

Entered value

1234

1234

12340

9999

15

0.0

0.00

0

0

0
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5. Locate the cursor on the "Data 2" part.  "Max. value" indicates "99" and "Min.

value" indicates "22".

Press "12" on the keypad.  "12" is entered for "Entered value".

When one more key ("3" for example) is pressed, the key makes an error sound

(beep) and does not work because the maximum available digits have already been

entered.

6. If the cursor is moved to the "Data 3" part before the [ENT] key is pressed, "Data

2" still indicates "0".

When "888.8" is keyed in and the [ENT] key is pressed while the cursor is located

on the "Data 3" part, the key makes an error sound (beep) and the entry is not

valid.  Any value exceeding the maximum available value cannot be entered.

Press [CLR] key to reset "Entered value" and key in a value within the allowable

range.

Data 1

Data 2

Data 3

Data 4

Data 5

4 5 6 ▽�

7 8 9 △�

1 2 3 CLR

0 . +- ENT

Max. value

Min. value

Entered value

1234

1234

12340

9999

0.0

0.00

0

0

15

15

Pi !

By pressing the [ENT] key, "15" is written to "Data 1".

"15" is written to D160.

D160 15

Data 1

Data 2

Data 3

Data 4

Data 5

4 5 6 ▽�

7 8 9 △�

1 2 3 CLR

0 . +- ENT

Max. value

Min. value

Entered value

1234

1234

123422

99

0.0

0.00

0

0

15

12

When a key is pressed while the maximum available digits
 have already been entered, the key does not work.

PiPiPi !
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About bit 14 (movement between entry items) of [Command

Memory]
It is recommended to set bit 14 (= H C000) when bit 15 of D150 (set up for [Command
Memory]) is set.
After a value is entered for an entry target part and the [ENT] key is pressed, the cursor
moves to the next part automatically.

If a value exceeding the max. available value is keyed in,
 the [ENT] key is not valid.

Data 1

Data 2

Data 3

Data 4

Data 5

4 5 6 ▽�

7 8 9 △�

1 2 3 CLR

0 . +- ENT

Max. value

Min. value

Entered value

1234

1234111.1

555.5

0.00

0

0

15

PiPiPi !

888.8

0.0

Press [CLR] key to reset "Entered value". Key in a proper value.

4 5 6 ▽�

7 8 9 △�

1 2 3 CLR

0 . +- ENT

Max. value

Min. value

Entered value

1234

1234111.1

555.5

0.00

0

0

15

0.0

0.0

Pi !

Data 1

Data 2

Data 3

Data 4

Data 5

4 5 6 ▽�

7 8 9 △�

1 2 3 CLR

0 . +- ENT

Max. value

Min. value

Entered value

1234

1234111.1

555.5

0.00

0

0

15

2.0

0.0

Pi !

When "1", "5" and [ENT] keys are pressed,

4 5 6 ▽�

7 8 9 △�

1 2 3 CLR

0 . +- ENT

Max. value

Min. value

Entered value

1234

12340

9999

0.00

0

0

15

0.0

Pi !

4 5 6 ▽�

7 8 9 △�

1 2 3 CLR

0 . +- ENT

Max. value

Min. value

Entered value

1234

123422

99

0.00

0

15

0

0.0

0

0

the cursor moves to the next entry target part
 automatically.
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Memory for Entry Mode

The screen uses the following memory addresses:

Questions and Answers

The following describes possible keypad problems and measures.

None of the keys on the keypad work.

--> The same division number may not be entered for the keys and the [Division

No.] in the [Entry] dialog.  The same division number must be set up.

(Refer to page 7-16.)

Although the up/down cursor keys work, the numerical and [ENT] keys do not work.

--> Bit 15 (writing enabled/disabled bit) of [Command Memory] in the [Entry

Dialog] may not be set.

Setting bit 15 should release the keypad interlock.

The cursor does not appear on the screen.

--> A memory address may be entered for [Item Select Memory] in the [Screen

Setting] dialog for the screen.

When a memory address is entered for [Item Select Memory], the cursor is

displayed only for the corresponding part.  Delete the address entry.

[Item Select Memory] (in [Screen Setting] dialog)
When the entry mode is used, whether entry target parts on the base screen are valid is
controlled by [Item Select Memory].
Bits from 0 of the memory address "n" respectively correspond to the numbers entered
for [Order] (in the [Num. Display] dialog) for entry target parts.  By setting a bit, the entry
target part of the corresponding [Order] number becomes valid for data entry and the
cursor is displayed.
Any entry target part having an [Order] number which corresponds to a reset bit becomes
invalid and the cursor is not displayed.

D150

D160�
�
D164
〜�

PLC -> ZM-70

ZM-70 -> PLC

Option

[Command Memory]

Address Contents Direction Set in:

Control memory for releasing
 the keypad interlock, etc.

[Memory]

[Entry] dialog

Memory to which values entered
 through the keypad are written

[Num. Display] dialog

4 5 6 ▽�

7 8 9 △�

1 2 3 CLR

0 . +- ENT

0.0

0.00

0

0

0

Pi !

89101112131415 01234567

00000000 1 1010000

When bits of the [Item Select Memory] address
 "n" are set as follows:

Ignored       Corresponding to [Order] numbers

The cursor moves between the entry target parts
 as indicated by the arrows. 
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88 Displaying the Keypad Only When

Necessary (Multi-Overlap)

It is possible to display the keypad on the screen only when necessary.

You will create the following screen.

By pressing a numerical data display part, the hidden switch is activated to display the

keypad.

Multi-OMulti-O

Data 1

Data 2

Data 3

Data 4

Data 5 0

445

2990

330

15

Multi-OverlapMulti-Overlap

Data 1

Data 2

Data 3

Data 4

Data 5

Data 6

Data 7

Data 8

Data 9

Data 101234

1234

1234

1234

1234

1234

Pi !

445

2990

330

15

0

4 5 6 ▽�

7 8 9 △�

1 2 3 CLR

0 . +- ENT

9999

0

Max. valueMax. value

Min. valueMin. value

Entered valueEntered value 0

O
u

tlin
e



Displaying the Keypad Only When Necessary (Multi-Overlap)

8-2

Procedure

1) Setting up display environment • • • • • • • • • • • • • • • • • • • • • • • • • • • • P8-3

Set up the [Display Environment] dialog.

2) Setting up an overlap part in multi-overlap editing • • • • • • • • • • • • • • • • P8-5

Create an overlap to be called up.

3) Placing a keypad • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • P8-7

Place a keypad using the entry mode parts tool bar in multi-overlap editing.

4) Placing entered value, max. value, and min. value display parts • • • • • • P8-8

Place them using the entry mode parts tool bar in multi-overlap editing.

5) Setting up entry mode • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • P8-9

Click the [Detail] icon in the entry mode parts tool bar in multi-overlap

editing.

6) Setting up multi-overlap in screen editing • • • • • • • • • • • • • • • • • • • • • P8-11

Set up the [Overlap Setting] dialog to call up the created overlap on the

screen.

7) Placing entry target parts in screen editing • • • • • • • • • • • • • • • • • • • • P8-12

Place the parts on the screen.

8) Placing the overlap call switches on the screen • • • • • • • • • • • • • • • • P8-15

Place them behind the numerical data display parts.

9) Division number check • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • P8-21

Check that the same division number is entered for 3, 4 and 5.

Operation

Creating a Screen Change Switch

Create the following screen change switch.

1. Place the switch part as shown below.  Enter [Screen: 4] for [Function] in the

[Switch] dialog.

2. Click the [Next] icon to open the [Screen [4] Edit] window.
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Screen Color and Display Environment Setting

1. Select [Screen Setting] from the [Edit] menu.  Check green for [F] in [Back Color]

and Click [OK].

The screen color is changed to green.

2. Select [Display Environment] from the [Display] menu.  The [Display

Environment] dialog is displayed.

3. Open the [Grid] tab window.   Set up as shown below and click [OK].

Grid Dsp. ON Grid

Grid Color : Purple

Grid Type : Free

X Offset : 0 Y Offset  : 0

X Pitch : 5 Y Pitch    : 5

Place switches on switch grids.

The purple grids are displayed on the screen.

Creating a Screen Title

3. Draw a box to be placed behind the title.

Click the [Box] icon in the draw tool bar.  The following dialog is displayed.

Multi-OverlapMulti-Overlap

1. Click [Text] icon in the draw tool bar.  Key in "Multi-Overlap".

2. Set up text properties as shown below:

Foreground : Red Enlarge X :2

Background : Black Enlarge Y :2

Rotate : Normal      Italic

Direction : RGT Shadow
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4. Set up properties as shown below:

Foreground : White

Background : Black Paint

Frame Color : Black Frame

Tile : No. 0 (extreme left)

Line Type : No. 0 (extreme left: solid line)

5. Draw a painted box and cover the title.

6. Click the [Select] icon and click the box (handles are shown).

Click the [Move to Back] icon.  The title appears on the box.

7. Copy the box.

Click the box (handles are shown).  While holding down the [CTRL] key, drag the

box.  The copy box is displayed in the dragged position.

Multi-Overlap

Multi-OverlapMulti-Overlap

Multi-OverlapMulti-Overlap

Multi-OverlapMulti-Overlap

The copy box is displayed.

Drag the box while holding down the [CTRL] key.
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8. Double-click the copy box or click it (handles are shown).  Click the [Detail/Prop.

Change] icon.  The [Prop. Change] dialog is displayed.

Check black for [Foreground].

9. While handles are shown around the box, click the [Move to Back] icon.  Place the

box as shown below.  The copy box is placed like a shadow of the original box.

This step completes drawing the screen title.

Creating an Overlap

Create an overlap to be called up.

1. Select [Multi-Overlap] from the [Item] menu.

Multi-OverlapMulti-Overlap
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2. The [Multi-Overlap] dialog is displayed.  Check that "0" is entered and click the

[OK].

3. The [Multi Overlap [0] Edit] window is opened.  Click the [Overlap] icon in the

tool bar.

4. The [Overlap (Normal)] dialog is displayed.  Click the [Parts Select] button and

select the [0002] part.

5. Set up as shown below:

Use System Button

Frame Type : Paint

Frame Prop. : Yellow

Area Prop. Foreground : Green

Background : White

Tile : No. 1 (2nd from the left)

    Continue reading PLC memory when set to OFF
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6. Click [Place].  A dotted box with cross cursor is displayed.  Place the box on the

screen by clicking it.  Adjust it to the keypad size.

Placing a Keypad

1. In the [Multi Overlap [0] Edit] window, in which the overlap part is placed, right-

click the mouse.

The following pop-up menu is displayed.

2. Select [Overlap 0].  Now the editing layer is limited within the overlap part and

parts placement or drawing is allowed only on the part.  The tool bar as enclosed

below becomes valid.

3. Check that "0" is entered for [Division No.] at the top right of the screen.  Click

the [Entry Mode] icon.  Click the [Keypad] icon in the entry mode parts tool bar.
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If the entry mode parts tool bar is not displayed entirely, click the outside of any icon and
drag the tool bar to the desired position on the screen.

4. Click [0002] and place the keypad as shown below:

Placing Numerical Data Display Parts (Entry Display)

０� . +- ENT

1234

If entry mode parts tool bar is hidden,

 click the outside of any icon and drag.

The entry mode parts tool bar is displayed independently.

Place the numerical data display parts for entered value, max. value, and min. value on

the overlap.

1. Click [Entry Display] icon in the entry mode parts tool bar.

Select [Numerical Data].  The [Num. Display] dialog is displayed.  Select the

[0001] part.  Set up properties as shown below and place it on the screen.

[Main] tab window Division No.: 0

[Type] tab window Display function: Entry Display Digits: 4

[Char. Prop] tab window Char. Type: Normal

    Transparent     Italic

Char. Size   1-Byte

Rotate: Normal Direction: RGT

    Spacing

Enlarge X: 1 Y: 1

Foreground: Blue Background: Yellow
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Setting Up Entry Mode

Set up the control data for the keypad placed on the overlap.

1. Click the [Detail] icon

 in the entry mode parts tool bar.

The [Entry] dialog is displayed.

０� . +- ENT

1234

1234

1234 Min. value display

Max. value display

2. Also place the max. value and min. value display parts following the same steps.

Click the [Max. Display] icon and [Min. Display] icon in the entry mode parts tool

bar respectively and set up as shown below:

[Main] tab window Division No.: 0

[Type] tab window Display function: Max. or Min. Display

Digits: 4 Decimal Point: 0

Display Type: DEC (w/o sign)

[Char. Prop] tab window Char. Type: Normal

    Transparent     Italic

Char. Size   1-Byte

Rotate: Normal Direction: RGT

    Spacing: unchecked

Enlarge X: 1 Y: 1

Foreground: Purple Background: Yellow
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Placing Texts on the Overlap

Place the following texts on the overlap.

1. Click the [Text] in the draw tool bar.

The dialog for text entry is displayed.

2. Key in the texts and set up properties as shown below:

０� . +- ENT

1234

1234

1234

Max. valueMax. value

Min. valueMin. value

Entered valueEntered value

Text

Foreground
Background
Enlarge X 
Enlarge Y
Rotate
Direction
Italic
Char. Type

"Max. value"
Red

White
1
1

Normal
RGT

unchecked
Shadow

"Entered value"
Green
Blue

1 
1

Normal
RGT

unchecked
Shadow

"Min. value"
Red

White
1
1

Normal
RGT

unchecked
Shadow

Prop.

Place the texts on the overlap as shown in the above figure.

2. Set up as shown below:

[Main] tab window [Detail] tab window

Division No.: 0     Use Graphic

Type: Data Display     Default to 0

Command Memory: 09310 Process Cycle: Low Speed

Info. Output Memory: $u16340

Reverse

Target Memory   Direct

Input Item Select   Internal

    ZM-30 Compatible

3. Click [OK].

The [Entry] icon is stored in the [Part] auxiliary tool box in the lower left corner.
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[Overlap Setting] Dialog

Return to the [Screen Edit] window and set up the [Overlap Setting] dialog for calling

up the overlap.

1. Click the "x" (close) button in the [Multi Overlap [0] Edit] window.

The [Screen [4] Edit] window is displayed.

2. Click the [Overlap] icon in the tool bar.  The [Overlap Setting] dialog is displayed.

3. Click the [No. 0 Overlap] box.  The following options are displayed.  Click

[Multi].

[Close] button
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4. The [Overlap (Multi)] dialog is

 displayed.

Placing a Numerical Data Display Part (Entry Target)

Place a numerical data display part to which data entered through the keypad should be

written.

1. Click the [Num. Data Display] icon in the tool bar.

5. Set up as shown below:

Overlap No.: 0

    Item Select

Command   Internal

Memory: $u16340

6. Click [OK].

The [Overlap] icon is stored in the [Part] auxiliary tool box in the lower left corner

of the screen.

The setting to call up the overlap on the screen has been completed.

2. The [Num. Display] dialog is displayed.  Click [Part Select].  Select [0001] from

the list.

3. Set up as shown below:

[Main] Memory: D180

[Type] Display Function: Entry Target

Order: 0 Digits: 4 Decimal Point: 0

Display Type: DEC (w/o sign)

Entry Type: DEC Data Length: 1-Word

Zero Suppress : Flush R

[Char. Prop] Char. Type: Normal

    Transparent Italic Char. Size   1-Byte

Rotate: Normal         Direction: RGT        Enlarge   X: 1   Y:1

Foreground: White Background: Green
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[Detail] Alarm

Max.: 9999 Max. Color Foreground : Red

Background : Green

Min.: 0 Min. Color Foreground : Red

Background : Green

Process Cycle: High Speed

4. Click [Place].  A dotted box with cross cursor is displayed on the screen.  Place it

as shown below.

Placing an Overlap Call (Hidden) Switch

To bring up the keypad when any numerical data display part is pressed, place an

overlap call switch behind each part.  Place one switch with the following steps.

1. Click the [Switch] icon in the tool bar.

The [Switch] dialog is displayed.

1234

Multi-OverlapMulti-Overlap

Multi-OMulti-O

Data 1

Data 2

Data 3

Data 4

Data 5 0

445

2990

330

15

Multi-OverlapMulti-Overlap

Data 1

Data 2

Data 3

Data 4

Data 5

Data 6

Data 7

Data 8

Data 9

Data 101234

1234

1234

1234

1234

1234

Pi !

445

2990

330

15

0

445

2990

330

15

0

4 5 6 ▽�

7 8 9 △�

1 2 3 CLR

0 . +- ENT

9999

0

Max. valueMax. value

Min. valueMin. value

Entered valueEntered value 0

Place an overlap call switch
behind the part.

For checking/
unchecking the
[Alarm] box, refer
to page 7-13.
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2. Click the [Parts Select] button and select [0000].  The [Switch] dialog is displayed

again.

3. Click the [Change] button at [Function] in the [Main] tab window.  The [Switch

Function] dialog is displayed.

Select [Multi-Overlap] and enter "0" for [Overlap No.] and [Multi-Overlap No.].

Click [OK].

4. Open the [Color] tab window and

set up as shown below:

ON Color : Purple

OFF Color : Green

Frame Type : No Frame

5. Click [Place] and place the switch over the top numerical data display part.

The numerical data display part is under the switch.

6. Click the switch (handles are shown).  Click the [Move to Back] icon to display

the part on the switch.

1234

The numerical data display par t is hidden.

Multi-OverlapMulti-Overlap

1234 1234

Select the switch
 (handles are shown).

Click the [Move to Back] icon.
The numerical data display par t
 appears on the switch.



8-15

8

O
p

e
ra

tio
n

Displaying the Keypad Only When Necessary (Multi-Overlap)

Copying the Numerical Data Display Part

 and the Overlap Call Switch

Make nine copies of both the numerical data display part and the overlap call switch.

1. Copy the numerical data display part.

Click the numerical data display part.  Select [Multi Copy] from the [Edit] menu.

The [Multiple Copy] dialog is displayed.

2. Set up as shown below:

Dot Direction

Interval

X Distance : 0 Quantity X  : 1

Y Distance : 24 Quantity Y  : 6

Order INC

Memory INC

Num. Data Memory: D180 Step: 1

3. Click [OK].  The copy parts are displayed on the screen.

4. Click the bottom part and move it as shown below:

1234

Multi-OverlapMulti-Overlap

1234

1234

1234

1234

1234

1234

Multi-OverlapMulti-Overlap

①②③�
④⑤⑥�



Displaying the Keypad Only When Necessary (Multi-Overlap)

8-16

5. Click the moved part (handles are shown).  Select [Multi Copy] icon in the tool

bar.  The [Multiple Copy] dialog is displayed.  Set up as shown below:

Dot Direction

Interval

X Distance : 0 Quantity X  : 1

Y Distance : 24 Quantity Y  : 5

Order INC

Memory INC

Num. Data Memory: D185 Step: 1

6. Click [OK].

The copies are displayed as shown below:

1234

1234

1234

1234

1234

1234

Multi-OverlapMulti-Overlap

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

Multi-OverlapMulti-Overlap

①②③�
④⑤⑥�
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7. Make nine copies of the overlap call switch.

Click the switch (handles are shown) and open the [Multiple Copy] dialog.

8. Set up as below and click [OK].

Dot Direction

Interval

X Distance : 3 Quantity X : 2

Y Distance : 3 Quantity Y : 5

9. Place five copy switches over the respective numerical data display parts on the

right.

10. Move each switch behind the part using the [Move to Back] icon.

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

Multi-OverlapMulti-Overlap

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

Multi-OverlapMulti-Overlap

1234

Select the switch.

①②③�
④⑤⑥�
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Placing the Overlap

It is possible to specify the position of the overlap, which is displayed by pressing an

overlap call switch.

1. Click the top switch on the left and click the [Detail/Prop. Setting] icon (or,

double-click the switch).  The [Switch] dialog is displayed.

2. Check that "Multi-Overlap: O:0 M:0" is entered for [Function] in the [Main] tab

window.  Open the [Detail] tab window.

3. The [Define MLIB Placement] box is checked.  Click the [Placement] button.

The [Switch] dialog disappears, and the "OVLP" cursor appears on the screen.

1234

1234

1234

1234

1234

Multi-Multi-
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4. Click the "OVLP" cursor in the desired position, in which the top left corner of the

overlap part is located.  "MLIB" appears in the position, and the [Switch] dialog is

displayed.

5. Click [OK].

6. Specify the overlap positions for the remaining nine switches with the same steps

using the [Placement] button in the [Detail] tab window.

Drawing on the Screen

Draw texts, boxes, and lines on the screen as shown below:

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

MLIB

MLIB Multi-OverlaMulti-OverlaMulti-OverlaMulti-Overla

"MLIB" appears here when the switch for 
[Function: Multi-overlap] is placed on the screen.

Click the mouse
 in the desired position.

"MLIB" is displayed in the position.

Multi-OverlapMulti-Overlap

Data 1

Data 2

Data 3

Data 4

Data 5

Data 6

Data 7

Data 8

Data 9

Data 10

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

Box and line

Text
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1. Click the [Text] icon in the draw tool bar.  Enter the desired texts and place them.

Set up properties as shown below:

When drawing vertical or horizontal lines, drag the mouse while holding down the
[SHIFT] key.  Lines can be drawn straight.

"Data 1 (~ 10)"

White

1

1

Normal

RGT

checked

unchecked

Normal

Text

Foreground

Enlarge X

Enlarge Y

Rotate

Direction

Transparent

Italic

Char. Type

Prop.

Multi-OverlapMulti-Overlap

Data 1

Data 2

Data 3

Data 4

Data 5

Data 6

Data 7

Data 8

Data 9

Data 10

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

Ver tical l ine

Box

Horizontal l ine

2. Right-click the mouse to bring up the pop-up menu.

Uncheck [ON Grid].

3. Draw the following table using the [Line] and [Box] icons in the draw tool bar.

Set up properties as shown below:

Vertical line          Box

Color : White Foreground : White

Line Type : No. 1 (thick line) Line Type   : No. 0 (solid line)

Horizontal line     Paint

Color : White

Line Type : No. 0 (solid line)

Click here to delete the check mark.
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Division Number Check

Check that the division number is set up correctly.

1. Select [Multi-Overlap] from the [Item] menu and open the [Multi Overlap [0]

Edit] window.

2. Select [Display Environment] from the [Display] menu.  The [Display

Environment] dialog is displayed. Check the [Div No.] box for [Detail] and click

[OK].

3. The division number (<0>) is entered for each part on the overlap.

Check that all parts and the icon in the [Part] auxiliary tool box have the same

division No. 0.

The overlap has been completed.

Save the file and transfer the data to ZM-80.

The same division number
must be set up.
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ZM-70 Operation Check

Opening Screen No. 4

1. Connect ZM-70 and PLC, and start communication.  Screen No. 0 including the

bit map data is displayed.

2. Press the NEXT switch.  Screen No. 1 is displayed.  Press the NEXT switch on the

screen.  Repeat this procedure until screen No. 4 "Multi-Overlap Screen" is

displayed.

Calling Up the Overlap

1. Press any numerical data display part.  The overlap is displayed and the cursor is

placed on the pressed part.

0

0

0

0

0

0

0

0

0

0

Multi-OverlapMulti-Overlap

Data 1

Data 2

Data 3

Data 4

Data 5

Data 6

Data 7

Data 8

Data 9

Data 10
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2. Press the top left corner of the overlap.  The overlap frame blinks.  By pressing a

different position on the screen, the overlap is moved into position.

3. To delete the overlap, double-press the top left corner of the overlap (because the

system button is activated).

Multi-OMulti-O

Data 1

Data 2

Data 3

Data 4

Data 5 0

0

0

0

0

Multi-OverlapMulti-Overlap

Data 1

Data 2

Data 3

Data 4

Data 5

Data 6

Data 7

Data 8

Data 9

Data 101234

1234

1234

1234

1234

1234

Pi !

0

0

0

0

0

4 5 6 ▽�

7 8 9 △�

1 2 3 CLR

0 . +- ENT

9999

0

Max. valueMax. value

Min. valueMin. value

Entered valueEntered value 0

Multi-OverlaMulti-Overla

Data 1

Data 2

Data 3

Data 4

Data 5

Data 6

Data 7

Data 8

Data 9

Data 101234

0

0

0

0

0

Multi-OverlapMulti-Overlap

Data 1

Data 2

Data 3

Data 4

Data 5

Data 6

Data 7

Data 8

Data 9

Data 101234

1234

1234

1234

1234

1234

0

0

0

0

0

4 5 6 ▽�

7 8 9 △�

1 2 3 CLR

0 . +- ENT

9999

0

Max. valueMax. value

Min. valueMin. value

Entered valueEntered value 0

4 5 6 ▽�

7 8 9 △�

1 2 3 CLR

0 . +- ENT

9999

0

Max. valueMax. value

Min. valueMin. value

Entered valueEntered value 0

Click the desired position.
By clicking here,
 the overlap frame blinks. The overlap moves.

Multi-OverlaMulti-Overla

Data 1

Data 2

Data 3

Data 4

Data 5

Data 6

Data 7

Data 8

Data 9

Data 10

0

0

0

0

0

Multi-OverlaMulti-Overla

Data 1

Data 2

Data 3

Data 4

Data 5

Data 6

Data 7

Data 8

Data 9

Data 101234

0

0

0

0

0

4 5 6 ▽�

7 8 9 △�

1 2 3 CLR

0 . +- ENT

9999

0

Max. valueMax. value

Min. valueMin. value

Entered valueEntered value 0

Double-press here
 to delete the overlap.
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Set bit 15 of D170.

D170

Releasing the Keypad Interlock

1. When the numerical data display part of "Data 1" is pressed, the overlap appears

on the right and the cursor is displayed on the part.

2. When any numerical key or the ENT key is pressed, the key makes an error sound

(beep) and does not work because the keypad interlock is on.

For the overlap, "D170" is entered for [Command Memory] in the [Entry] dialog.

Set bit 15 of D170 (= H8000).  Now the keypad interlock is released.

3. Press "33" on the keypad.  "33" is indicated at "Entered value".

Multi-OMulti-O

Data 1

Data 2

Data 3

Data 4

Data 5

0

0

0

0

0

Pi !

Multi-OverlapMulti-Overlap

Data 1

Data 2

Data 3

Data 4

Data 5

Data 6

Data 7

Data 8

Data 9

Data 10

1234

1234

1234

1234

1234

0

0

0

0

0

4 5 6 ▽�

7 8 9 △�

1 2 3 CLR

0 . +- ENT

9999

0

Max. valueMax. value

Min. valueMin. value

Entered valueEntered value 0

Multi-OverlapMulti-Overlap

Data 1

Data 2

Data 3

Data 4

Data 5

Data 6

Data 7

Data 8

Data 9

Data 10

1234

1234

1234

1234

1234

0

0

0

0

0

4 5 6 ▽�

7 8 9 △�

1 2 3 CLR

0 . +- ENT

9999

0

Max. valueMax. value

Min. valueMin. value

Entered valueEntered value 0

Pi !
Pi !

Multi-OverlapMulti-Overlap

Data 6

Data 7

Data 8

Data 9

Data 10

1234

1234

1234

1234

1234

0

0

0

0

0

4 5 6 ▽�

7 8 9 △�

1 2 3 CLR

0 . +- ENT

9999

0

Max. valueMax. value

Min. valueMin. value

Entered valueEntered value 33
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4. Press the ENT key.  The overlap disappears and "33" is written to "Data 1".

Check that "33" is written to D180 (the address set for [Memory] in the [Num.

Display] dialog for Data 1) in the PLC memory.

Values can be written to the other data display parts with the same steps.

Memory for Entry Mode

The screen uses the following memory addresses:

Questions and Answers

The following describes possible keypad problems on the overlap and measures.

 The cursor is displayed even though the overlap is not called.

--> [Entry] dialog should be set up only for the overlap, but it may have been set

also in the screen edit window.

If the [Entry] icon is stored in the auxiliary tool box also on the screen, the

[Entry] dialog has been set up.  Delete it.

Multi-OverlapMulti-Overlap

Data 1

Data 2

Data 3

Data 4

Data 5

Data 6

Data 7

Data 8

Data 9

Data 10

1234

1234

1234

1234

1234

0

0

0

0

0
Pi !

Multi-OverlapMulti-Overlap

Data 6

Data 7

Data 8

Data 9

Data 10

33

0

0

0

0

4 5 6 ▽�

7 8 9 △�

1 2 3 CLR

0 . +- ENT

9999

0

Max. valueMax. value

Min. valueMin. value

Entered valueEntered value 33

0

0

0

0

0

Press the ENT key. The overlap disappears and "33" is written to D180.

D170

D180�
�
D189
〜�

PLC -> ZM-70

ZM-70 -> PLC

Option

[Command Memory]

Address Contents Direction Set in:

Control memory for releasing
 the keypad interlock, etc.

[Memory]

[Entry] dialog
 (in overlap editing)

Memory to which values entered
 through the keypad are written

[Num. Display] dialog
 (in screen editing)
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99 Displaying Messages by Setting/

Resetting Bits (Relay Mode)

The following ways are available to display messages on the screen.

Messages are displayed by specifying the numbers.

As many consecutive messages
 as the number of lines (Y size) are displayed.

Messages are displayed or erased by setting or resetting of bits.

Relay mode

Message mode

Messages are linked with bits in the PLC memory.  
When a bit is set, its corresponding message is displayed.

Supplemental
 display function

A screen block is called.

Supplemental messages or
 graphics are displayed.

Page mode

As many messages as the number of lines (Y size)
 are displayed by specifying each message number.Direct mode

Screen-call

Sub-display (Relay-sub)

The messages to be displayed are set up in the message edit window.

In this chapter, you will create the following screen in relay mode.

O
u

tlin
e
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Procedure

1) Registering messages • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • •P9-3

2) Selecting relay mode • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • P9-6

3) Setting up the [Relay] dialog • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • P9-7

4) Setting up a message display area part • • • • • • • • • • • • • • • • • • • • • • P9-10

5) Creating the Roll Up and Roll Down switches • • • • • • • • • • • • • • • • • • P9-12

6) Division number check • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • P9-14

Operation

Creating a New Screen

Create and place the NEXT switch to bring up the next screen on screen No. 4.  Open a

new screen and place the fixed text.

1. Place a switch part on screen No. 4 as shown below.  In the [Switch] dialog, enter

[Screen: 5] for [Function].

2. Click the [Next] icon to open the new screen No. 5.

3. Select [Screen Setting] from the [Edit] menu.  In the [Screen Setting] dialog,

check black for [F (foreground)].  Click [OK].

4. Select [Display Environment] from the [Display] menu.  Open the [Grid] tab

window and uncheck the [Grid Dsp.] box.  Also uncheck the [ON Grid] box if it is

checked.  Click [OK].

[Next] icon

Uncheck this check box.
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5. Check that "0" is entered for [Division No.] at the top right of the screen.

6. Key in "Trouble Display".  Set up properties as shown below and place the title in

the center of the screen.

Foreground: White Direction: RGT

Enlarge X: 3 Transparent

Enlarge Y: 3

Rotate: Normal

Message Registration

It is necessary to register the messages to be displayed on the screen.  Open the

[Message Edit] window.

1. Select [Message] from the [Item] menu.  The [Message] dialog is displayed.  Enter

"0" (group number) and click the [OK] button.

The message editing area is divided into 24 groups, each of which can contain a
maximum of 256 message lines (maximum available lines: 6144 lines).  In message
editing, a maximum of 80 one-byte characters or 40 two-byte characters can be
registered per line.

Set up messages to be displayed
in this area.

Group No.
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2. The [Message [0] Edit] window is displayed.

3. Enter messages using alphabets in this example.  Start to enter them from line No.

0.  Registration is made upon entry.  Press the return key to move the cursor to the

next line.

Line No.      Message
     0    AAAAAAAA
     1    BBBBBBBB
     2    CCCCCCCC
     3    DDDDDDDD
     4    EEEEEEEE
     5    FFFFFFFF
     6    GGGGGGGG
     7    HHHHHHHH

Group No.

Cursor

Indicates the cursor position.

[Next] icon
Click this to bring up the next
group number window.
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4. To close the [Message [0] Edit] window, click [X](close) or select [Close] from

[File] the pull-down menu.

The [Message Edit] window has the retrieval and replacement functions, and they are
valid within the same message group.

Or, click this button.

<Find> Enter the text to be retrieved.

<Replace> Enter the text to be retrieved.

Choose the retrieval direction
: upward or downward from the cursor position.

Enter the text for replacement.
* The screen is searched downward from the cursor position.

Data created by other softwares (Microsoft Word, etc.) can be copied and pasted.
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The next [Message Edit] window can be opened for executing edit.  (Select [Message]
from the [Item] menu.)

Relay Mode Selection

Select relay mode.

1. Click [Relay Mode] icon in the tool bar.  The following relay mode parts tool bar

is displayed.

2. This tool bar is used for setting up relay mode, display areas, and switches.

[Relay Mode] icon

Relay mode parts tool bar

[Display Area] [Detail]

[UP/DOWN] switch [Quit]
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[Relay] Dialog

Set up the [Relay] dialog.

Click the [Detail] icon in the relay mode parts tool bar.  The [Relay] dialog is displayed.

[Main] Tab Window
1. Open the [Main] tab window.  Check that "0" is entered for [Division No.].

2. Specify the top bit address for allocating the PLC memory to the registered

messages.

The total number of bits is to be entered for [Executing Relays] with the following

step.

In this example, enter "09310-0" for [Memory].

3. Specify the message group number and the top line (message) number, which are

registered in message editing.  Enter "0" for [G No.] and [No.].

4. Specify the number of bits to be allocated to the messages (range: 1 to 512).

In this example, enter "8" for [Executing Relays].

5. Select [Area], [Switch], or [Lamp] for specifying the place where the message

should be displayed on the screen.

In this example, choose [Area] for [Action Area].

6. Specify the number of lines (of messages) to be linked with one bit.

In this example, enter "1" for [Lines per Relay].

[Detail] icon
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7. Choose [No] for [Sub-Action] when using relay mode only.

Now the messages from No. 0 to No. 7 (equivalent to the value entered for [Executing

Relays]) can be displayed when the corresponding bit is set.

Based on the top bit address entered for
[Memory], as many bits as the number
entered for [Executing Relays] are used.
Messages starting from the line (message)
of the group as specified for [Start
Message] are allocated to the bits
automatically.
When the number of bits specified for
[Executing Relays] is greater than the
maximum available number for a group,
the next message group is also used.
<Ex.> When "258" is entered for [Executing
Relays], and [G No.. 0] and [No. 0] are
entered for [Start Message]:
Messages from message No. 0 of group
No. 0 to message No. 1 of group No. 1 (258
lines) correspond to the bits respectively.

[Char. Prop] tab window
Set up the [Char. Prop.] tab window as shown below:

Set up text properties to be
displayed in this area.

Set up as shown below:

Char. Type : Normal

Transparent

    Italic

Enlarge X: 1 Y: 1

Foreground : White

Message No. 0 ~ 7
 of group No. 0
 in message editing

Corresponding memory
         M00010 =
         M00011 =
         M00012 =
         M00013 =
         M00014 =
         M00015 =
         M00016 =
         M00017 =
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[Detail] Tab Window
1. Choose whether data of the message displayed or selected on the screen in relay

mode should be output to PLC.  If you want to output data, check the box and

specify the desired top memory address.  For specifying the memory address (3-

word required), refer to the "Instruction Manual".  The box is not checked in this

example.

2. Choose [Low Speed]

 for [Process Cycle].

Quitting the [Relay] Dialog
When quitting the [Relay] dialog, click [OK].  The dialog is reduced to an icon and

stored in the [Part] auxiliary tool box in the lower left corner of the screen.

Modifying or deleting the [Relay] dialog

1) When modifying or deleting the [Relay] dialog,
click the icon in the [Part] auxiliary tool box
appearing in the lower left corner of the screen.

2) The relay mode parts tool bar is displayed. Click here.

Relay mode parts tool bar

[Detail]        [Quit]

3) The [Detail] icon retains the data of the [Relay] dialog previously set.
Click the [Detail] icon.  The [Relay] dialog is displayed.
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Creating a Message Display Area

Create a message display area on the screen.

1. Click the [Display Area] icon in the relay mode parts tool bar.  The [Display Area]

dialog is displayed.

Create this message display area.

4) Modify the data of the dialog.

5) To delete the dialog, click the [Delete] icon.  The icon in the [Part] auxiliary tool box
disappears.

This icon disappears.

[Display Area] icon

[Delete]
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2. Set up as shown below:

Division No. : 0

Foreground : Blue

Background : Blue

Tile : No. 0

3. Click the [Place] button and place the display area in the desired position (as

shown on the previous page).

4. Reduce the area to the size of 4 lines.

1) Select [Display Environment] from the [Display] menu.  The [Display

Environment] dialog is displayed.

2) Check the [Message Dsp.] box.

3) Click the [OK] button to quit the dialog.

4) The message display image is

shown on the screen.

5) If the image is not shown, select [Redraw] from the [Display] menu.

Y size
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6) Click the message display area (handles are shown).  Drag the handle until

the area is reduced to the size of four lines (Y size).

The message area must be able to contain the lines specified for

[Lines per Relays] in the [Relay] dialog.  If the area is too small, an

error will arise.

Creating Roll Up and Roll Down Switches

When the called messages cannot be held in the specified area, it is necessary to scroll

up or down.  For this purpose, create the switches for scrolling up/down.

1. Click the [UP/DOWN Switch] icon in the relay mode parts tool bar.  The

following pull-down menu is displayed.

Create the switches for scrolling up/down.

[UP/DOWN Switch] icon

4 lines

The message display area has been set up.
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2. When [Roll Up] is chosen, the [Switch] window for the Roll Up switch is

displayed.  When [Roll Down] is chosen, the window for the Roll Down switch is

displayed.

3. Choose [Roll Up].  The [Switch] dialog is displayed. [Roll up] is chosen for

[Function].

4. The switch part shown in the preview display should be modified.  Click [Parts

Select].  [Switch List Parts_e.z7p] is displayed.  Select [0001] and click [Select].

Check the [Save Setting] box if it is not checked.

5. Click [Character] in the [Switch] dialog.  The [Character] tab window is displayed.

6. Enter "UP" for text field No. 0.  Set up text properties as shown below:

Char. Type : Normal Foreground : White

Transparent Rotate : Normal

Direction : RGT Enlarge X:1 Y:1

7. Click the [Place] button and place the switch part on the screen as shown below:

Place in this position.

Preview display
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8. Create a Roll Down switch following the same steps.

Choose [Roll Down] from the pull-down menu appearing by clicking the [UP/

DOWN Switch] icon.  Enter "DOWN" in the [Character] tab window and set up

text properties as those for the Roll Up switch.

Quitting Relay Mode

1. Relay mode has been set up.

2. Click the [Quit] icon in the relay mode parts tool bar.  The tool bar disappears.

Or, the bar disappears automatically by clicking an icon in a different tool bar.

Division Number Check

The same division number must be entered for the message display area, Roll Up and

Down switches, and the [Relay] dialog icon in the [Part] auxiliary tool box so that they

are linked with each other.

1. Select [Display Environment] from the [Display] menu.  The [Display

Environment] dialog is displayed.

2. Open the [Detail] tab window.  Check the [DIV No.] box and click [OK].

[Quit] icon
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ZM-70 Operation Check

3. On the screen, check that the division No. 0 is entered as shown below:

Save the created screen.

While referring to "Chapter 3 Screen Data Transference", transfer the created screen

data to ZM-70 and check that ZM-70 operates correctly.

Used memory and Registered Messages

Relay Mode Check

1. Set M00010 to M00017 in sequence.

      <Relay> <Message group No.>
No. Address         Line No.
 1 M00010 0 AAAAAAAA
 2 M00011 1 BBBBBBBB
 3 M00012 2 CCCCCCCC
 4 M00013 3 DDDDDDDD
 5 M00014 4 EEEEEEEE
 6 M00015 5 FFFFFFFF
 7 M00016 6 GGGGGGGG
 8 M00017 7 HHHHHHHH

The same division number
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2. Messages from "AAAAAAAA" to "DDDDDDDD" can be displayed, but the

remaining messages cannot be held in the specified area.

3. Press the Roll Up switch "UP" so that the area is scrolled to display the following

message.

Relay Mode Interrupt Test

Priority is given in displaying messages in relay mode.  This is based on message

numbers that are registered in message editing.  The small numbers have higher

priority.

1. Reset M0010 to M0017.

2. Set M0010 and M0013.

"AAAAAAAA" and

"DDDDDDDD" messages are displayed.

3. Set M0012.  "CCCCCCCC"

is inserted.

4. Set M0011.  "BBBBBBBB"

is inserted.

Messages from "EEEEEEEE"
 are not held in the display area.

AAAAAAAA
BBBBBBBB
CCCCCCCC
DDDDDDDD

UP DOWN Press the Roll Up switch.

The following "EEEEEEEE" message appears.

BBBBBBBB
CCCCCCCC
DDDDDDDD
EEEEEEEE

UP DOWN

�

AAAAAAAA
BBBBBBBB
CCCCCCCC
DDDDDDDD

AAAAAAAA
CCCCCCCC
DDDDDDDD

AAAAAAAA
DDDDDDDD
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1010
Displaying Supplemental Explana-

tion or Graphics to Messages

 (Relay-Sub Mode)

It is possible to link relay messages that are displayed by setting bits with supplemental

explanation or graphics using the relay-sub function.

In this chapter, place two sub-display areas on the screen using the relay-sub function

as shown below:

(1) Message sub-display area

(2) Graphic sub-display area
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By selecting "BBBBBBBB", 
the corresponding explanation 
and graphic are displayed.

By selecting "AAAAAAAA", 
the corresponding explanation 
and graphic are displayed.
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(1) reray-sub (2) reray-sub



Displaying Supplemental Explanation or Graphics to Messages (Relay-Sub Mode)

10-2

Procedure

1) Placing a sub-display area for messages • • • • • • • • • • • • • • • • • • • • • P10-2

Registering messages

Registering page blocks

Selecting the relay-sub function

Setting up the [Relay-Sub] dialog

Setting up the display area part

Roll Up and Roll Down switches setting

2) Placing a sub-display area for graphics • • • • • • • • • • • • • • • • • • • • • P10-12

Selecting the relay-sub function

Setting up the [Relay-Sub] dialog

Setting up the display area part

Registering graphics

3) Linking relay mode with the relay-sub mode • • • • • • • • • • • • • • • • • • P10-21

Operation

(1) Message Sub-Display Area

Create the following message sub-display area.

Registering Messages for Sub-Display

Register messages to be used for sub-display in message editing.

Create this area.

Register messages to be
displayed in this area.
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1. Select [Message] from the [Item] menu.  The [Message Edit] dialog is displayed.

Enter "0" for [No.] and click [OK].

2. The previously registered messages are displayed.

Press the [RETURN] key and place the cursor in the 15th line.

(Leave a space from the 8th line to the 14th line for entering additional messages

when necessary.)

3. Key in the messages from the 15th line on the screen as shown on the left.

Message group number

Line No.      Message
    15    a
    16    aa
    17    aaa
    18    aaaa
    19    aaaaa
    20    aaaaaa
    21    aaaaaaa
    22    aaaaaaaa
    23    b
    24    bb
    25    bbb
    26    bbbb
    27    bbbbb
    28    bbbbbb
    29    bbbbbbb
    30    bbbbbbbb
    31    c
    32    cc
    33    ccc
    34    cccc

    69    ggggggg
    70    gggggggg
    71    h
    72    hh
    73    hhh
    74    hhhh
    75    hhhhh
    76    hhhhhh
    77    hhhhhhh
    78    hhhhhhhh

… …
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4. To quit entering messages, click the icon

shown right.  The pull-down menu is displayed.

Select [Close] to close the [Message Edit] window.

Registering the Created Messages as "Page Blocks"

To bring up the messages in the sub-display area, register them as a "page block" or a

"direct block".

• Page block
A "page block" is a group of messages selected in consecutive numbers from those
created in the [Message Edit] window.  By specifying the desired block number, the
corresponding group of messages can be displayed.

<Ex.>
When messages as shown on the left are registered as "page blocks":

Line No.      Message
    15    a
    16    aa
    17    aaa
    18    aaaa
    19    aaaaa
    20    aaaaaa
    21    aaaaaaa
    22    aaaaaaaa
    23    b
    24    bb
    25    bbb
    26    bbbb
    27    bbbbb
    28    bbbbbb
    29    bbbbbbb
    30    bbbbbbbb
    31    c
    32    cc
    33    ccc
    34    cccc
    35    ccccc
    36    cccccc
    37    ccccccc
    38    cccccccc

Messages from line No. 15 to No. 22 are registered as page block No. 0.
Messages from line No. 23 to No. 30 are registered as page block No. 1.

• Direct block
A "direct block" is a group of messages selected at random ranging over
different message groups created in message editing.  By specifying the
desired block number, the corresponding group of messages can be
displayed.

<Ex.>
When messages as shown on the left are registered as "direct blocks":
Messages of line No. 15, 31, 34, 23, 18, and 26 are registered as page
block No. 0.
Messages of line No. 38, 30, and 22 are registered as page block No. 1.
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�

�
aaaaaaaa�
bbbbbbbb�
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�

When page block No. 0 is selected,

the following messages are displayed.

When page block No. 1 is selected,

the following messages are displayed.

When page block No. 1 is selected,

the following messages are displayed.

When page block No. 0 is selected,

the following messages are displayed.
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Displaying Supplemental Explanation or Graphics to Messages (Relay-Sub Mode)

"Page blocks" are used in this example.

1. Select [Page Block] from the [Item] menu.

2. The [Page Block Edit] window is displayed.

3. Set block numbers.

1) Click the area under [Group] of block No. 0.  The display is changed as

shown below:

2) Enter "0" for [Group].

4. Enter "15" for [Start].  "a" appears on the right.

5. Enter "22" for [End].  "aaaaaaaa" appears on the right.

By clicking [Reference], the [Message Edit] window showing the specified group is
displayed.  To go back to the [Page Block Edit] window, click the "x" (close) button in the
[Message Edit] window.

Message group No.

Block No.

End message line No.

Start message line No.

Click here.

"-1" is displayed as default.
Clicking here brings up the
[Message Edit] window.
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6. Enter the following messages for each block.

To delete the set up data of a block, enter "-1" for [Group] and click the block number.
"No setting" is displayed.

7. Click the icon shown below.  Select [close] to close the [Page Block Edit]

window.

Relay-Sub Mode Selection

Bring up the relay-sub mode parts tool bar.

1. Because division No. 0 has been set up for the relay mode on this screen, set up

division No. 1 for the relay-sub mode.  Enter "1" for [Division No.] at the top right

of the screen.

One mode can be set up for one division.

Click here.

Enter "1".

Block No.   Group   Start message No.   End message No.
0    0 15   a         22   aaaaaaaa
1    0 23   b         30   bbbbbbbb
2    0 31   c         38   cccccccc
3    0 39   d         46   dddddddd
4    0 47   e         54   eeeeeeee
5    0 55   f         62   f f f f f f f f
6    0 63   g         70   gggggggg
7    0 71   h         78   hhhhhhhh

Or, click this button.
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Displaying Supplemental Explanation or Graphics to Messages (Relay-Sub Mode)

2. Click the [Relay Sub Mode] icon in the tool bar.  The following relay-sub mode

parts tool bar is displayed.

3. The relay-sub mode parts tool bar is used for setting up relay-sub mode, display

areas, and switches.

[Relay-Sub] Dialog

Set up details for relay-sub mode.

Click the [Detail] icon in the relay-sub mode parts tool bar.  The [Relay-Sub] dialog is

displayed.

[Main] Tab Window
1. Check that "1" is entered for [Division No.].

2. Relay-sub mode can only work when it is linked with relay mode.  With this

option setting, the relay-sub mode is linked with the relay mode.

Set up the same division number as the corresponding relay mode.  Enter "0" for

[Link Division No.].

[Relay Sub Mode] icon

Relay-sub mode parts tool bar

[Display Area]      [Detail]    [Quit]

[UP/DOWN switch]



Displaying Supplemental Explanation or Graphics to Messages (Relay-Sub Mode)

10-8

3. Choose a form of sub-display from [Block].

Choose [Page Block].

4. Specify the top block number set up in the [Page Block Edit] window.

Enter "0" for [Block No.].

[Char. Prop] Tab Window
Set up text properties for the messages to be displayed in the sub-display area.

Quitting the [Relay-Sub] Dialog
When quitting the [Relay-Sub] dialog, click the [OK] button.  The dialog is reduced to

an icon and stored in the [Part] auxiliary tool box in the lower left of the screen.

Set up properties for the messages
to be displayed in this area.

Set up as shown below:

Char. Type : Bold

Transparent

    Italic

Enlarge X: 1 Y: 1

Foreground : Black
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Creating a Display Area for Relay-Sub Mode

Create a message display area  in relay-sub mode.

1. Click the [Display Area] icon in the relay-sub mode parts tool bar.  The [Display

Area] dialog is displayed.

2. Set up as shown below:

Division No. : 1

Foreground : White

Background : White

Tile : No. 0

3. Click the [Place] button and place the part on the screen as shown above.

Create this message display area.

[Display Area] icon



Displaying Supplemental Explanation or Graphics to Messages (Relay-Sub Mode)

10-10

4. Click the placed display area and reduce it to the size of seven lines (Y size).

Creating Roll Up and Roll Down Switches

Create the Roll Up and Roll Down switches.  When a group of messages cannot be held

in the display area, these switches scroll up and down to bring the hidden part into

view.

The display area has been completed.

1. Click the [UP/DOWN Switch] icon in the relay-sub mode parts tool bar.  The

following pull-down menu is displayed.

2. When [Roll Up] is chosen, the [Switch] window for the Roll Up switch is

displayed.  When [Roll Down] is chosen, the window for the Roll Down switch is

displayed.

3. Choose [Roll Up].  The [Switch] dialog is displayed.  [Roll up] is chosen for

[Function].

4. The switch part shown in the preview display should be modified.  Click [Parts

Select].  [Switch List Parts_e.z7p] is displayed.  Select [0001] and click [Select].

Check the [Save Setting] box if it is not checked.

a
aa
aaa
aaaa
aaaaa
aaaaaa
aaaaaaa

Y size: 7 lines

Create the switches to scroll up and
down the messages in the display area.

[UP/DOWN Switch] icon
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Displaying Supplemental Explanation or Graphics to Messages (Relay-Sub Mode)

5. Click [Character] in the [Switch] dialog.  The [Character] tab window is

displayed.

6. Enter "UP" for text field No. 0.  Set up text properties as shown below:

Char. Type : Normal Foreground : Black

Transparent : checked Rotate : Normal

Direction : RGT Enlarge X:1 Y:1

7. Click [Color] in the switch dialog.

The [Color] tab window is displayed.

8. Set up as shown below:

Frame Color : Black

ON Color : Red

OFF Color : White

9. Click the [Place] button and place the

switch part on the screen as shown below:

10. Create a Roll Down switch following the same steps.

Click the [UP/DOWN Switch] icon in the relay-sub mode parts tool bar and select

[Roll Down] from the pull-down menu.

11. Enter "DOWN" for the switch in the [Character] tab window.  Click [Char. Prop]

and set up properties as those for the Roll Up switch.

12. Set up the [Color] tab window as shown below:

Frame Color : Black

ON Color : Red

OFF Color : White

13. Place the switch part on the screen.

Place in this position.

Preview display
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(2) Graphic Sub-Display Area

Create the following message sub-display area.

Relay-Sub Mode Selection

Bring up the relay-sub mode parts tool bar.

1. Because division No. 0 for the relay mode and division No. 1 for message sub-

display have been set up, set up division No. 2 for graphic sub-display.

Enter "2" for [Division No.] in the tool bar.

2. Click the [Relay Sub Mode] icon in the tool bar.  The following relay-sub mode

parts tool bar is displayed.

Create this area.

Enter "2".

[Relay Sub Mode] icon

Relay-sub mode parts tool bar
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Displaying Supplemental Explanation or Graphics to Messages (Relay-Sub Mode)

[Relay-Sub] Dialog

Set up details for relay-sub mode.

Click the [Detail] icon in the relay-sub mode parts tool bar.  The [Relay-Sub] dialog is

displayed.

[Main] Tab Window
1. Check that "2" is entered for [Division No.].

2. Relay-sub mode can only work when it is linked with relay mode.  With this

option setting, the relay-sub mode is linked with the relay mode.

Set up the same division number as the corresponding relay mode.  Enter "0" for

[Link Division No.].

3. Choose a form of sub-display from [Block].

Choose [Graphic LIB].

4. Graphics are entered in graphic editing using the following steps.  Specify the top

group number and the graphic number for the graphics.  Enter 0 for [Graphic LIB

G No.] and [Graphic LIB No.].

Quitting the [Relay-Sub] Dialog
When quitting the [Relay-Sub] dialog, click the [OK] button. The dialog is reduced to

an icon and stored in the [Part] auxiliary tool box in the lower left corner of the screen.
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Creating a Display Area for Relay-Sub Mode

Create a display area to display graphics in relay-sub mode.

1. Click the [Display Area] icon in the relay-sub mode parts tool bar.  The [Display

Area] dialog is displayed.

2. Set up as shown below:

Division No. : 2

Foreground : White

Background : White

Tile : No. 0

3. Click the [Place] button and place the part on the screen as shown above.

Create this graphic display area.

[Display Area] icon
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Displaying Supplemental Explanation or Graphics to Messages (Relay-Sub Mode)

Registering Graphics for Sub-Display

Register graphics to be used for sub-display in graphic library editing.

[Graphic LIB Edit] Window
1. Select [Graphic Library] from the [Item] menu.  The [Graphic Library] dialog is

displayed.

Enter "0" for [Group No.] and [No.] and click the [OK] button.

2. The [Graphic LIB [0:0] Edit] window is displayed.

Register graphics to be
displayed in this area.
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3. Click [Display Environment] from the [Display] menu.

The [Display Environment] dialog is displayed.

4. Check the [Base Screen Dsp.] box.   Select [Screen]

and enter "5" for the screen number.  Click [OK].

5. Select [Redraw] from the [Display] menu.

6. Screen No. 5 is displayed in the [Graphic LIB [0:0] Edit] window.

Creating Graphics
Create graphic No. 0 of group No. 0 as shown below.

1. Create graphic "A".

Refer to the next page for details.

2. Group the graphic "A".

Enclose the graphic "A" using the mouse (handles are shown).  Select [Group]

from the [Edit] menu or click the [Group] icon.

Create this graphic.

Screen No. to display

Enclose the graphic.

Handles are shown.

[Group] icon
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Displaying Supplemental Explanation or Graphics to Messages (Relay-Sub Mode)

3. Make seven copies of the graphic "A".  Select [Multi Copy] icon in the tool bar.

 * The [Multiple Copy] dialog is set up as shown

below in this example.  But adjust [X Distance]

and [Y Distance] to your graphics.

Dot Interval Direction

X Distance: 15 Quantity X: 4

Y Distance: 15 Quantity Y: 2

A
Create the graphic "A" with steps 1 to 3.

1

Box part

[Box] icon

Foreground : Blue
Background : Blue
Tile : No. 0

2

Oval parts

[Circle] icon Foreground : Blue
Background : Blue
Tile : No. 0

3
Character part

[Text] icon

A
Foreground : Green
Enlarge X: 3
Enlarge Y: 3
Rotate : Normal

Transparent     Italic
Direction : RGT

Normal

①②③�
④⑤⑥�
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4. Ungroup the copy graphics using the [Ungroup] icon. Change the character "A" to

"B", "C", "D", "E", "F", "G", and "H" for each copy.

When modifying a grouped graphic, ungroup it using the [Ungroup]

icon.

Offsetting
Place the offset mark.

[Ungroup] icon

Offset
"Offset" is the reference position for calling up the graphics registered in graphic library editing to the screen.

1. Click the [Offset] icon.

2. The offset cursor is displayed.

Move the cursor to the top left corner of the

display area part for graphic (division No. 2)

and click the mouse.

3. The offset mark is located at the top left corner

of the display area part.

OFF

[Offset] icon

Offset mark
(Default position
   : the top left corner)

Locate the offset cursor here.
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Displaying Supplemental Explanation or Graphics to Messages (Relay-Sub Mode)

Graphic Copy and Modification
1. Copy this graphic to No. 1 to No. 7 on [Screen List].

1) Click the [Screen List] icon.

2) [Screen List] is displayed.

Click No. 0 graphic and drag it to area No. 1.  The copy is displayed in the

area.

3) Likewise, drag the graphic to areas No. 2 ~ No. 7.

4) Close the list

2. Return to graphic editing for graphic No. of group No. 1 (Graphic LIB [0:0]).

Change the color of graphic "A".

Drag.

Clicking this icon
closes the list.
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[B] denotes blinking.

3. In graphic editing for graphic No. 1 of group No. 0 (Graphic LIB [0:1]), change

the color of the graphic "B".  Set up the colors the same as those for graphic "A"

(refer to the above figure).

4. Likewise, in graphic editing for graphic No. 2, change the color of graphic "C".

Repeat the same steps until the color of graphic No. 7 ("H") is changed (refer to

the above figure).

5. Graphic editing has been completed.  Click the "x" (close) button and return to the

initial screen.

Box part

Oval parts

Character part
A

Change the color of this graphic.

Foreground: Red        Check [B (blink)].

Foreground: Red        Check [B (blink)].
Foreground: White
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Setting Up the [Relay Dialog] for Linking Relay Mode

with Relay-Sub Mode

1. Click the [Relay] dialog icon in the [Part] auxiliary tool box.  The relay mode parts

tool bar is displayed.

2. Click the [Detail] icon.

The [Relay] dialog is displayed.

3. Select [Sub-Display] for [Sub-Action].

4. The [Relay] dialog has been set up.

[Detail] icon

Select [Sub-Display].
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ZM-70 Operation Check

Save the created screen.

While referring to "Chapter 3 Screen Data Transference", transfer the created screen

data to ZM-70 and check that ZM-70 operates correctly.

Relay-Sub Function Check

1. Reset the PLC register.

2. Set M00010.

3. "AAAAAAAA" is displayed.

The corresponding messages and

highlighted graphic "A" are displayed

in the respective sub-display areas.

 (Refer to Fig. 1.)

4. Press the UP switch to bring up

the hidden message.  (Refer to Fig. 2.)

5. Set M00012.

6. "CCCCCCCC" is displayed.

However, the sub-display areas still

correspond to "AAAAAAAA"

because the message "AAAAAAAA"

is chosen.

(Refer to Fig. 3.)

A B C D

F G HE

AAAAAAAA

UP DOWN

a
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aaaaaaa

UP DOWN

A B C D

F G HE

AAAAAAAA

UP DOWN

aa
aaa
aaaa
aaaaa
aaaaaa
aaaaaaa
aaaaaaaa

UP DOWN

A B C D

F G HE

AAAAAAAA
CCCCCCCC

UP DOWN

aa
aaa
aaaa
aaaaa
aaaaaa
aaaaaaa
aaaaaaaa

UP DOWN

<<Fig. 1>>

<<Fig. 2>>

<<Fig. 3>>
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7. Touch "CCCCCCCC".

A beep is made and "CCCCCCCC"

is chosen.  The sub-display areas

bring up the corresponding messages

and highlighted graphic "C".

(Refer to Fig. 4.)

8. Set M00011 and M00013 to M00017.

9. Press the UP switch to choose "FFFFFFFF".

The sub-display areas bring up

the corresponding messages and

highlighted graphic "F".

(Refer to Fig. 5.)

10. Press the UP/DOWN switch

and check that the sub-display areas

change according to the chosen message.

(Refer to Fig. 6.)
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<<Fig. 4>>

<<Fig. 5>>

<<Fig. 6>>

<<Fig. 7>>

11. Touching the desired message directly

in the display area will also choose it.

(Refer to Fig. 7.) ZM
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Buffering area
The buffering area stores data sampled.  The internal buffer of ZM-80 (ZM-70) or memory cards can be chosen

for data storage.

* Memory cards can be used only when ZM-80 (ZM-70) is available with internal or external memory cards

(optional).

Bit sampling mode is used to store the times when errors occurred and were reset (bit

ON/OFF times) as well as error contents, and to display the stored data.

Follow the steps below to use the bit sampling mode.

  (1) Register error messages to the [Message Edit] window.

  (2) Set up the [Buffering Area Setting] dialog for storing error contents.

  (3) Set up the [Bit Sampling] dialog for indicating stored error contents.

Data stored in the buffering area can be printed.

Unless the buffering area is cleared, sampled data can be stored and displayed anytime

even after screen change.

Create the following screen.
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Procedure

Operation

Error Message Registration for Display

1) Registering error messages • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • P11-2

2) Setting up the buffering area • • • • • • • • • • • • • • • • • • • • • • • • • • • • • P11-3

3) Selecting bit sampling mode • • • • • • • • • • • • • • • • • • • • • • • • • • • • • P11-6

4) Setting up the [Bit Sampling] dialog • • • • • • • • • • • • • • • • • • • • • • • • P11-6

5) Registering messages for [Display in Area] and [Status Display • • • • P11-10

6) Setting up the display area • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • P11-11

7) Placing switches for bit sampling • • • • • • • • • • • • • • • • • • • • • • • • • •P11-12

8) Setting up bit sampling data display parts • • • • • • • • • • • • • • • • • • • •P11-14

Bring up a new screen for creating a bit sampling screen.

Check silver-color (extreme right) for [F (foreground)].

([Edit] -> [Screen Setting] -> [F (foreground)] -> Silver-color (extreme right))

Place the title "Error History" at the center of the screen.  Set up properties as shown

below:

It is necessary to register error messages to be displayed on the screen.  Bring up the

[Message Edit] window.

Text: "Error History"

Foreground Red Enlarge X 3

Background Mahogany (No. 6 from the right) Enlarge Y 3

Rotate Normal Italic unchecked

Direction RGT Shadow

Register error messages to
be displayed in this area.

1. In "Chapter 9  Displaying Messages by Setting/Resetting Bits (Relay Mode)",

group No. 0 has been selected in the [Message

Editing] window for registering messages.  In this

example, select group No. 1 for registering error

messages.

Select [Message] from the [Item] menu.  The
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2. In this example, register fifteen error messages from line No. 0.

Buffering Area Setting

Buffering area is set to store error data.

In the [Buffering Area Setting] dialog, the desired buffer number can be chosen, and

sampling mode, the number of sampling times, etc. can be specified for the buffer.

[Buffering Area Setting] Dialog
The buffering area is set in the [Buffering Area Setting] dialog.

Select [System Setting] from the [Item] menu, and click [Buffering Area Setting].  The

[Buffering Area Setting] dialog is displayed.

Buffer No. 0 is used in this example.

The maximum capacity of the buffering area is 32K words.  The buffering area can be
divided into 12 sections (buffer No. 0 to 11).  Sampling data can be stored in each buffer.

For the message editing procedure, refer to "Message Registration" in "Real-Time

Message Display".

3. When messages have been registered, Click [x] (close button).  The [Message [1]

Edit] window is closed.

Line No. Message Line No.    Message

0       Line error 1 8 Line error 9

1       Line error 2 9 Line error 10

2       Line error 3       10 Line error 11

3       Line error 4       11 Line error 12

4       Line error 5       12 Line error 13

5       Line error 6       13 Line error 14

6       Line error 7       14 Line error 15

7       Line error 8

Close button

[Message] dialog is displayed.  Enter "1" and click the [OK] button.

The [Message [1] Edit] window is displayed.
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Buffer numbers

Buffer No. 0 Setting

1. Buffering area data is written to the memory address selected for [Info. Output]

(ZM80 or ZM70 -> PLC).

The selected memory address is used for all buffer Nos. 0 to 11.

Select "D310" for [Info. Output] in this example.

For more information, refer to page 11-17.

2. Check [Use Sample Buffer].

The options for buffer No. 0 are displayed.

3. Uncheck [Memory Designation].

When this item is not checked, sampling data memory addresses are allocated

following the read area memory and the sampling control memory.

For more information, refer to page 11-16.

4. Select "Bit Sample" for [Sampling Method].

Data is sampled at the edge of ON/OFF of each bit.

5. Specify the number of words to be sampled for [No. of Words].

One word corresponds to 16 bits.

When "1" is specified, data is sampled at the edge of ON/OFF of 16 bits.

15 errors should be displayed in this example.  Specify "1".

Data is thus sampled at the edge of ON/OFF of 16 bits.

[No. of Words] "1"

6. Specify "1" for [Sampling Time].  Sampling is executed at intervals of 1 sec.

Uncheck this box.

Check this box.
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9. [Full Processing] determines what happens when the specified number of

samplings has been exceeded.

Choose "Continuous" in this example.

10. Click [OK].  The [Buffering Area Setting] dialog is closed.

Buffering Area Capacity Calculation
Calculate the capacity as indicated below when "Bit Sample" is chosen for [Sampling

Method]:

For "Bit Sample"

1 sampling = 3 words

Buffering area size = Number of samples x 1 sampling

The buffering area size in this example corresponds to 1,500 words.

Calculation 500 x 3 = 1500

When a short time (0 or 1 sec.) is specified for [Sampling Time],

the number of PLC data reading times by ZM-70 is increased, and

screen process speed will be slow.  When [Memory Designation] is

checked, the speed will be slower.  [Memory Designation] should

not be checked in such a case.

7. Specify "500" for [No. of Samples].

The display area in this example shows up to 11 lines.  Set the number of sampling

times to 11 or more.  (Refer to page 11-11.)

Specify [No. of Samples] as a larger number than the Y size of the

display area in bit sampling mode.  Otherwise, the linked switches

(Roll Up, Reset, etc.) will be ineffective.

8. Specify an address for storing sampled data.

[Store Target] "Internal Buffer"

When the ZM-80 (ZM-70) internal buffer is chosen for [Store

Target], the sampled data is cleared by turning off the system or

by bringing up the main menu on ZM-80 (ZM-70).

Clearing of sampled data as mentioned above can be avoided by choosing a memory
card for storage.  Sampled data can be saved in the memory card even in the event of a
power failure, and the data can be displayed again when the system is turned on.Also,
the stored data can be imported to an application software (EXCEL, for example) using
our software M-CARD SFT.
ZM-80 (ZM-70) must be available with internal or external memory cards when choosing
"Memory Card" for [Store Target].



Display Error History (Bit Sampling Mode)

11-6

Set up how to indicate data stored in the buffering area.

1. Click the [Bit Sampling] icon in the tool bar.

The bit sampling parts tool bar is displayed.

Click [Detail] in the bit sampling parts tool bar.

The [Bit Sampling] dialog is displayed.

[Bit Sampling] Dialog Setting

Bit Sampling Mode Selection

[Bit Sampling] icon

[Display Area]        [Count Display] [Status Display] [Quit]

2. The bit sampling parts tool bar contains the parts that are required for setting up

bit sampling mode.

<Essential parts>

[Detail] and [Display Area]

<Parts to be used when necessary>

[Sample Switch], [Count Display], [Time Display], and [Status Display]

All parts are used in this example.

Note on bit sampling parts setting

Choose the same division number from 0 to 255 for [Detail],

[Display Area], [Sample Switch], [Count Display], [Time Display] and

[Status Display] so that all these bit sampling parts are linked.

[Sample Switch]         [Time Display]     [Detail]

Bit sampling parts tool bar
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[Main 1] Tab Window

1. Specify "0" for [Division No.].

2. Specify the buffer number for execution of bit sampling.

Choose "0" for [Buffer No.] in this example.

When checking the set data of the buffer, click [Refer to Buffer Use].

3. Click [Refer to Buffer Use].  The [Buffering Area Setting] dialog is displayed.

Clicking [OK] after checking the dialog data returns to the [Bit Sampling] dialog.

For more information about the [Buffering Area Setting] dialog, refer to

page 11-4.

4. Specify the message group number and the top line number of the registered

messages.  Refer to page 11-2.

[Start Message GNo.] "1" [No.] "0"

5. Bit activations (ON/OFF) can be indicated at the extreme left of the screen.

Choose the indication method for [Display in Area].

"Occurring" should be indicated when a bit is set (ON), and "Reset" should be

indicated when a bit is reset (OFF) in this example.  Choose "TYPE 1".

• Display in Area (TYPE 1)
Messages registered in
message editing are
indicated.
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＜ON/OFF＞�07:03:50 6

発生  12-20  07:03:36  ライン異常５�

07:03:50�
�

6

Occurring 12-20 07:03:37 Line error 1
Reset       12-20 07:03:40 Line error 1
Occurring 12-20 07:03:43 Line error 3
Occurring 12-20 07:03:43 Line error 4
Reset       12-20 07:03:45 Line error 3
Occurring 12-20 07:03:50 Line error 5

Occurring 12-20 07:03:37 Line error 1
Reset       12-20 07:03:40 Line error 1
Occurring 12-20 07:03:43 Line error 3
Occurring 12-20 07:03:43 Line error 4
Reset       12-20 07:03:45 Line error 3
Occurring 12-20 07:03:50 Line error 5

• TYPE 0
  <ON/OFF>,<ON>,or<OFF> are shown.

• "No"
   Nothing is shown. 

No.0
No.1
No.2
No.3
No.4

Message group No.2 edit

Occurring
Reset
Occurring/Reset
Occurring
Reset

• "No"
   Nothing is shown.

• TYPE 0
  <ON/OFF>,<ON>,or<OFF> are shown.

< ON >  12-20 07:03:37 Line error 1
<OFF>  12-20 07:03:40 Line error 1
< ON >  12-20 07:03:43 Line error 3
< ON >  12-20 07:03:43 Line error 4
<OFF>  12-20 07:03:45 Line error 3
< ON >  12-20 07:03:50 Line error 5

12-20 07:03:37 Line error 1
12-20 07:03:40 Line error 1
12-20 07:03:43 Line error 3
12-20 07:03:43 Line error 4
12-20 07:03:45 Line error 3
12-20 07:03:50 Line error 5

When "TYPE 1" is chosen, two different messages for bit ON and OFF should be

registered in message editing.  When a bit is set or reset, the corresponding

message is indicated.

Examples when "No" or "TYPE 0" is chosen for [Display in Area]

6. Register messages "Occurring" and "Reset" in message editing.  Use line Nos. 0

and 1 in group No. 2 in this example.

[Start Message GNo.] "2" [No.] "0"

For the message registration procedure, refer to "Message Registration for

[Display in Area] and [Status Display]" on page 11-10.

7. The status display indicates which contents are being shown: bit ON, bit OFF, or

bit ON/OFF.

"Occurring" should be indicated for

bit ON, "Reset" should be indicated

for bit OFF, and "Occurring/Reset"

should be indicated for bit ON/OFF in

this example.  Choose "TYPE 1" for

[Status Display].

When "TYPE 1" is chosen, messages for bit ON, OFF, and ON/OFF should be

registered in message editing.  The registered messages are indicated according to

bit conditions.

Examples when "No" or "TYPE 0" is chosen for [Status Display]

.

8. Register messages "Occurring", "Reset", "Occurring/Reset"  in message editing.

Use line Nos. 2, 3, and 4 in group No. 2.

[Start Message GNo.] "2" [No.] "2"

For the message registration procedure, refer to "Message Registration for

[Display in Area] and [Status Display]" on page 11-10.

＜Occurring/Reset＞�07:03:50 6

発生  12-20  07:03:36  ライン異常５�

Occurring 12-20 07:03:37 Line error 1
Reset       12-20 07:03:40 Line error 1
Occurring 12-20 07:03:43 Line error 3
Occurring 12-20 07:03:43 Line error 4
Reset       12-20 07:03:45 Line error 3
Occurring 12-20 07:03:50 Line error 5

• Status Display (TYPE 1)
  Registered messages "Occurring","Reset",
  or "Occurring/Reset" is indicated.

No.0
No.1
No.2
No.3
No.4

Message group No.2 edit

Occurring
Reset
Occurring/Reset
Occurring
Reset
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[Main 2] Tab Window

The priority of the
message cannot be
set by the panel
editor.  Messages
are displayed in
chronological order.

ZM-70For

1. When you want to indicate the sampling time, check [Time Display].

It is indicated in the format of [month - day hour : minute : second].  The number

of one-byte characters is 15.

Check this box in this example.

2. [Initial Status] determines the status display to

be effective when the screen is opened.

Choose "ON-OFF" in this example.  ON/OFF

of all bits sampled can be indicated.

3. When data of all buffers in use (buffer No. 0 in this example) should be printed by

a PLC command, check the [Print Command Memory] box.

Printing should be executed using the switch in this example.  Uncheck the box.

4. Select the type of the priority by [Priority Display]. In this example, select

[Chronological Display].

[Char. Prop. ON ] Tab Window

07:03:50 6

Status Display

Occurring 12-20 07:03:37 Line error 1
Reset       12-20 07:03:40 Line error 1
Occurring 12-20 07:03:43 Line error 3
Occurring 12-20 07:03:43 Line error 4
Reset       12-20 07:03:45 Line error 3
Occurring 12-20 07:03:50 Line error 5

Occurring/Reset 

Time Display
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1. Specify the ON message color to be displayed in the display area.

[ON Foreground] "Red"

2. Set up properties for the messages in the display area.  The set properties are valid

for both ON and OFF messages.

Char. Type Bold

Transparent  checked

Italic  unchecked

[Char. Prop. OFF ] Tab Window

Register the messages for [Display in Area] and [Status Display] in message editing.

(Refer to page 11-8.)

1. In the section "Error Message Registration for Display", the error messages have

been registered in message group No. 1.  The messages for [Display in Area] and

[Status Display] are thus registered in group No. 2.

Select [Message] from the [Item] menu.  The [Message] dialog is displayed.

2. Select group No. 2 and click [OK].

The [Message [2] Edit] window is displayed.

Message Registration for [Display in Area]

and [Status Display]

1. Specify the OFF message color to be displayed in the display area.

[OFF Foreground] "Green"

Characters can be sized up to 1 x 1.

Click [OK] to quit the [Bit Sampling] dialog.
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Set up the sampled data display area.

1. Click the [Display Area] icon in the bit sampling parts tool bar.

The [Display Area] dialog is displayed.

Display Area Setting

Register the messages from line No. 0.

Line No.      Message
     0 Occurring
     1 Reset
     2 Occurring/Reset
     3 Occurring
     4 Reset

For message edit procedure in the message edit window, refer to "Message

Registration" in "Chapter 9  Displaying Messages by Setting/Resetting Bits (Relay

Mode)".

3. Click [x] button after registration.  The [Screen Edit] window appears.

[Display Area]

2. Set up options as shown below.  Place the display area at the center of the screen.

3. Modify the size of the display area.

(1) Bring up grids for reference.

Select [Display Environment] from the [Display] menu.  The [Display

Environment] dialog is displayed.

Set up the [Grid] tab window as shown below, and click [OK].

(2) Modify the display area size while referring to the grids shown on the screen.

Grid Dsp. checked

Grid Color Red

Grid Type 1-Byte

Part selection No. 15 in file [Parts_e.z7p]

Division No. 0

In-area Prop. Foreground Black

Tile No. 0

Display in Area (Refer to page 11-7.)
bit ON
bit OFF
Status Display (Refer to page 11-8.)
bit ON/OFF
bit ON
bit OFF
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1. Click the [Sample Switch] icon in the bit sampling parts tool bar.  The switches for

the bit sampling mode are displayed in the drop-down menu.

Switches for Bit Sampling

• Roll Up

Part selection No. 96 in file [Parts_e.z7p]

• Roll Down

Set up the options in the tab windows in the same manner as those for the Roll Up switch,

except the following:

Part selection No. 95 in file [Parts_e.z7p]

  [Main] tab window

  Function Roll Down

2. Set up as shown below:

Enlarge the Y size to 11 lines
and the X size to 60 one-byte
characters.

1-byte character

1 line for 1-byte character

[Sample Switch]

Switches

[Main] tab window

Division No. 0

Draw Mode REP

Output Memory  unchecked

Lamp Memory  unchecked

Output Action Momentary(ignored)

Function Roll Up

[Character] tab window

(No setting)

[Detail] tab window

Use ON Macro  unchecked

Use OFF Macro  unchecked

Use Interlock  unchecked

Process Cycle High Speed

[Color] tab window

Frame ON Color Gray

ON Color Gray

Frame OFF Color Gray

OFF Color Silver-color (extreme right)
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Foreground Black

Transparent checked

Italic  unchecked

Rotate Normal

Direction RGT

[Detail] tab window

Use ON Macro  unchecked

Use OFF Macro  unchecked

Use Interlock  unchecked

Process Cycle High Speed

[Color] tab window

ON Color Blue

OFF Color Yellow

O
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• Plus Block

Set up the options in the tab windows in the same manner as those for the Roll Up switch,

except the following:

Part selection No. 100 in file [Parts_e.z7p]

[Main] tab window

Function Plus Block

• Minus Block

Set up the options in the tab windows in the same manner as those for the Roll Up switch,

except the following:

Part selection No. 99 in file [Parts_e.z7p]

[Main] tab window

Function Minus Block

• Graph Return

Part selection No. 65 in file [Parts_e.z7p]

• Display Change

Set up the options in the tab windows in the same manner as those for the Graph Return

switch, except the following:

• Print

Set up the options in the tab windows in the same manner as those for the Graph Return

switch, except the following:

• Reset

Set up the options in the tab windows in the same manner as those for the Graph Return

switch, except the following:

[Main] tab window

Division No. 0

Draw Mode REP

Output Memory  unchecked

Lamp Memory  unchecked

Output Action Momentary (ignored)

Function Graph Return

[Character] tab window

No. 0 Graph

No. 1 Return

[Char. Prop.] dialog (for No. 0 and No. 1)

Char. Type Normal

[Main] tab window

Function Sample Print

[Character] tab window

No. 0 Print

[Main] tab window

Function Display Change

[Character] tab window

No. 0 Display

No. 1 Change

[Color] tab window

ON Color Blue

OFF Color White

[Main] tab window

Function Reset

[Character] tab window

No. 0 Reset

[Color] tab window

ON Color Blue

OFF Color Red
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The following explains the switch functions.

Roll Up

Roll Down

Plus Block

Minus Block

Graph Return

Display Change

Print

Reset

Display Order Change

Scrolls by one data element toward the most recent.  If it

cannot be held in the display area, one data element at a time

scrolls into view.

Scrolls by one data element toward the oldest.  If it cannot be

held in the display area, one data element at a time scrolls

into view.

Scrolls by one page toward the most recent.

Scrolls by one page toward the oldest.

Flashes when any of the Roll Up, Roll Down, Plus Block,

and Minus Block switches is pressed.  When the Graph

Return switch is pressed while it is flashing, the display is

restored to the most recent bit sampling data.  Flashing is

canceled as well as the selection.

Changes over the sampling status display when it is set to be

indicated.

Prints all data stored in the specified buffer numbers.

Lights up when the switch is pressed once.  When it is

pressed again within 2 seconds, the buffer in use is cleared,

and sampling is restarted immediately.

If not pressed within 2 seconds, the switch is turned off, and

resetting is nullified.

Changes the order of the displayed messages when the

switch is pressed once.  The chronological display is

reversed by turns.

Cannot specify the
[Function: Display
Order Change]
switch.

ZM-70For

• Display Order Display

Set up the options in the tab windows in the same manner as those for the Graph Return

switch, except the following:

[Main] tab window

Function Display Order Change

[Character] tab window

No. 0 Order

No. 1 Change
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Depending on the setting for [Digits], the sampling time is indicated in the following
format:
     8 digits or less

no display
     greater than 8 digits and less than 14 digits (both inclusive)

hour : minute : second
     15 digits or greater

month - day hour : minute : second

2. Set up each display part and place it on the screen.

• Sampling status display

Part selection No. 9 in file [Parts_e.z7p]

• Sampling time display

Part selection No. 9 in file [Parts_e.z7p]

[Main] tab window

Division No. 0

[Type] tab window

Display Function Sample Status Display

Bytes 10

Flush L

[Char. Prop.] tab window

Char. Type Normal

Transparent  unchecked

Italic  unchecked

Rotate Normal

Direction RGT

Spacing  unchecked

Enlarge X: 1 Y: 1

Foreground Blue

Background Silver-color

[Detail] tab window

Process Cycle High Speed

[Main] tab window

Division No. 0

[Type] tab window

Display Function Sample Time Display

Digits 9

Decimal Point 0

Display Type DEC (w/o sign)

Zero Suppress  checked

Flush R

[Char. Prop.] dialog

Char. Type Normal

Transparent  unchecked

Italic  unchecked

Char. Size 1-Byte

Rotate Normal

Direction RGT

Spacing  unchecked

Enlarge X: 1 Y: 1

Foreground Blue

Background Silver-color

[Detail] tab window

Process Cycle High Speed

Bit Sampling Data Display Parts

1. Set up the [Count Display], [Status Display], and [Time Display] parts for

indicating the number of samplings, the status of sampling, and the time recorded

when the data was sampled.

[Count Display] [Time Display] [Status Display]

Sampling status display

Sampling time display

Sampling count display
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ZM-80 Operation Check

Memory Allocation

The following memory addresses are used in this example.

Read area memory address: D00000

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 R T 0 0 R T 0 0 R T 0 0 R T

n+3
n+4
n+5

MSB LSB

Buffer No.3
Buffer No.7
Buffer No.11

Buffer No.2
Buffer No.6
Buffer No.10

Buffer No.1
Buffer No.5
Buffer No.9

Buffer No.0
Buffer No.4
Buffer No.8

Sampling control
              memory

• Sampling count display

Set up the options in the tab windows in the same manner as those for the sampling time

display, except the following:

   Sampling status display This display indicates which contents are being shown:

bit ON, bit OFF, or bit ON/OFF.

   Sampling time display This display indicates the last sampling time or that of

the selected data element.

   Sampling count display This display indicates the total number of data sampled

or the ordinal number of the selected data element

among those sampled.

     Memory address   Contents
D00003 Sampling control memory
D00004 Sampling data memory
D00310 Information output memory

Sampling Control Memory
When any setting is made in the [Buffering Area Setting] dialog, sampling control

memory addresses are automatically allocated following the read area memory.

The number of allocated words and the contents depend on the number of buffers.

Read area memory addresses: n, n + 1, n + 2 (3 words)

[Type] tab window

Display Function Sample Count Display

Digits 4
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Information Output Memory
Buffering area information is written to the memory address chosen for [Info. Output]

(ZM80 -> PLC).

Memory addresses and bits correspond to buffers as shown below:

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

F1 F0 D T F1 F0 D T F1 F0 D T F1 F0 D T

n
n+1
n+2

MSB LSB

Buffer No.3
Buffer No.7
Buffer No.11

Buffer No.2
Buffer No.6
Buffer No.10

Buffer No.1
Buffer No.5
Buffer No.9

Buffer No.0
Buffer No.4
Buffer No.8

Information output
                memory

R: Reset

When this bit is set (1) , the buffering area is cleared and no sampling occurs.

When this bit is reset (0), sampling is started.

T: Trigger

This is effective only when [Bit Synchronize] is selected for [Sampling Method] in

the [Buffering Area Setting] dialog.

Only buffer No. 0 is used in this example.  Address D00003 (1 word) is allocated as the

sampling control memory.

Sampling Data Memory
When [Memory Designation] is not checked in the [Buffering Area Setting] dialog,

sampling data memory addresses are allocated following the sampling control memory.

Address D00004 (1 word) is allocated as the sampling data memory in this example.

F1: Specified buffer is full.

F0: Specified buffer is 90 % full.

D : Specified buffer contains data.

T : Status of the input trigger is output.

Only buffer No. 0 is used in this example.

Address D00310 (1 word) is allocated as the information output memory (refer to page

11-4).
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Save the created screen.

While referring to "Chapter 3 Screen Data Transference", transfer the created screen

data to ZM-80 and check that ZM-80 operates correctly.

1. Specify "H0000" for "D00003".  Start sampling.

2. Specify "H0001" for "D00004".

(Bit 0 is set.)

Bit Sampling Screen Operation Check

07:03:37 1Occurring/Reset

Occurring  12-20 07:03:37  Line error 1

The following table indicates error messages corresponding to the sampling data

memory bits respectively.

Error Messages Corresponding to Bits

       Bit   Message

D00004-00 Line error 1

D00004-01 Line error 2

D00004-02 Line error 3

D00004-03 Line error 4

D00004-04 Line error 5

D00004-05 Line error 6

D00004-06 Line error 7

D00004-07 Line error 8

D00004-08 Line error 9

D00004-09 Line error 10

D00004-10 Line error 11

D00004-11 Line error 12

D00004-12 Line error 13

D00004-13 Line error 14

D00004-14 Line error 15

D00004-15
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3. Specify "H0002" for "D00004".

(Bit 0 is reset, and bit 1 is set.)
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6. Monitor the information output memory.

"H0002" is entered for "D00310".

It is confirmed that buffer No. 0 contains data.

7. Press the [Reset] switch.  The switch lights up.  Press it again within 2 seconds.

Data sampled in buffer No. 0 as well as the messages in the display area are

cleared.

8. Monitor "D00310".  "H0000" is entered.

It is confirmed that the buffering area contains no data.

9. Bring up 12 or more messages on the screen.

Check that the [Roll Up], [Roll Down], [Plus Block], [Minus Block], and [Graph

Return] switches operate as intended.  (Refer to page 11-14.)

07:03:43 3Occurring

Occurring  12-20 07:03:37  Line error 1
Occurring  12-20 07:03:43  Line error 3

07:03:43 3Occurring/Reset

Occurring  12-20 07:03:37  Line error 1
Reset        12-20 07:03:40  Line error 1
Occurring  12-20 07:03:43  Line error 3

07:03:40 3Reset

Reset        12-20 07:03:40  Line error 1

4. Press the [Display Change] switch.

"Occurring/Reset" changes to

"Occurring"  in the status display.

5. Press the [Display Change] switch again.

"Occurring" changes to "Reset"

in the status display.
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Buffering area
The buffering area stores data sampled.  The internal buffer of ZM-80 (ZM-70) or memory cards can be chosen

for data storage.

* Memory cards can be used only when ZM-80 (ZM-70) is available with internal or external memory cards

Trend sampling mode is used to express time-varying data in a line graph.  This mode

stores time-varying data in the buffering area, thus allowing you to check data trends in

reverse chronological order.

Up to 16 lines can be displayed in a trend sampling area.

Follow the steps below to use the trend sampling mode:

  (1) Set up the [Buffering Area Setting] dialog for storing time-varying data.

  (2) Set up the [Trend Sampling] dialog for expressing the stored data.

(optional).

Unless the buffering area is cleared, sampled data can be stored and displayed anytime

even after screen change.

Create the following screen.

ZM-70For
Up to 8 lines can be
displayed in a display
area.
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Procedure

Operation

Buffering Area Setting

1) Setting up the buffering area • • • • • • • • • • • • • • • • • • • • • • • • • • • • • P12-2

2) Selecting trend sampling mode • • • • • • • • • • • • • • • • • • • • • • • • • • • •P12-4

3) Setting up the [Trend Sampling] dialog • • • • • • • • • • • • • • • • • • • • • • P12-5

4) Placing the trend sampling area • • • • • • • • • • • • • • • • • • • • • • • • • • P12-10

5) Placing switches for trend sampling • • • • • • • • • • • • • • • • • • • • • • • • P12-11

6) Setting up trend sampling data display parts • • • • • • • • • • • • • • • • • •P12-13

Bring up a new screen for creating a trend sampling screen.

Check silver-color (extreme right) for [F (foreground)].

([Edit] -> [Screen Setting] - > [F (foreground)] -> Silver-color (extreme right)

[Buffering Area Setting] Dialog
Select [System Setting] from the [Item] menu, and click [Buffering Area Setting].  The

[Buffering Area Setting] dialog is displayed.

Buffer No. 0 has been used in Chapter 11.  Use buffer No. 1 in this example.

Buffer No. 1 Setting
1. The memory address selected for [Info. Output] in the [Buffering Area Setting]

dialog is used for all buffer Nos. 0 to  11.

Check that "D00310" is chosen for [Info. Output] (refer to page 12-17).

2. Click [1].  The [1] tab window is opened for buffer No. 1.

Check the [Use Sample Buffer] box.  The options for buffer No. 1 are indicated.

3. The memory address to be sampled can be specified when [Memory Designation]

is checked.  Uncheck the box in this example.

The maximum capacity of the buffering area is 32K words.  The buffering area can be
divided into 12 sections (buffer Nos. 0 to 11).  Sampling data can be stored in each
buffer.

The buffering area is set to store time-varying data.
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When [Memory Designation] is not checked, sampling data memory addresses are

allocated following the read area memory, the sampling control memory, and the

sampling data memory for buffer No. 0.

For more information, refer to page 12-16.

4. Choose "Bit Synchronize" or "Constant Sample" for [Sampling Method].  Choose

"Bit Synchronize" in this example.

    Bit Synchronize:

Data is sampled at the edge of 0 -> 1 of bits in the sampling control memory.

    Constant Sample:

Data is sampled at the specified intervals.

5. Specify the number of words to be sampled for [No. of Words].

3 words are sampled in this example.

[No. of Words] "3"

6. Specify "100" for [No. of Samples].

"20" is to be entered for [Trends] in the [Trend Sampling] dialog.  "20" or more

must be entered for [No. of Samples] (refer to page 12-7).

Specify [No. of Samples] as a larger number than the number of

[Trends].  Otherwise, the linked switches (Roll Up, Reset, etc.) will

be ineffective.

7.  Specify an address for storing sampled data.

[Store Target] "Internal Buffer"

The internal buffer is installed in ZM-80 (ZM-70).

When "Internal Buffer" is chosen for [Store Target], the sampled

data is cleared by turning off the system or by bringing up the

local main screen on ZM-80 (ZM-70).

Buffer numbers
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Set up how to indicate the data stored in the buffering area.

1. Click the [Trend Sampling] icon in the tool bar.  The trend sampling parts tool bar

is displayed.

Trend Sampling Mode Selection

Clearing of sampled data as mentioned above can be avoided by choosing a memory
card for storage.  Sampled data can be saved in the memory card even in the event of a
power failure, and the data can be displayed again when the system is turned on.
Also, the stored data can be imported to an application software (EXCEL, for example)
using our software M-CARD  SFT.
ZM-80 (ZM-70) must be available with internal or external memory cards when choosing
"Memory Card" for [Store Target].

The buffering area size in this example corresponds to 500 words.

Calculation method 3 + 2 = 5

100 x 5 = 500

For "Bit Synchronize"

1 sampling = Set number of words + 2 words

Buffering area size = Number of samples x 1 sampling

8. [Full Processing] determines what happens when the specified number of

samplings has been exceeded.

Stop : Sampling is stopped when the specified number has been

  exceeded.

Continuous : Sampling is continued by discarding old ones when the

  specified number has been exceeded.

Choose "Continuous" in this example.

9. Click [OK].  The [Buffering Area Setting] dialog is closed.

Buffering Area Capacity Calculation
Calculate the capacity as indicated below when "Bit Synchronize" is chosen for

[Sampling Method]:

[Trend Sampling] icon Trend sampling parts tool bar
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Click the [Trend Sampling] icon in the trend sampling parts tool bar.

The [Trend Sampling] dialog is displayed.

[Trend Sampling] Dialog

2. The trend sampling parts tool bar contains the parts that are required for setting up

trend sampling mode.

<Essential parts>

[Trend Sampling]

<Parts to be used when necessary>

[Count Display], [Time Display], and [Sample Switch]

Notes on trend sampling parts setting:

Choose the same division number from 1 to 255 for [Count

Display], [Time Display], [Sample Switch], and [Trend Sampling] so

that all these trend sampling parts are linked.

Once the trend sampling parts tool bar is closed, the bar linked

with the set trend sampling mode cannot be displayed again.  To

set up parts ([Sample Switch], [Count Display], etc.) for the trend

sampling mode afterwards, click the [Switch] or [Num. Data

Display] icon in the tool bar.

[Count Display] [Time Display] [Trend Sampling]   [Sample Switch]    [Quit]

All parts are used in this example.
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Basic trend sampling data is set in the [Main], [Setting 1], and  [Setting 2] tab windows.

The [0] to [15] tab windows are used for setting details of respective trend lines.

[Main] Tab Window
1. Specify "0" for [Division No.].

2. Specify the buffer number for execution of trend sampling.

Buffer No. 1 has already been chosen in "Buffering Area Setting".

Choose "1" for [Buffer No.].

When checking the buffer No. 1 data, click [Refer to Buffer Use].

3. Click [Refer to Buffer Use].  The [0] tab window appears in the [Buffering Area

Setting] dialog.

Click [1] and check the data of buffer No. 1.

Click [OK].   The [Trend Sampling] dialog is displayed.

For more information about setting of the [Buffering Area Setting] dialog, refer to

page 12-2.

4. Click [Parts Select] and choose the part for trend sampling.  Choose No. 0 from

file [Parts_e.z7p] in this example.

[Setting 1] Tab Window

ZM-70For
Up to 8 lines can be
displayed in a display
area.

Up to 16 lines can be displayed in a trend sampling area.
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1. Choose the desired direction for drawing the

trend lines for [Direction].

Choose "RGT" in this example.
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[Setting All]

1. Open the desired tab windows, and check
their [Trend Display] boxes.

2. Open the [Setting 1] tab window.  Click
[Setting] for [Setting All].  The [Setting All]
dialog is displayed.

3. Set up the data of [Data Length], [Graph
Max. Value], and [Graph Min. Value], and
click [OK].  The trend line numbers of
[Trend Display] boxes which are checked
in respective tab windows can be set up in a batch.

2. Specify the desired maximum number of plot

points for [Trends].

Setting range: 3 to 639

Choose "20" in this example.

3. Choose line graph colors for [Display in Area].

Foreground Black

Background Black

Tile No. 0

4. When setting up the same data for [Data Length], [Graph Max. Value], and [Graph

Min. Value] of trend line Nos. 0 to 7, it is convenient to use [Setting All].

Click [Setting] in the [Setting 1] window when using this function.

Although 3 trend lines are drawn in this example, different data is set up for the

lines.  [Setting All] is not used.

Y

XCoordinate zero point

"RGT" direction

�Point
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[Setting 2] Tab Window

1. It is possible to draw up to two lines for reference in the trend sampling area.

If you want to draw two lines, check both [Upper Line Display ] and [Lower Line

Display] boxes.  If you want to draw one line, check either box.

A central line should be drawn in this example.  Check [Upper Line Display].

2. Scales can be attached for reference of

drawing the upper/lower lines.

Specify "2" for [Graph Max.] and "0"

for [Graph Min.].

3. Choose either "1-Word" or "2-Word"

for the [Graph Max.] and [Graph Min.]

data.

Specify "1-Word" for [Data Length].

4. Specify "1" for [Upper Value] and check white for [Upper Color] of [Upper Line

Display].

[0] Tab Window
1. Check the [Trend Display] box.

2. Set up [Line Color] and [Line Type & Point] as shown below:

Line Color "White"

Line Type & Point "Solid line (thin line, No. 5 from the left)"

07:03:36 1
1000

500

0

300

150

0

100

50

0
1 2010
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3. Choose "1-Word" for [Data Length].

4. Specify the max. and min. graph values of trend line No. 0.

Graph Max. Value "1000"

Graph Min. Value "0"

5. When [Constant Sample] or [Bit Synchronize] is selected for [Sampling Method]

in the [Buffering Area Setting] dialog, word addresses starting from "0" are

determined.

Specify the word address number to be sampled in buffer No. 1 for [Sample

Buffer Word No.].

"3" is specified for [No. of Words] in the [Buffering Area Setting] dialog in this

example.

Addresses are allocated as shown below:
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Address

1st word       0

2nd word       1

3rd word       2

Data of the 1st word should be sampled in the buffering area.  Specify "0" for

[Sample Buffer Word No.].

[1] Tab Window
1. Check the [Trend Display] box.

2. Set up [Line Color] and [Line Type & Point] as shown below:

Line Color "Green"

Line Type & Point "Broken line (No. 2 from the right)"

3. Choose "1-Word" for [Data Length].
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4. Specify the max. and min. graph values of trend line No. 1.

Graph Max. Value "300"

Graph Min. Value "0"

5. Specify "1" for [Sample Buffer Word No.].

[2] Tab Window
1. Check the [Trend Display] box.

2. Set up [Line Color] and [Line Type & Point] as shown below:

Line Color "Purple"

Line Type & Point "Solid line (thick line, No. 5 from the right)"

3. Choose "1-Word" for [Data Length].

4. Specify the max. and min. graph values of trend line No. 2.

Graph Max. Value "100"

Graph Min. Value "0"

5. Specify "2" for [Sample Buffer Word No.].

Trend Sampling Area Placement

When the size of the trend sampling area is specified after setting

[Trends], it will be determined automatically by adjusting the size

with no remainder.

If the value of [Trends] is changed after placing the trend sampling

area, there may be a remainder.  The value of the remainder will be

specified as the blank area.

Point pitch (dot) = X size  / (Trends - 1)

When the [Trend Sampling] dialog has been set up, click [Place] and place the trend

sampling area at the center of the screen.

�Point

Point Pitch

Y
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Switches for Trend Sampling

1. Click the [Sample Switch] icon in the trend sampling parts tool bar.  The switches

for the trend sampling mode are displayed in the drop-down menu.

• Roll Up

Part selection No. 98 in file [Parts_e.z7p]

• Roll Down

Set up the options in the tab windows in the same manner as those for the Roll Up switch,

except the following:

Part selection No. 97 in file [Parts_e.z7p]

• Plus Block

Set up the options in the tab windows in the same manner as those for the Roll Up switch,

except the following:

Part selection No. 102 in file [Parts_e.z7p]

• Minus Block

Set up the options in the tab windows in the same manner as those for the Roll Up switch,

except the following:

Part selection No. 101 in file [Parts_e.z7p]

[Sample Switch]

Switches

2. Set up the switches and place them on the screen as shown below:

[Main] tab window

Division No. 0

Draw Mode REP

Output Memory  unchecked

Lamp Memory  unchecked

Output Action Momentary (ignored)

Function Roll Up

[Character] tab window

(No setting)

[Detail] tab window

Use ON Macro  unchecked

Use OFF Macro  unchecked

Use Interlock  unchecked

Process Cycle High Speed

[Color] tab window

Frame ON Color Gray

ON Color Gray

Frame OFF Color Gray

OFF Color Silver-color

(extreme right)

[Main] tab window

Function Roll Down

[Main] tab window

Function Plus Block

[Main] tab window

Function Minus Block

(2) (1) (4) (3) (5) (6)

(1)
(2)
(3)
(4)
(5)
(6)
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The following explains the switch functions.

Roll Up Scrolls by one data element toward the most recent.  If it cannot

be held in the display area, one data element at a time scrolls

into view.

Roll Down Scrolls by one data element toward the oldest.  If it cannot be

held in the display area, one data element at a time scrolls into

view.

Plus Block Scrolls by one page toward the most recent.

Minus Block Scrolls by one page toward the oldest.

Graph Return Flashes when any of the Roll Up, Roll Down, Plus Block, and

Minus Block switches is pressed.  When the Graph Return

switch is pressed while it is flashing, the display is restored to

the most recent trend sampling data.  Flashing is canceled as

well as the selection.

Reset Lights up when the switch is pressed once.  When it is pressed

again within 2 seconds, the buffering area in use is cleared and

sampling is restarted immediately.

If not pressed within 2 seconds, the switch is turned off, and

resetting is nullified.

• Graph Return

Part selection No. 65 in file [Parts_e.z7p]

Transparent checked

Italic  unchecked

Rotate Normal

Direction RGT

[Detail] tab window

Use ON Macro  unchecked

Use OFF Macro  unchecked

Use Interlock  unchecked

Process Cycle High Speed

[Color] tab window

ON Color Blue

OFF Color Green

• Reset

Set up the options in the tab windows in the same manner as those for the Graph Return

switch, except the following:

[Main] tab window

Division No. 0

Draw Mode REP

Output Memory  unchecked

Lamp Memory  unchecked

Output Action Momentary (ignored)

Function Graph Return

[Character] tab window

No. 0 Graph

No. 1 Return

[Char. Prop.] dialog (for No. 0 and No. 1)

Char. Type Normal

Foreground Black

[Main] tab window

Function Reset

[Character] tab window

No. 0 Reset

[Color] tab window

ON Color Blue

OFF Color Red
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Trend Sampling Data Display Parts

1. Set up the [Count Display] and [Time Display] parts for indicating the number of

samplings and the time recorded when the data was sampled.

Depending on the setting for [Digits], the sampling time is indicated in the following
format:

8 digits or less
no display

greater than 8 digits and less than 14 digits (both inclusive)
hour: minute: second

15 or more greater
month - day hour : minute : second

• Sampling time display

Part selection No. 9 in file [Parts_e.z7p]

• Sampling count display

Set up the options in the tab windows in the same manner as those for the sampling time

display, except the following:

Transparent  unchecked

Italic  unchecked

Char. Size 1-Byte

Rotate Normal

Direction RGT

Spacing  unchecked

Enlarge X: 1 Y: 1

Foreground Blue

Background Silver-color

[Detail] tab window

Process Cycle High Speed

[Count Display] [Time Display]

Sampling time display Sampling count display

2. Set up each display part and place it on the screen.

[Main] tab window

Division No. 0

[Type] tab window

Display Function Sample Time Display

Digits 8

Decimal Point 0

Display Type DEC (w/o sign)

Zero Suppress checked

Flush R

[Char. Prop.] tab window

Char. Type Normal

[Type] tab window

Display Function Sample Count Display

Digits 3

12345678 123
1000300100
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(2) Drag the mouse to the [Screen Edit] window.  The cross-shaped cursor

appears.  Draw scales by dragging the cursor from the upper left to the lower

right.

2. Right-click the mouse.  The pop-up menu is displayed.  Uncheck [ON Grid] when

it is checked.

Sampling time display This display indicates the last sampling time or that of

the selected data element.

Sampling count display This display indicates the total number of data sampled

or the ordinal number of the selected data element

among those sampled.

Drawing Scales
1. Draw scales.

(1) Click [Trend Graph Scale] icon

in the draw tool bar.  The [Screen

Drawing] dialog is displayed.

Set up as shown below:

Color "Black"

Length "5"

Line checked

Split No. X "19", Y "2"

The check mark is removed by clicking.

3. Draw graduation marks.

Click the [Text] icon.  Create and place the marks as shown below:

Data VariationsData Variations
07:03:36 1

1000

500

0

300

150

0

100

50

0
1 2010

Foreground color

Red

Green

Black
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4. Draw the screen title "Data Variations" by setting up properties as shown below:

Memory Allocation

The following memory addresses are used in this example.

Read area memory address: D00000

<Common options>

Enlarge X: 1, Y:1

Transparent  checked

Rotate Normal

Direction RGT

Italic  unchecked

Normal  checked

Foreground Blue

Background Red

Rotate Normal

Direction RGT

Enlarge X: 3, Y: 3

Italic  unchecked

Shadow  checked

Memory address Contents

      D00003 Sampling control memory

      D00004 Sampling data memory (Buffer No. 0)

      D00005 Sampling data memory (Buffer No. 1)

      D00006 Sampling data memory (Buffer No. 1)

      D00007 Sampling data memory (Buffer No. 1)

      D00310 Information output memory

Sampling Control Memory
When any setting is made in the [Buffering Area Setting] dialog, sampling control

memory addresses are automatically allocated following the Read Area memory.

The number of allocated words and the contents depend on the number of buffers.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 R T 0 0 R T 0 0 R T 0 0 R T

n+3

Sampling control
memory

n+4
n+5

MSB LSB

Buffer No.3
Buffer No.7
Buffer No.11

Buffer No.2
Buffer No.6
Buffer No.10

Buffer No.1
Buffer No.5
Buffer No.9

Buffer No.0
Buffer No.4
Buffer No.8
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Sampling Data Memory
When [Memory Designation] is not checked in the [Buffering Area Setting] dialog,

sampling data memory addresses of buffer No. 1 are allocated following the sampling

control memory and the sampling data memory of buffer No. 0.

Addresses D00005, D00006, and D00007 (3 words) are allocated as the sampling data

memory of buffer No. 1 in this example.

Information Output memory
Buffering area information is written to the memory address chosen for [Info. Output]

(ZM80 -> PLC).

Memory addresses and bits correspond to buffers as shown below:

F1: Specified buffer is full.

F0: Specified buffer is 90 % full.

D: Specified buffer contains data.

T: Input trigger is output.

Read Area memory addresses: n, n + 1, n + 2 (3 words)

R: Reset

When this bit is set (1), the buffering area is cleared and no sampling occurs.

When this bit is reset (0), sampling is started.

T: Trigger

This is effective only when [Bit Synchronize] is selected for [Sampling

Method] in the [Buffering Area Setting] dialog.

Buffer No. 1 is used in this example.  Address D00003 is allocated as the sampling

control memory.

[Bit Synchronize] is selected for [Sampling Method] in the [Buffering Area Setting]

dialog.  Sampling is thus executed at the edge of 0 -> 1 of bit 4 of D00003.

Buffer No. 1 is used in this example.

Address D00310 (1 word) is allocated as the information output memory of buffer No.

1 in this example (refer to page 12-2).

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

F1 F0 D T F1 F0 D T F1 F0 D T F1 F0 D T

n
n+1
n+2

MSB LSB

Buffer No.3
Buffer No.7
Buffer No.11

Buffer No.2
Buffer No.6
Buffer No.10

Buffer No.1
Buffer No.5
Buffer No.9

Buffer No.0
Buffer No.4
Buffer No.8

Information output
                memory
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Trend Sampling Screen Operation Check

Save the created screen.

While referring to "Chapter 3  Screen Data Transference", transfer the created screen

data to ZM-80 and check that ZM-80 operates correctly.

1. The stored data is displayed in the following format:

Sampling data    Graph max. value    Graph min. value      Line type Line color
No. 0 (D00005) 1000 0      Thin line    White
No. 1 (D00006)   300 0    Broken line    Green
No. 2 (D00007)   100 0     Thick line    Purple

2. Specify the following constants for addresses D00005, D00006, and D00007.

D0005 <- 800

D0006 <- 230

D0007 <-  30

 3. Set bit 4 of D00003 (0 -> 1).

D0003 <- H0010

The sampling time and sampling

count data are displayed.

4. Reset bit 4 of D00003 (0 -> 1).

D0003 <- H0000

5. Set bit 4 of D00003 (0 -> 1).

D0003 <- H0010

The displayed sampling time

changes and the sampling count

increases to "2".

A trend line is shown.

6. Reset bit 4 of D00003 (1 -> 0).

D0003 <- H0000

Sampling time display Sampling count display

14:34:47 1
1000

500

0

300

150

0

100

50

0
1 2010

14:36:47 2
1000

500

0

300

150

0

100

50

0
1 10 20

Trend line
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7. Set bit 4 of D00003 (0 -> 1).

D0003 <- H0010

The sampling count increases to "3".

8. Reset bit 4 of D00003 (1 -> 0).

D0003 <- H0000

9. Specify the following constant for address D00006.

D0006 <- 160

10. Set bit 4 of D00003 (0 -> 1).

D0003 <- H0010

The sampling count increases to "4".

11. Reset bit 4 of D00003 (1 -> 0).

D0003 <- H0000

12. Execute sampling of the following data.

Count

15:14:47 20
1000

500

0

300

150

0

100

50

0
1 2010

14:40:47 4
1000

500

0

300

150

0

100

50

0
1 2010

14:38:47 3
1000

500

0

300

150

0

100

50

0
1 10 20

  5   6   7   8   9  10  11  12  13 14

D00005 800 800 800 800 800 800 800 800 800 800

D00006 160 160 160 160 160 210 210 210 210 210

D00007 30 30 30 30 30 30 30 30 30 30

 15  16  17  18  19  20  21  22  23 24

D00005 800 800 800 800 800 800 800 800 800 800

D00006 210 210 210 210 210 210 210 210 210 210

D00007 30 30 30 30 30 30 30 30 30 30

Memory

Count
Memory
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13. To check the old data, press the [Roll Down] switch.

The selection cursor appears at the center of the graph.

The sampling time and sampling count display parts indicate the data of the

selected data element.

The [Graph Return] switch flashes.

(The sampling count display part indicates "20".)

[Roll Down] switch

14. Press the [Roll Down] switch again. The selection cursor moves to the left.

15. Press the [Graph Return] switch.  The display is restored to the most recent trend

sampling data.

Data VariationData Variation
15:17:30 14

Graph
Return Reset

1000

500

0

300

150

0

100

50

0
1 2010

15:17:30 14
1000

500

0

300

150

0

00

50

0
1 2010
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Creating Animation Screens

Control Terminal contains the function to animate or transform texts or graphics.

By specifying coordinates of a graphic on the screen, it can be moved freely.

Also, a graphic can be enlarged or reduced, or can be replaced with a different

graphic.

The level in the tank can be moved up or down.



Creating Animation

13-2

1) Creating the screen title • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • P13-3

The [Draw] menu is used.

2) Registering a graphic as a pattern • • • • • • • • • • • • • • • • • • • • • • • • • •P13-3

A graphic is registered in pattern editing.

3) Registering the graphic in the graphic library • • • • • • • • • • • • • • • • • • P13-5

The [Graphic LIB Edit] window is used.

4) Setting up parameters • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • P13-6

The parameters of the graphic in the graphic library is set up.

5) Setting up graphic relay mode • • • • • • • • • • • • • • • • • • • • • • • • • • • P13-10

The [Graphic Relay] dialog is used.

Create the following screen.

Procedure

Animation Screen Creation

Animation ScreenAnimation Screen
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Operation

Screen Color and Title Setting

1. Select [Screen Setting] from the [Edit] menu.  Set up as shown below.

F (foreground) Black

T (tile) No. 1 (extreme left)

2. Create the following screen title using the [Draw] menu.

Graphic Registration as a Pattern

Create the following graphic to be moved on the animation screen.

Pattern editing of bit map data is useful to create complicated graphics.

Text "Animation Screen"

Foreground: Yellow Enlarge X:2

Background: Black Enlarge Y:2

Rotate: Normal Italic:  unchecked

Direction: RGT Shadow

Box

Foreground: Red Paint: checked

Background: Black Frame: checked

Frame color: Blue

Tile: No. 1 (extreme left)

Line Type: Thick line (No. 2 from the left)

Animation ScreenAnimation Screen

1. Select [Pattern] from the [Item] menu.  The [Pattern] dialog is displayed.  Choose

"2" for [No.] and click [OK].
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2. The [Pattern [2] Edit] window appears.

Select [Change Size] from the [Transform] menu.

3. The following message appears.  Click [Yes].

4. The [Size Change] dialog is displayed.  Set up as

shown below and click [ OK].

X Size: 48 Y Size: 48

Color: 128-Color

A background color of a pattern is usually "Black" unless any changs are not made to the
background. The background color will remain when you place the pattern  on the screen.

ZM-70For

Draw tool bar

It is convenience to set the background color of the pattern first so that it matches with the
color of the screen.

The above pattern is placed on the screen
 whose background color is cyan...

<-- The pattern is displayed as left.

<How to draw this graphic:>

[Line] icon (white)

[Paint] icon (white)

[Circle] icon (white)

Finish this graphic
 by drawing black lines
 between the fingers.

5. Draw the following graphic using the drawing parts tool bar.

The back color in pattern editing is black as default.
A graphic created in pattern editing is thus shown on the screen with the black back color.
If the above graphic is placed on a light blue screen, it appears like this.
It is recommended that the back color in pattern editing be determined in advance as
compared with the screen color.

White

Black
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Graphics must be registered in the graphic library before calling them up for display.

The above graphic has been registered in pattern editing, but also must be registered in

the graphic library.

1. Select [Graphic Library] from the [Item] menu.  The [Graphic Library] dialog is

displayed.  Choose "1" for [Group No.] and "0" for [No.].

6. Close the [Pattern [2] Edit] window, and go back to the [Screen Edit] window.

Graphic Registration in Graphic Library

2. The [Graphic LIB [1:0] Edit] window is displayed.

The graphic is registered in this window.

Click the [Pattern] icon in the draw tool bar.
[Pattern] icon

3. The [Pattern List] window is displayed.

Select No. 2 and click [Place].
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When animating graphics registered in the graphic library, provide them with

parameters.

Parameter Setting

4. The cross cursor is displayed in the window.  Drag the cursor in the following

position and click the mouse.

Parameter
When animating or transforming graphics or texts on the screen, it is necessary to secure memory for these

purposes.  These settings are made by parameters.

Set up parameters in graphic library editing.

1. Select the graphic (handles are shown) in the [Graphic LIB [1:0] Edit] window.

2. Click the [Parameter] icon in the draw tool bar.  The [Parameter Setting [Pattern]]

dialog is displayed.
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3. Choose [Animate] for [Action].

About [Animate] and [Replace]
When [Replace] is chosen, the graphic moves in the following manner.

When [Animate] is chosen, the graphic moves in the following manner.  The previous
graphic is cleared.

4. Set the graphic to move it in the X-axis direction.

When the graphic is moved to the right on the X axis, it is moved in the plus

direction.

About the plus and minus directions
On the Control Terminal screen, the X-
axis starts from the upper left corner of
the screen to the right, and the Y axis
starts from the same corner to the
bottom.  The coordinates of the starting
point are [0,0], and the coordinates of the
end point in the lower right corner are
[639, 479].

When either axis is moved in the plus
direction, its coordinate is increased.
When it is moved in the minus direction, its coordinate is decreased.

Click [Set] for [Start X].  The [Parameter] dialog is displayed.

（0:0）�

（639:479）�

Plus direction

Plus direction

Minus direction

Minus direction

Plus X-axis direction

X：0 X：639
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About [Absolute Input] and [Incremental Input]
When [Absolute Input] is chosen, position inputs are expressed by the distances on the
X and Y axes from the upper left corner (0, 0) of the screen.
When [Incremental Input] is chosen, position inputs are expressed by the distance on
the X and Y axes from the reference position (0, 0) of the graphic.

5. Choose [Incremental + Input (P)].  The entry box becomes active.  Enter "1", and

click [OK].  "Incremental + 1" is now entered for [Start X] in the [Parameter

Setting [Pattern]] dialog.

About parameter numbers
When displaying a graphic on the screen, memory for display must be secured.  Memory
for animation/transformation (parameter memory) also must be secured, but is allocated
following the memory for display.  By specifying a number in the [Parameter] dialog, the
ordinal number for allocating memory for animation/transformation is determined.
Refer to the following example.

Radius X: Absolute Input 1

 Graphic No.0

�

Graphic No.1 Graphic No.2 Graphic No.3

End point X : Incremental +  Input 2
End point Y : Incremental +  Input 3

Radius X: Incremental + Input 4 PX3 : Incremental +  Input 5
PY3 : Incremental +  Input 6

Memory

n

n＋1

n＋2

n＋3

n＋4

n＋5

n＋6

　　　　　Contents

Memory for display

For parameter1（graphic No. 0）

For parameter2（graphic No. 1）

For parameter3（graphic No. 1）

For parameter4（graphic No. 2）

For parameter5（graphic No. 3）

For parameter6（graphic No. 3）

In the graphic relay mode, memory is allocated
 to the above graphics in the sequence as shown
 in the table.
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6. Set the graphic to move it in the Y-axis

direction.

When the graphic is moved up, it is moved in

the minus direction.

Click [Set] for [Start Y].  The [Parameter] dialog is displayed.

Choose [Incremental - Input (N)].  The entry box is becomes active.  Enter "2",

and click [OK].

7. "Incremental - 2" is now entered for [Start Y] in

the [Parameter Setting [Pattern]] dialog.  Click

[OK].

8. Close the [Graphic LIB [1:0] Edit] window.  The [Screen Edit] window appears.

The above step completes parameter setting for the graphic in the graphic library edit

window.

OFF

Minus Y-axis direction

Y：0

Y：479
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Graphic Relay Mode Setting

3. Click [OK].  The [Graphic Relay] dialog is reduced to an icon and stored in the

[Part] auxiliary tool box in the lower left corner of the screen.

XOR mode must be chosen for the animation function.

If [Type: 2-Graphic] and [Mode: REP] are chosen in the [Graphic

Relay] dialog, the graphic cannot be animated normally in the REP

mode.  When [Type: 1-Graphic] is chosen, the graphic is displayed

in the XOR mode, and animation can be normally executed.

When animating or transforming the graphics registered in the graphic library, set up

relay or graphic mode in screen editing.

In this example, choose the graphic relay mode to display graphics by bit activation.

1. Click the [Graphic Relay Mode] icon in the tool bar.

2. The [Graphic Relay] dialog is displayed.  Set up as shown below:

Division No : 0

Memory : D450

Type : 1-Graphic

Start Graphic GNo: 1 No: 0

No. of Relays : 1

Parameter : 2

Process Cycle : Low Speed
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Bring up the graphic on the screen.

1. In accordance with the setting of the [Graphic Relay] dialog ("D450" is specified

for [Memory], "1" is specified for [No. of Relays], and "1" and "0" are specified

for [Start Graphic GNo.] and [No.] respectively), bit 0 of address D450 is

allocated to graphic No. 0 in group No. 1.

Memory Allocation

Graphic Display on Screen

2. By setting bit 0 of address D450, the graphic is displayed in the left corner of the

screen.  By resetting the bit, the graphic is deleted.

[Memory] Memory for graphic display [Graphic Relay] dialogD450�

D451�

D452

PLC→ZM80

Option Address Contents Direction Set in:

Memory for parameter 1 (X coordinate of graphic)

Memory for parameter 2 (Y coordinate of graphic)
[Parameter] 2 addresses (2 words) are secured�

because "2" is specified for [Parameter].

[Start Graphic GNo. : 1  No. : 0 ]

D450
15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

Graphic No.0 in group No.1

[Memory : D450]
[No. of Relays : 1]

Animation ScreenAnimation Screen

D450

When bit 0 of D450 is set (ON):

Graphic No.0 in group No.1 is displayed.
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3. In the [Parameter] dialog, "1" and "2" are specified for [Start X] and [Start Y]

respectively.  In the [Graphic Relay] dialog, "D450" is specified for [Memory].

The X and Y axes are thus provided with D451 and D452 respectively.

Graphic Movement in the X-axis Direction

4. Set bit 0 of D450.

By specifying "K300" for D451, the graphic is moved in the X-axis direction by

300 dots.

5. By specifying "K550" for D451, the graphic is moved to the extreme right (500

dots from the original position).

D450
15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

Graphic No.0 in group No.1

Start X : Incremental + 1 , Start Y : Incremental - 2

D451
D452

For parameter 1 = X coordinate of start point �
�

�

Memory : D450

Parameter : 2
For parameter 2 = Y coordinate of start point �
�

D450
D451 K300

300 dots

Animation ScreenAnimation Screen

When "K300" is specified for D451:

The graphic moves in the plus X-axis direction by 300 dots.

D450
D451 K550

550 dots

Animation ScreenAnimation Screen

When "K550" is specified for D451 :

The graphic moves in the plus X-axis direction by 550 dots from the original position.
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6. Specify "K200" for D452.

"Incremental -" is specified for [Start Y] in the [Parameter Setting [Pattern]]

dialog.  The graphic is thus moved in the minus Y-axis direction by 200 dots.

Graphic Movement in the Y-axis Direction

7. By specifying "K400" for D452, the graphic is moved in the minus Y-axis

direction by 400 dots from the original position.

D450
D451 K550
D452 K200

200 dots

Animation ScreenAnimation Screen

When "K200" is specified for D452 :

The graphic moves in the minus Y-axis direction by 200 dots.

D450
D451 K550
D452 K400

400 dots

Animation ScreenAnimation Screen

When "K400" is specified for D452 :

The graphic moves in the minus Y-axis direction by 400 dots from the original position.
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Graphics can be replaced with different graphics.

Graphic Change

Procedure

1) Registering additional graphics • • • • • • • • • • • • • • • • • • • • • • • • • • • P13-14

Additional graphics can be registered using the registered graphic.

2) Setting up additional parameters • • • • • • • • • • • • • • • • • • • • • • • • • • P13-18

Parameters for graphic change must be set up in the graphic library.

3) Modifying graphic relay mode setting • • • • • • • • • • • • • • • • • • • • • • • P13-19

The [Graphic Relay] dialog is used.

Operation

Additional Graphic Registration

Register the following three additional graphics.

Animation ScreenAnimation Screen Animation ScreenAnimation Screen

Graphic No.0 (registered) Graphic No.1 Graphic No.2 Graphic No.3
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1. Select [Pattern] from the [Item] menu.  The [Pattern] dialog is displayed.  Choose

"2" for [No.] and click [OK].

Click this icon.

2. The [Pattern [2] Edit] window appears.

The registered graphic is shown in the window.  Click the [Screen List] icon.

3. The [Screen List - [Pattern] window is displayed.

Graphic No.0 to No. 2 are registered.
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4. Drag graphic No. 2 to area Nos. 3, 4, and 5.  It is copied to each area.

The copy appears in area No. 3.

5. Close the [Screen List - [Pattern]] window and go back to the [Pattern [2] Edit]

window.  Click the [Next] icon.  The [Pattern [3] Edit] window is displayed.

Click graphic No. 2 and drag it to area No. 3.

Copy the graphic to area No. 4 and 5 in the same manner.
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6. Click the [Rotate Graphic] icon.  Graphic No. 3 is rotated by 90 degrees.

Click this icon. The graphic is rotated by 90 degrees.

7. Click the [Next] icon.  The [Pattern [4] Edit] window is displayed.

8. Click the [Rotate Graphic] icon twice.  The graphic is rotated by 180 degrees.

Click this icon twice. The graphic is rotated by 180 degrees.
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9. Click the [Next] icon.  The

[Pattern [5] Edit] window is

displayed.

Click the [Rotate Graphic] icon

three times.  The graphic is

rotated by 270 degrees.

Additional Parameters Setting

Set up additional parameters for graphic change.

1. Select [Graphic Library] from the [Item] menu.

The [Graphic Library] dialog is displayed.  Choose "1" and "0" for [Group No.]

and [No.] respectively.  Click [OK].

Click this icon three times.  The graphic
is rotated by 270 degrees.

10. Close the [Pattern [3] Edit] window and go back to the [Screen Edit] window.

2. The graphic registered in the graphic library is displayed.  Select the graphic

(handles are shown) and click the [Parameter] icon.
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1. Click the [Graphic Relay] icon in

the [Part] auxiliary tool box in the

left corner of the [Screen Edit]

window.  The [Graphic Relay]

dialog is displayed.

Graphic Relay Mode Modification

3. The [Parameter Setting [Pattern]] dialog containing the set data is displayed.

4. [No.] is the option for the graphic change parameter.

Click [Set] for [No.].  The [Parameter] dialog is displayed.

Choose "Incremental + Input (P)".  The entry box becomes active.  Enter "3" and

click [OK].

5. "Incremental + 3" is now entered for [No.] in the

[Parameter Setting [Pattern]] dialog.

6. The above step completes setting in the graphic

library.  Close the [Graphic LIB [1:0] Edit]

window.
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1. Bring up the registered graphic.

Set bit 0 (ON) of D450 (D450 = H0001).

2. "2" is specified for [Parameter].  Correct it to "3" and click [OK].

Memory addresses D451 to D453 (3 words) are secured.

The above step completes the setting for the animation screen.  Save the created screen

and transfer the data to V6.

ZM-80 Operation Check

Memory Allocation

Graphic Change on Screen

[Memory] Memory for graphic display [Graphic Relay] dialogD450�

D451�

D452�

D453

PLC→V6

Option Address Contents Direction Set in:

Memory for parameter 1 (X coordinate of graphic)

Memory for parameter 2 (Y coordinate of graphic)[Parameter] 3 addresses (3 words) are secured�
because "3" is specified for [Parameter].

Memory for parameter 3 (graphic number)

Animation ScreenAnimation Screen

D450

When bit 0 of D450 is set (ON):

Graphic No.0 in group No.1 is displayed.
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2. Move the graphic.

Specify "K100" for D451 and "K200" for D452.  The graphic is moved in the plus

X-axis direction by 100 dots, and in the minus Y-axis direction by 200 dots.

3. Change the graphic.  Specify "K1" for D453.  Pattern No. 3 is displayed in place

of pattern No. 2.

D450
D451 K100

200 dots

D452 K200

100 dots

Animation ScreenAnimation Screen

D450
D451 K100
D452 K200

K1D453

Animation ScreenAnimation Screen

Pattern No.2 is replaced with pattern No.3.
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4. Specify "K3" for D453.  Pattern No. 5 is displayed in place of pattern No. 3.

5. The graphic called up for change can be moved by changing the data of D451 or

D452.

D450
D451 K100
D452 K200

K3D453

Animation ScreenAnimation Screen

Pattern No.3 is replaced with pattern No.5.

D450
D451 K400
D452 K400

K3D453

400 dots

400 dots

Animation ScreenAnimation Screen
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Calendar Display

With the calendar function, the ZM-80 screen displays "year, month, day, hour, minute,

second, and day of the week".

When using PLC with calendar function to display the calendar:

(1) ZM-80 automatically reads PLC's calendar data to display it on the screen.  ZM-80

then corrects the calendar display by reading the PLC's data every 15 minutes.

(2) For the 15 minutes, ZM-80 displays the calendar using the inner clock.

(3) When ZM-80 must read PLC's calendar data forcibly to update the ZM-80

calendar after correction of PLC's calendar data, set bit 11 (ON) of the read area

memory address "n".

Examples

1) Correcting calendar data from ZM-80 • • • • • • • • • • • • • • • • • • • • • • • P14-2

2) Modifying the calendar part • • • • • • • • • • • • • • • • • • • • • • • • • • • • • P14-10

Calendar data can be corrected from PLC as mentioned above and also by the macro

function of ZM-80.  The procedures of calendar correction by the macro function and

of calendar part modification are explained in this chapter.

When using PLC without calendar function to display the calendar:

(1)Select [System Setting] from the [Item] menu and click [Comm. Parameter].  Specify
the memory to display the calendar in the [Comm. Parameter] dialog.

(2)Use ZM-80's CPU clock.
(3)This type of calendar causes a slight error in time because there is no PLC calendar to

provide ZM-80 with the initial calendar data and allow it to check the time every 15
minutes.  It is thus recommended that the data for the calendar memory be adjusted
from time to time by setting bit 11 of the read area memory address "n".  If this bit is
set (ON) in conjunction with constant sampling, it is recommended that the sampling
be reset as mentioned above.

If calendar data is forcibly read by setting this bit during constant

sampling, timing may be shifted, disturbing the process.  If this bit

is set during sampling, we recommend resetting.
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Operation

Calendar Data Correction by Macro

If calendar data has become different from the actual time, correct the data by setting

the entry mode and by editing the macro.

PLC with calendar function is used in this example.

Create the following screen.

• Text "Calendar Correction"

Foreground White

Background Camel (No. 2 from the right)

Frame color Mahogany (No. 6 from the right)

Tile No. 0

Line type Thick line

Foreground Mahogany (No. 6 from the right)

Line type Thick line

[Fig. 1-1]

Bring up a new screen for creating the above calendar screen.

Check silver-color (extreme right]) for [Back Color] in the [Screen Setting] dialog.

([Edit] menu -> [Screen Setting])

Create the screen title "Calendar Correction" and set up properties as shown below:

Foreground Slate blue (No. 3 from the right)

Background Camel (No. 2 from the right)

Rotate Normal

Direction RGT

Enlarge X 3

Enlarge Y 3

Italic  unchecked

Shadow

• Inner painted box

Paint  checked

Frame  checked

• Outer box

Text

Calendar partSwitch

Text

Numerical data display
in the entry mode

Keypad in the entry mode

A

BCD
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Calendar Part Setting
Set up the calendar part in Fig. 1-1.

(1) Click the [Calendar Display] icon.  The [Calendar] dialog is displayed.

(2) Select the part and place it on the screen.  (Refer to "(A)" in Fig. 1-1.)

Entry Mode Setting
The keypad is required to correct calendar data.  Set up the entry mode for the key pad.

(1) Click the [Entry Mode] icon.  The entry mode parts tool bar is displayed.

Clicking the [Entry Mode] icon brings up the message "Cannot register in this

division.  Register in [1]?".  Click [Yes].

[Save Setting]
Clicking [Parts Select] in the [Calendar] dialog brings up the [Calendar List].  It is
recommended that [Save Setting] be unchecked.

If calendar part No. 4 is selected from the file [Parts_e.z7p] while part No. 1 has been
placed:

<[Save Setting] is checked:>
Calendar part No. 4 is placed but the part No. 1
dialog data is still saved.

<[Save Setting] is unchecked:>
Calendar part No. 4 is placed and its dialog
data is set up while the part No. 1 dialog data is
cleared.

Calendar parts show calendar data (year, month, day, hour, minute, second, day of the
week) in various ways with characters of "-", ":", etc.  If a new calendar part is placed
while the old part data is saved, the format of the new part may be altered.  It will not be
easy to correct such an altered format using the [Modify Part] window, etc. (refer to page
14-12).  Thus, do not check the [Save Setting] box when placing the new calendar part.
The part can be placed in the correct format.
* When placing other parts, such as switch parts, it is recommended that the [Save

Setting] box be checked again.

Part selection No. 49 in file [Parts_e.v6p]

Do not check the [Save Setting] box.

[Main] tab window

Division No. 0

Do not set data in the [Year], [Month], [Day], [Hour], [Minute], [Second], [Week],

and [Day-of-Week Message Setting] tab windows.
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(2) Place a keypad on the screen.  (Refer to "(B)" in Fig. 1-1.)

Click the [Keypad] icon in the entry mode parts tool bar.

[Keypad List] is displayed.  Click [Parts File] and select "Parts_e.v6p".  Select

keypad No. 16 and place it on the screen.

(3) Set up the numerical data display part for "Year".  (Refer to "(C)" in Fig. 1-1.)

Click the [Data Display] icon in the entry mode parts tool bar.  Click [Numerical

Data].  The [Num. Display] dialog is displayed.  Set up as shown below and place

it in the designated position.

• [Num. Display] dialog

Part selection No. 0 (Not Transparent) in file [Parts_e.z7p]

(Check the [ Save Setting] box and select the part.)

Italic  unchecked

Char. Size 1-Byte

Rotate Normal

Direction RGT

Spacing  unchecked

Enlarge X: 2 Y: 2

Foreground Navy (No. 7 from the right)

Background Silver-color (extreme right)

[Detail] tab window

Use Operation  unchecked

Alarm checked

Max. 2100

Max. Color Foreground Blue

Background Black

Min. 1998

Min. Color Foreground Red

Background Black

Dot  Checked

Interval  Checked

Direction ①②③�
④⑤⑥�

X Distance 0

Y Distance 5

Quantity X 1

Quantity Y 7

Order INC  checked

Memory INC  checked

Num. Data Memory $u0001

Step 1

(4) While the placed numerical display part is selected (handles are shown), select

[Multi Copy] from the [Edit] menu.  The [Multi Copy] dialog is displayed.  Set up

as shown below and click [OK].

Keypad Data Display Entry Display Max. Display Min. Display Detail

[Main] tab window

Division No. 0

Memory $u0001

[Type] tab window

Display Function Entry Target

Order 0

Digits 4

Decimal Point 0

Display Type DEC (w/o sign)

Input Type DEC

Data Length 1-Word

Zero suppress  checked

Flush R  checked

[Char. Prop] tab window

Char. Type Bold

Transparent  unchecked

• [Multi Copy] dialog
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Create and place the text "Year" on the

screen.

Make 6 copies of "Year", and change them

to "Month", "Day", "Hour", "Minute", "Second",

and "Day of the week" respectively using

the [Detail/Prop Change] icon.

[Detail] tab window

Use Graphic  unchecked

Default to 0  unchecked

Process Cycle Low Speed

[Main] tab window

Division No. 1

Type Data Display

Command Memory $u0000

Info. Output Memory $u16340

Reverse  checked

Target Memory Direct

Input Item Select Internal

GD80 Compatible  unchecked

(6) Click [Detail] in the entry mode parts tool bar.

The [Entry] dialog is displayed.  Set up as shown below:

[Type] tab window

Digits 2

[Detail] tab window

Alarm checked

Max. 12

Min. 1

[Type] tab window

Digits 2

[Detail] tab window

Alarm checked

Max. 31

Min. 1

[Type] tab window

Digits 2

[Detail] tab window

Alarm checked

Max. 23

Min. 0

[Type] tab window

Digits 2

[Detail] tab window

Alarm checked

Max. 59

Min. 0

[Type] tab window

Digits 2

[Detail] tab window

Alarm checked

Max. 59

Min. 0

[Type] tab window

Digits 1

[Detail] tab window

Alarm checked

Max. 6

Min. 0

(5) Set up the [Num. Display] dialog for the six copy numerical display parts as

shown below:

(7) Create the texts of "Year", "Month", "Day", "Hour", "Minute", "Second", and

"Day of the week" and set up properties as shown below:

(Refer to "D" in Fig. 1-1.)

Foreground Navy

Enlarge X 2

Enlarge Y 2

Rotate Normal

Direction RGT

Transparent  checked

Italic  unchecked

Normal  checked

• [Num. Display] dialog for month

• [Num. Display] dialog for day

• [Num. Display] dialog for hour

• [Num. Display] dialog for minute

• [Num. Display] dialog for second

• [Num. Display] dialog for day of the week

• [Entry] dialog

Click [OK].  The [Entry] dialog is reduced to an

icon and stored in the [Part] auxiliary tool box in

the lower left corner of the screen.
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Macro Setting
Switch ON macro and screen OPEN macro are used.

••• Switch ON macro •••

Create the switch shown in Fig. 1-1 (page 15-2).  Pressing this resets the calendar to the

corrected data.

(1) Click the [Switch] icon.

(2) The [Switch] dialog is displayed.  Set up as shown below:

[Main] tab window

Division No. 1

Draw Mode REP

Output Memory  unchecked

Lamp Memory  unchecked

Output Action Momentary

Function No Function

[Character] tab window

(No setting)

[Detail ] tab window

Use ON Macro checked

ON Macro Edit Refer to step 3 below.

Use OFF Macro  unchecked

Use Interlock  unchecked

Process Cycle High Speed

[Color] tab window

Frame ON Color Gray

ON Color Red

Frame OFF Color Gray

OFF Color Mahogany

1) Click area B of line No.

0.  The [Line No: 0]

dialog is displayed.

(3) Click [ON Macro Edit].  The [Switch ON Macro Edit] window is displayed.

• [Switch] dialog

Part selection No. 71 from file [Parts_e.z7p]

Click either area A or area B depending on purposes.

When executing cutting, copying, or pasting, click area A.

When setting macro commands, click area B.

A B
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2) Set up macro for adjusting the calendar to the corrected data.

Click [Command].

The [Command]

dialog is displayed.

Choose [SYS] and

click [OK].  The

[Line No: 0] dialog

appears.

0 Sunday

1 Monday

2 Tuesday

3 Wednesday

4 Thursday

5 Friday

6 Saturday

SET_CLND
The value in F1 is set for the use of the system calendar.  When PLC has the calendar function, its clock data is

also set.
F1 memory

     n + 0 Year (4 digits)

     n + 1 Month

     n + 2 Day

     n + 3 Hour

     n + 4 Minute

     n + 5 Second

     n + 6 Day of the week ( 0 - 6)

     n + 7 Station number Use for 1 : n (multi-drop)

All data should be binary.

3) Click [F0].  The [System Call] dialog is displayed.

Choose [SET_CLND] and click [OK].  The [Line No: 0] dialog appears.

If "SET_CLND" is executed during constant sampling, timing may

be shifted, disturbing the process.   After execution of this, we

recommend resetting of the sampling.
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••• Screen OPEN macro •••

(1) Select [Edit OPEN Macro] from the [Edit] menu.  The [OPEN Macro Edit]

window is displayed.

(2) Click line No. 0.  Choose [MOV] in the [Command] dialog.  With this command,

the macro is set for setting bits 14 and 15 of the memory address specified for

[Command Memory] in the [Entry] dialog.

"$u0000=C000H (W)" is indicated in line No. 0

GET_CLND
This system call gets the calendar data.

MOV
Calculation F0 = F1

F1 is moved to F0.

Both F0 and F1 can be located in the PLC memory at the same time.

F1 memory

     n + 0 Year (4 digits)

     n + 1 Month

     n + 2 Day

     n + 3 Hour

     n + 4 Minute

     n + 5 Second

     n + 6 Day of the week

All data should be binary.

OPEN macro
OPEN macro is executed when the screen is opened.

4) Click [F1].  The [Memory Input] dialog is displayed.

Specify "$u0001" and click [OK].  The [Line No: 0] dialog appears.

Seven words are allocated to F1 memory.

5) Click "x" in the upper right corner of the [Line No. 0] dialog.

"SYS (SET_CLND) $u0001" is displayed in line No. 0.

6) Click "x" in the upper right corner of the window.  The [Switch ON Macro

Edit] window is closed and the [Switch] dialog appears.

(4) Click [Place] and place the switch in the designated position (Fig. 1-1).

(3) Click [Next] in the [Line No: 0] dialog.  The [Line No: 1] dialog is displayed.

(4) Choose [SYS] in the [Command] dialog and choose [GET_CLND] in the [System

Call] dialog.  This system call gets the calendar data.

"SYS (GET_CLND) $u0001" is displayed in line No. 1
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(5) Click the "X" button in the upper right corner of the [OPEN Macro Edit] window.

The window is closed, and the [Screen Edit] window appears.

ZM-80 Operation Check

Save the created screen.

While referring to "Chapter 3  Screen Data Transference", transfer the created screen

data to ZM-80 and check that ZM-80 operates correctly.

1. Open the "Calendar Correction" screen.  The calendar part indicates the calendar

data from PLC.

2. Change the day.

Move the cursor to the part of "Day" by pressing the "�" key on the keypad.  In

this example, enter "10" for "Day".

Likewise, enter "16" for "Hour", "50" for "Minute", and "10" for "Second".

3. Press the switch for ON macro.

4. The calendar part indicates the hour, minute, and second as entered.

5. Check that the clock memory data of PLC is also changed.

When the MITSUBISHI series A PLC is used, for example:

D9026 H1016 -> (Day: 10, Hour: 16)

D9027 H5010 -> (Minute: 50, Second: 10)

Press this switch.

On execution of the macro, this calendar
part indicates the corrected time.
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Modify the current calendar part by removing the areas for second and day of the week.

[Calendar] Dialog Modification
(1) Double-click the calendar part.  The [Calendar] dialog is displayed.

(2) Click the [Second] tab.  In the [Second] tab window, uncheck the [Display] box.

(3) Click the [Week] tab.  In the [Week] tab window, uncheck the [Display] box.

Click [OK].  The [Calendar] dialog is closed.  The following calendar part is

shown.

Calendar Part Modification

When selecting two or more lines at a time,
hold down the [CTRL] key and click them.

(3) Click and delete the "Char" lines for

second, "(", and ")".

[Modify Part] Window
(1) While the calendar part is selected (handles are shown), click the [Change the

setting of a part placed] icon.  The [Modify Part] window is displayed.

(2) Select [Item List] from the [Tool] menu.  [Item List (Placed Part)] is displayed.
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(4) Bring up both [Item List (Placed Part)] and [Modify Part] window.

Click [Grouping Start >>>].  All included items are selected.

The calendar part in the [Modify Part] window is also selected.

Reduce the calendar display part by dragging the handle of the part in the X-axis

direction.

(8) Click "X" in the [Modify Part] window.  The [Screen Edit] window appears.

(7) Click "X" in [Item List (Placed Part)].  The list is closed.

(6) Click the [Frame Auto Fit] icon.  The frame is snapped to the calendar part.

(5) Click the next [Grouping Start >>>>].  Reduce the calendar part in the same

manner.
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Notes on calendar part modification

1. When adding or removing an area for year, month, day, hour, minute, second, or day
of the week of the calendar part, use the [Calendar] dialog.  The [Modify Part] window
is not valid for adding or removing areas because the [Calendar] dialog cannot be
opened.

2. Calendar display part characters (":", "/", etc.) or frame can be modified in the [Modify
Part] window.

3. In [Item List (Placed Part)], the calendar part areas for year, month, day, hour, minute,
second, and day of the week are displayed as one item.  When selecting each area,
click the desired one on the screen.

4. When enlarging/reducing an area of the calendar part, click the area and drag a
handle.

5. When aligning the characters or areas of the calendar part, display grids on the screen
(select [Display Environment] from the [Display] menu.  Open the [Grid] tab window
and check [Grid Dsp.].  Choose "1-Byte" for [Grid Type].)  Click the desired character/
area and move manually.

6. If an area of the calendar part is placed outside the frame in the [Modify Part] window,
the area may not be selected.  In such a case, place the frame again by clicking the
[Frame Auto Fit] icon, and select the area.

Areas for year, month, day, hour, minute, second, and day of the week

Frame

Characters

Frame

[Frame Auto Fit] icon



Option-1

O
p

tio
n

Memory card/Memory manager function

�

It is possible to store data from a 
memory card to a PLC, or from a 
PLC to a memory card.�

PLCMemory card

240�
520�
340

240�
520�
340

data data

ZM-80

Sampling data can be stored on 
memory cards.  It is possible to keep 
data intact even after a power failure�
�

PLCZM-80Memory card

GD-MREC

External Memory
Card
With a ZM-70
(Recorder)

ZM-70For
The followings
are avairable:
256Kbyte
512Kbyte
  1  Mbyte

Memory Manager Function
Memory cards can be used as external storage media for a PLC, and data can be read or written.

Since memory cards can store a great amount of data, it is not necessary to allocate memory in the PLC for

storage purposes.

The memory card mode can be used when an optional built-in memory card or external

memory card unit is attached to a ZM-80.

Use Sharp's SRAM cards, REC-MCARD (256 KB, 512 KB, 1 MB, 2 MB, and 4 MB are

available).

Memory card mode has two major functions: the memory manager function and the data

logging function.

With the memory manager function, memory cards can be used as external storage

media for the PLC.

Data Logging Function
Sampling data can be stored on memory cards.  Thus, in the event of a power failure, data on memory cards can

be kept intact.

Using Memory Cards

as External Storage Media for a PLC
(The Memory Manager Function )

P
ro

c
e

d
u

re

With a ZM-80
(Card recorder)
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Procedure

1)    Partitioning the area on the memory card into files and setting up the files

[System Setting] -> [Memory Card Setting]  • • • • • • • • • • • • • •  P Option-3

2)    Creating the memory card format screen (Screen I)

[Memory Card Mode] -> [Detail] ([Memory Card] dialog) [Format Switch]

• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • •  P Option-6

3)    Creating the edit screen for memory card names and numbers, file names,

and record names (Screen I)

[Memory Card Mode] -> [Detail] ([Memory Card] dialog) [Display Area]

[Memory Card Memory Card Name] [Memory Card File Name], etc.

 • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • •  P Option-9

4) Creating the screen for data transfer between a V6 and a PLC (Screen II)

[Memory Card Mode] -> [Detail] ([Memory Card] dialog) [Memory Card File

No.] [Memory Card Record No.] [Data Transfer PLC > V6], etc.

• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • •  P Opition-19

5) Creating an error indicator lamp and error message display part (Screen I)

[Message Mode], etc. • • • • • • • • • • • • • • • • • • • • • • • • • • • •  P Option-26

[Screen- I] [Screen-II]

The memory manager function is used in this example:

To set up the memory manager function, the following two settings are required.

1. [Memory Card Setting]

This setting is required to partition the area on the memory card into files and

to set up data for the files.

2. [Memory Card Mode]

This setting is required to format memory cards, and to edit and transfer data.

Create the following two screens:

Screen I For memory card formatting, and for editing of the names

of cards, files, and records.

Screen II For data transfer between memory cards and the PLC
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Operation

When memory cards are used, set up the [Memory Card] dialog.  The area on the

memory card is partitioned, and either the memory manager function or the data

logging function is chosen for each file from the options in this dialog.

[Memory Card] Dialog Setting
Select [System Setting] from the [Item] menu and click [Memory Card Setting].  The

[Memory Card] dialog is displayed.

A memory card can be partitioned into a maximum of 16 files, and one file can be

partitioned into a maximum of 4095 records.

Set up file Nos. 0 and 1 as in the following example.

1.    Set up file No. 0.

Memory card status is written from the V6 to the PLC.  Six memory words

starting from the top address specified for [I/F Memory] are used for storage.

Specify "D600" in this example.

For the data to be written, refer to page Option-30.

2.    Specify types of files for partitioning the memory card.

Choose from the following three settings for [Type].

[Not used] Files are not used.

[Data File] This is the file type for the memory manager function.

[Buffering File] This is the file type for the data logging function.

Choose [Data File].

3.    Specify the number of records to partition file No. 0 for [No. of Records].

(Setting range: 1 to 4095)

Specify "3".

File No.

Memory Card Setting
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Card and�
file information �
(1024 words)

Files

M
em
ory card size

ZM-70For

Setting
range is
1 to 1024.

4. Specify the number of words to be recorded for [No. of Data].

(Setting range: 1 to 1024)

Specify "12".

5. Specify the maximum number of characters for [Bytes for Record] for giving

names to records. (Setting range: 0 to 32)

Specify "6".

6. When transferring data between the ZM-80 and the PLC, choose whether only

data or data plus record names will be transferred for [Transfer Mode].

Choose "Data + Record Name".

7. When transferring data from the ZM-80 to the PLC, specify the top memory

address for [Memory] for storing data in the PLC memory.

Specify "D610".

8. The above step completes the [Memory Card] dialog setting for file No. 0.

Next, open the [1] tab window for file No. 1.  Set the options as shown below:
[File No.1]

 Type Data file

 No. of records 2

 No. of data 10

 Bytes for record 8

 Transfer mode Data only

 Memory D630

9. Click [OK].  This step completes [Memory Card] dialog setting for file No. 1.

Calculation of File Size on a Memory Card
The first 1024 words on the memory card are used for card and file information.  The

1025th word and after are used for files.

File size can be calculated by the following equation:

Calculation of file size (Unit: word)

File size = (bytes of record name / 2 + data ) x record

Calculating the size of file No. 0:

(6 / 2+12) x 3 = 45 45 words

Calculating the size of file No. 1:

(8 / 2+10) x2 = 28 28 words

Thus 1097 words have been used on the memory card.

1024+45+28=1097
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Relationship between File No. 0, 1 & PLC memory
The relationship between file Nos. 0 and 1 and the PLC memory is illustrated below:

Memory Card

Memory Card

Record　 0
Record Name

Data 0

Data 1

Data 2

Data 3

Data 4

Data 5

Data 6

Data 7

Data 8

Data 9

Data 10

Data 11

File 0

Record　1

Data 0

Data 1

Data 2

Data 3

Data 4

Data 5

Data 6

Data 7

Data 8

Data 9

Data 10

Data 11

Record　 2

Data 0

Data 1

Data 2

Data 3

Data 4

Data 5

Data 6

Data 7

Data 8

Data 9

Data 10

Data 11

D610

D611

D612

D613

D614

D615

D616

D617

D618

D619

D620

D621

D622

D623

D624

Addresses for the�
record name

Addresses �
for the data

PLC�
Memory

Record　 0

Data 0

Data 1

Data 2

Data 3

Data 4

 Data 5

Data 6

Data 7

Data 8

Data 9

File 1

Record　 1

Data 0

Data 1

Data 2

Data 3

Data 4

Data 5

Data 6

Data 7

Data 8

Data 9

D630

D631

D632

D633

D634

D635

D636

D637

D638

D639

Addresses for the data

PLC�
memory

Record name Record name

Record name Record name

Record name Record name

Record name Record name

Record Name
Record Name

Record Name

Record Name
Record Name

Record Name

Record Name
Record Name

* Although [Bytes for Record]

was set up, "Data only" was

chosen for [Transfer Mode] in

the example above.  In such

a case, record names are not

stored in the PLC memory

specified as [Memory];

however, they are stored on

the memory card.
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Type Data File

No. of Records 2

No. of Data 10

Bytes for Record 8

Transfer Mode Data only

Memory D630

Type Data File

No. of Records 3

No. of Data 12

Bytes for Record 6

Transfer Mode Data

+ Record  Name

Memory D610

[Memory Card] dialog setting for file
No. 0

[Memory Card] dialog setting for file
No. 1
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[Memory Card Mode] icon Memory card parts tool bar

< Memory card parts tool bar >

When creating a memory card format switch, click the [Format Switch] and [Detail]

icons from the memory card parts tool bar, and set their respective dialog boxes.

Selection of Memory Card Mode
1. Open the [Screen [10] Edit] window.  Click silver-color (extreme right) for [F]

(foreground) in the [Screen Setting] dialog.  (Select [Screen Setting] from the

[Edit] menu.)

2. Click the [Memory Card Mode] icon from the tool bar.  The memory card parts

tool bar is displayed.

Creation of the Memory Card Format Screen

When using a new memory card, it must be initialized (formatted) as set in the

[Memory Card] dialog.  Formatting is executed by pressing the format switch as shown

in the following figure.  Create this screen by opening the [Screen [10] Edit] window.

[Screen 1]

3. Drag the memory card parts tool bar downward until all icons come into

view.  The following icons are included:

Display Area Memory Card Name Memory Card File No. Memory Card Switch Memory Card Record No. Quit

Memory Card No.  Format Switch Memory Card File Name Memory Card Record Name Detail
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Division No. 0

Draw Mode REP

Output Memory  unchecked

Lamp Memory  unchecked

Output Action Momentary

(ignored)

Function Card Format

[Character] tab window

No. 0 "Format"  *

[Char. Prop.] dialog

Char. Type Normal

Foreground White

 Transparent checked

 Italic  unchecked

Rotate Normal

Direction RGT

Enlargement X : 1   Y : 1

[Detail] tab window

Use ON Macro  unchecked

Use OFF Macro  unchecked

Use Interlock  unchecked

Process Cycle High Speed

[Color] tab window

ON color Green

OFF color Red
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  * Place the switch on the screen and enlarge it by two grids in the X direction.  Bring

up the [Switch] dialog again.

For the position of the switch on the screen, refer to [Screen I] on the previous

page.

[Detail] Settings for a Memory Card
For formatting a memory card, click the [Detail] icon and specify a division number

equivalent to the division number set for the editing layer (the base is used in this

example) for the format switch.

1. Click the [Detail] icon from the memory card parts tool bar.  The [Memory Card]

dialog is displayed.

Setting of the Format Switch
1. Click the [Format Switch] icon from the memory card parts tool bar.

The [Switch] dialog is displayed.

"Card Format" has been specified for

[Function] in the dialog.

2. Set the tab windows as shown below:
Part selection  No. 9 in file [Parts_e.z7p]

[Main] tab window
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[Main] tab window

Division No. 0

Memory D606

Key display location OVLP0

Process Cycle Low Speed

2. Set up the tab windows as shown below:

1) When editing or transferring data stored on the memory card between the

ZM-80 and the PLC, the memory address specified for [Memory] is used for

controlling the process.

Three words from the top address are used.  For more information, refer to

page Option-37.

2)    When editing memory card names and numbers, file names, and record

names, choose where to place the entry keys for [Key Display Location].

Choose one from "OVLP0" (overlap 0), "OVLP1", "OVLP2", and "BASE".

Choose "OVLP0" in this example.

3) Set up [Enlarge] in the [Char. Prop] tab window so as to double the sizes of

file names and record names to be displayed in the display area.  Specify "2"

for [X] and [Y].

4) Click [OK].

The [Memory Card] dialog is then reduced to an icon and stored in the [Part]

auxiliary tool box in the lower left corner of the screen.  At the same time, the

[Overlap (Multi)] dialog is displayed.

ZM-70For
Specify
"$u4060" for
[Memory] for
the ZM-70.

[Char. Prop] tab window

Char. Type Normal

Transparent  unchecked

Italic  unchecked

Enlarge X :2   Y : 2

Foreground White

Background Black

   Overlap No. 0

   Item Select  unchecked

   Command Internal

   Memory $u16340

Click [OK].

The [Overlap (Multi)] dialog is also reduced to an icon

and stored next to the [Memory Card] dialog icon in the

[Part] auxiliary tool box.

For the procedure for multi-overlap editing, refer to page Option-14.

The memory card format screen has been set.
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Creation of the Edit Screen for Memory Card Names

and Numbers, File Names, and Record Names

Create an edit screen on Screen I.  Memory card names and numbers, file names, and

record names can be edited on the ZM-80.

Setting of the Display Area
Set up the area to display the names and numbers of files and records.

1. Click [Display Area] from the memory card parts tool bar.

The [Display Area] dialog is displayed.

[Screen I] [Screen I-1]
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2. Set the dialog as shown below and

set the area as shown in the above

[Screen I-1].

Part selection  No. 12 in file [Parts_e.z7p]

Division No. 0

In-area Prop.

Foreground White

Tile No.0 (extreme left)
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[Main] tab window

Division No. 0

[Type] tab window

Display Function Memory Card Name

Bytes 8 *

Flush L

[Char. Prop.] tab window

Char. Type Normal

Transparent  unchecked

Setting of the Card Name & No. Display Parts
Setting of the Card Name and Number Display Parts

1. Click the [Memory Card Card No.] icon from the memory card parts tool bar.  The

[Num. Display] dialog is displayed.

Place the part as shown below.

3. Click the [Memory Card Memory Card Name] icon from the memory card parts

tool bar.  The [Char. Display] dialog is displayed.

Memory card number

Italic  unchecked

Char. Size 1-Byte

Rotate Normal

Direction RGT

Spacing  unchecked

Enlarge X : 1  Y : 1

Foreground White

Background Blue

[Detail] tab window

Process Cycle High Speed

Division No. 0

[Type] tab window

Display Function Memory Card No.

Digits 1

Decimal Point 0

Display Type DEC (w/o sign)

Zero Suppress  checked

Flush R

[Char. Prop.] tab window

Char. Type Normal

Transparent  unchecked

2. Set the dialog as shown below:

•[Memory Card Card No.]

Part selection   No. 1 in file [Parts_e.z7p]

[Main] tab window

Italic  unchecked

Rotate Normal

Direction RGT

Spacing  unchecked

Enlarge X:1 Y: 1

Foreground White

Background Blue

[Detail] tab window

Process Cycle High Speed

4. Set the dialog as shown below:
•[Memory Card Memory Card Name]

Part selection  No. 0 in file [Parts_e.z7p]
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4. Set the options in the tab windows in the same manner as those for the memory

card name display part, except for the following:
•[Memory Card File Name]

[Type] tab window

Display Function Memory Card File Name

Place the display part as shown above.

2. Set the options in the tab windows in the same manner as those for the memory

card number display part, except for the following:

•[Memory Card File No.]

[Type] tab window

Display Function Memory Card File No.

Place the display part as shown above.

3. Click the [Memory Card File Name] icon from the memory card parts tool bar.

The [Char. Display] dialog is displayed.

Memory card name

Memory card file number

Memory card file name

O
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Place the display part as shown below.

Setting of the File Name & No. Display Parts
Set up the file name and number display parts to check the file name and number of the

selected memory card.

1. Click the [Memory Card File No.] icon from the memory card parts tool bar.  The

[Num. Display] dialog is displayed.

* [Bytes] can be specified in the range of 0 to 32.  A memory card name within the specified number of bytes can be
displayed in the part.
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Setting of the Record Name & No. Display Parts
Set up the record name and number display parts to check the record name and number

of the selected memory card.

1. Click the [Memory Card Record No.] icon from the memory card parts tool bar.

The [Num. Display] dialog is displayed.

2. Set the options in the tab windows in the

same manner as those for the memory card number display part, except for the

following:
[Memory Card Record No.] [Type] tab window

Display Function Memory Card Record No.

Place the display part as shown above.

3. Click the [Memory Card Record Name]

icon from the memory card parts tool

bar.  The [Char. Display] dialog is

displayed.

4. Set the options in the tab windows in the same manner as those for the memory

card name display part, except for the following:
[Memory Card Record Name] [Type] tab window

Display Function Memory Card Record Name

[Bytes for Record] has been specified for each file in the [Memory Card] dialog.

 Check the maximum number for [Bytes for Record] and enter the same number for

[Bytes].

In this example, "6" and "8" have been specified for [Bytes for Record] for file Nos. 0

and 1 respectively.  Thus, enter "8" for [Bytes].

Place the display part as shown above.

Setting of the Selection and Edit Switches
Set the switches for selecting files and records, and for editing card names and

numbers, file names, and record names.

Memory card record number

Memory card record name

Card name edit switch

Card number edit switch
Record selection switch

File selection switch

File name edit switch

Record name edit switch
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Rotate Normal

Direction RGT

Enlarge X:1   Y:1

[Detail] tab window

 Use ON Macro  unchecked

 Use OFF Macro  unchecked

 Use Interlock  unchecked

 Process Cycle High Speed

 Define MLIB Placement     checked

[Color] tab window

 ON Color Red

 OFF Color Blue

* "Card No. Edit: 1" specified for [Function]

[Memory Card Switch] icon from the memory card parts tool bar
• Clicking the [Memory Card Switch] icon brings up the pull-down menu of the

switches for memory card mode.

means multi-overlap No. 1.  The entry keys set in multi-overlap editing

No. 1 are called up for card number editing.  Refer to page Option-14

for more information on multi-overlap editing.

•[Card Name Edit]

Set the options in the tab windows in the same manner as those for the card number

edit switch, except for the following:

[Main] tab window

Function Card Name Edit: 2 *

[Character] tab window

No.0 Card Name Edit

* Click [Change] for [Function].  Click the [Memory Card] tab.  Choose [Card Name

Edit] and specify "2" for [Overlap No.].

The entry keys set in multi-overlap editing No. 2 is called up for card name editing.

Refer to page Option-16 for more information on multi-overlap editing.
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Division No. 0

Draw Mode REP

Output Memory  unchecked

Lamp Memory  unchecked

Output Action Momentary

(ignored)

Function Card No. Edit: 1 *

[Character] tab window

No.0 Card No. Edit

[Char. Prop.[No. 0]] dialog

Char. Type Normal

Foreground White

Transparent  checked

Italic  unchecked

• When creating switches for edit, selection, or data
transfer related to memory cards, files, or records, click
the corresponding option from the menu.

1. Click the [Memory Card Switch] icon from the memory card parts tool bar.  Click

[Card No. Edit] and [Card Name Edit].  Enlarge their switches by 2 grids in the X

direction and place them on the screen as shown on the previous page.  Set their

switch dialog boxes as shown below:
•[Card No. Edit]

Part selection  No. 9 in file [Parts_e.z7p]

[Main] tab window
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•[File Select Edit]

Set up the options in the tab windows in the same manner as those for the card

number edit switch, except for the following:

[Main] tab window

Function File Select

[Character] tab window

No.0 File Select

•[File Name Edit]

Set the options in the tab windows in the same manner as those for the card number

 edit switch, except for the following:

[Main] tab window

Function File Name Edit: 2

[Character] tab window

No.0 File Name Edit

•[Record Select]

Set the options in the tab windows in the same manner as those for the card number

edit switch, except for the following:

[Main] tab window

Function Record Select

[Character] tab window

No.0 Record Select

•[Record Name Edit]

Set the options in the tab windows in the same manner as those for the card number

edit switch, except for the following:

[Main] tab window

Function Record Name Edit: 2

[Character] tab window

No.0 Record Name Edit

Multi-Overlap Editing
Set the entry keys in multi-overlap editing for editing memory card names and

numbers, file names, and record names.

Memory card numbers -> Multi-overlap editing No.1

The names of memory cards, files, and records -> Multi-overlap editing No.2

Set up multi-overlap editing No. 1.

1. Select [Multi-Overlap] from the

[Item] menu.  The [Multi-

Overlap] dialog is displayed.

Specify "1" and click [OK].

2. The [Multi-Overlap [1] Edit]

window is displayed.  Create the

overlap as shown on the right

using the steps below.
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[Keypad]
[Entry  Display]

[Detail]

O
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[Char. Prop.] tab window

Char. Type Normal

Transparent  unchecked

Italic  unchecked

Char. Size 1-Byte

Division No. 0

[Type] tab window

Display Function Entry Display

Digits 1

3. Set a normal overlap on the base editing layer for multi-overlap editing No. 1.

("Base" appears in the lower right corner.)

1) Click the [Overlap] icon from the tool bar.  The [Overlap (Normal)] dialog

    is displayed.

2) Set as shown below:

Part selection  No. 0 in file [Parts_e.z7p]

Use System Button  checked

Area Prop.

Foreground Yellow

Tile No. 0 (extreme left)

Continue reading PLC memory when set to OFF  unchecked

3) Place the overlap.

4) Enlarge the overlap so as to place the entry keys.

How to change the size of the overlap part:
Select [Display Environment] from the [Display] menu.  The [Display Environment] dialog
is displayed.  Open the [Grid] tab window and set as shown below:

Grid Dsp. checked
Grid Color Red
Grid Type Mode

"Mode" type grids are displayed.  Enlarge the placed overlap based on the grids.

X size by 8 grids Y size by 1 grid

Drag a handle of the overlap. (See figure on the previous page.)

4. Set up entry keys on the placed normal overlap.

1) Right-click the mouse.  Click [Overlap

0] from the pop-up menu to switch the

editing layer.

("OVLP0" appears in the lower right corner.)

2) Click the [Entry Mode] icon from the tool bar.  Click the [Keypad], [Entry

Display], and [Detail] icons from the entry mode parts tool bar, and set their

respective dialog boxes.

•[Keypad]

Part selection  No. 1 in file [Parts_e.z7p]

•[Entry Display] (Numerical Data)

Part selection No. 0 in file [Parts_e.z7p]

[Main] tab window
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* Memory card No. 0 is entered through the entry keys set up in this step.

0 to 255 can be designated as memory card numbers.  In the [Type] tab window for

[Entry Display], the number specified for [Digits] must be "3" or less.  "1" is specified in

this example.

5. Click the [Next] icon.  The [Multi Overlap [2] Edit] window is displayed.

Create the overlap as shown by the steps below.

6. Set up a normal overlap on the base

editing layer for multi-overlap editing

No. 2.  ("Base" appears in the lower

right corner.)

1) Click the [Overlap] icon.  The

[Overlap (Normal)] dialog is

displayed.

2) Set as shown below:
Part selection  No. 0 in file [Parts_e.z7p]

Use System Button  checked

Area Prop.

Foreground Yellow

Tile No. 0 (extreme left)

Continue reading PLC memory when set to OFF unchecked

3) Place the overlap.

4) Enlarge the overlap so as to place the character entry keys.  (See figure

above.)

Bring up "mode" type grids.

X size by 40 grids

Y size by 2 grids

Drag a handle of the overlap. (See figure on the previous page.)

7. Set up the entry keys on the placed normal overlap.

1) Right-click the mouse.  Click [Overlap 0] from the pop-up menu to switch

the editing layer.  ("OVLP0" appears in the lower right corner.)

2) Click the [Entry Mode] icon from the tool bar.

•[Detail] ([Entry] dialog)

[Main] tab window

Division No. 0

Type Memory Card

[Detail] tab window

Use Graphic  unchecked

Default to 0  unchecked

Process Cycle Low Speed

Rotate Normal

Direction RGT

Spacing  unchecked

Enlarge X: 1 Y: 1

Foreground Black

Background Yellow

[Detail] tab window

Process Cycle High Speed
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3) Click the [Keypad], [Entry Display], and [Detail] icons from the entry mode

parts tool bar, and set their respective dialog boxes.

•[Keypad]

Part selection  No. 18 in file [Parts_e.z7p]

•[Entry Display] (Character)

Part selection  No. 6 in file [Parts_e.z7p]

Rotate Normal

Direction RGT

Spacing  unchecked

Enlarge X: 1 Y: 1

Foreground Black

Background Yellow

[Detail] tab window

Process Cycle High Speed

*  The entry keys set up in this step are used to enter the names of memory cards,

    files, and records.

•[Detail] ([Entry] dialog)

[Main] tab window

Division No. 0

Type Memory Card

[Detail] tab window

Use Graphic  unchecked

Default to 0  unchecked

Process Cycle Low Speed

8. Select [Screen] from the [Item] menu.  Specify "10" in the [Screen] dialog and

click [OK].  The [Screen [10] Edit] window is displayed.

9. Click [Quit] from the memory card parts tool bar.  This step completes the setting

of memory card mode.

Setting of the Next Screen Switch, Screen Title, and

Boxes

1. Create a switch to bring up the next screen.

Click the [Switch] icon from the tool bar.  The [Switch] dialog is displayed.  Set as

shown below and place the switch in the upper right corner of the screen.

Part selection  No. 1 in file [Parts_e.z7p]

   [Main] tab window

Division No. 0

Draw Mode XOR
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[Main] tab window

Division No. 0

[Type] tab window

Display Function Entry Display

Bytes 8

Flush L

[Char. Prop.] tab window

Char. Type Normal

Transparent  unchecked

Italic  unchecked
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•[Text] Text: "Memory Card Edit Screen"

Foreground Black

Background Silver-color

Rotate Normal

Direction RGT

Enlarge X 2

Enlarge Y 2

Transparent Italic

Normal

•[Box]

Paint checked

Frame checked

Foreground White

Frame Color Pine green (No. 4 from the right)

Tile No. 0 (extreme left)

Line Type Thick line (No. 2 from the left)

•[Box]

Paint checked

Frame checked

Foreground Pine green

Frame Color Pine green

Tile No. 0 (extreme left)

Line Type Thick line (No. 2 from the left)

•[Line]

Color Pine green (No. 4 from the right)

Line Style   Thick line (No. 2 from the left)

• Set the texts "Card No.", "Card Name", "File No.", "File Name", "Record No.",

and "Record Name" as shown below:

Foreground Blue

Background White

Rotate Normal

Direction RGT

Enlarge X 1

Enlarge Y 1

Transparent Italic

Bold

Output Memory  unchecked

Lamp Memory  unchecked

Output Action Momentary

 (ignored)

Function Screen: 1

[Character] tab window

No.0 "NEXT"

[Char. Prop.] dialog (No. 0)

Char. Type Normal

Foreground Black

Transparent  checked

Italic  unchecked

2. Set the screen title and boxes as shown below:

Rotate Normal

Direction RGT

[Detail] tab window

Use ON Macro  unchecked

Use OFF Macro  unchecked

Use Interlock  unchecked

Process Cycle High Speed

[Color] tab window

Frame Color Black

ON  Color Red

OFF Color Silver color

Frame Typefl Type 1
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3. Create a display area by referring to "Setting of the Display Area" in "Creation of

the Edit Screen for Memory Card Names and Numbers, File Names, and Record

Names" on page Option-9.  Set properties as shown below:
Part selection  No. 11 in file [Parts_e.z7p]

Division No. 0

In-area Prop.

Foreground White

Tile No. 0 (extreme left)

Creation of the Data Transfer Screen

By pressing the [PLC > Memory Card] switch, data is transferred from the PLC

memory to a specified area on the memory card.  (File No. 0 on the memory card is

fixed for data transfer in this example, thus desired record numbers are specified.)   By

pressing the [Memory Card > PLC] switch, data is transferred from a specified area on

the memory card to the PLC memory.

1. Click the [Next] icon.  The [Screen [11] Edit] window is displayed.  Click slate

blue (No. 3 from the right) for [Back Color] in the [Screen Setting] dialog.

2. Click the [Memory Card Mode] icon from the tool bar.
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Display area

The memory card parts tool bar is displayed.
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Click [OK], and place the area as shown on the previous page.

Reduce the Y size of the area by 3 grids.

How to change the size of the display area:
Select [Display Environment] from the [Display] menu.  The [Display Environment] dialog
is displayed.  Open the [Grid] tab window and set as shown below:

Grid Dsp. checked
Grid Color Red
Grid Type 1-Byte

1-byte grids are displayed.  Enlarge the placed area based on the grids.

4. Place the card name and number display parts by referring to "Setting of the Card

Name and Number Display Parts" on page Option-10.  Set properties in the same

manner.

5. Place the file name and number display parts by referring to "Setting of the File

Name and Number Display Parts" on page Option-11.  Set properties in the same

manner.

6. Place the record name and number display parts by referring to "Setting of the

Record Name and Number Display Parts" on page Option-12.  Set properties in

the same manner.

Card number
Card name

File number

File name

Record number

Record name
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Switch for

transfer from the

ZM-80 to the PLC

7. Place the file selection and record selection switches by referring to "Setting of the

Selection and Edit Switches" on page Option-12.

Set properties in the same manner except that the switch OFF color is purple.

8. Create the switch for data transfer from the memory card to the PLC.

1) Click the [Memory Card Switch] icon from the memory card parts tool bar.

The pull-down menu is displayed.

2) Select [Data Transfer ZM-80 > PLC].

Enlarge the switch part by 3 grids in the X direction so as to place the name

"Memory Card > PLC" on the part.  Set properties as shown below and place

the switch part referring to the figure above.

•[Data Transfer ZM-80 > PLC]

File selection switch

Record selection

switch
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Transparent  checked

Italic  unchecked

Rotate Normal

Direction RGT

[Detail] tab window

Use ON Macro  unchecked

Use OFF Macro  unchecked

Use Interlock  unchecked

Process Cycle High Speed

[Color] tab window

ON Color Yellow

OFF Color Mahogany

(No.6 from the right)

Division No. 0

Draw Mode REP

Output Memory  unchecked

Lamp Memory  unchecked

Output Action Momentary

 (ignored)

Function Data Transfer V6 -> PLC

[Character] tab window

No.0 Memory Card > PLC

[Char. Prop.] dialog

Char. Type Normal

Foreground White

Part selection  No. 9 in file [Parts_e.z7p]

[Main] tab window
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[Main] tab window

Division No. 0

Draw Mode REP

Output Memory  unchecked

Lamp Memory  unchecked

Output Action Momentary

(ignored)

Function Data Transfer PLC -> ZM-80

[Character] tab window

No.0 PLC > Memory Card

[Char. Prop.] dialog

Char. Type Normal

Foreground White

      Transparent  checked

Italic  unchecked

Rotate Normal

Direction RGT

[Detail] tab window

Use On Macro  unchecked

Use OFF Macro  unchecked

Use Interlock  unchecked

Process Cycle High Speed

[Color] tab window

ON Color Yellow

OFF Color Navy Blue(No.7 from

the right)

Switch for

transfer from the

PLC to the ZM-80

9. Create the switch for data transfer from the PLC to the memory card.

1) Click the [Memory Card Switch] icon from the memory card parts tool bar.

The pull-down menu is displayed.

2) Select [Data Transfer PLC > ZM-80].

Enlarge the switch part by 3 grids in the X direction so as to place the name

"PLC > Memory Card" on the part.  Set properties as shown below and place

the switch part referring to the figure above.

•[Data Transfer PLC > ZM-80]

   Part selection  No. 9 in file [Parts_e.z7p]

10. Click the [Detail] icon from the memory card parts tool bar and set the

[Memory Card] dialog by referring to "[Detail] Settings for a Memory

Card" on page Option-7.
[Char. Prop] tab window

Char. Type Normal

Transparent  checked

Italic  unchecked

Enlarge X: 2 Y:2

Foreground Black

1) Specify the same memory address for [Memory] for both screens I and II in

this example.

2) When editing memory card names and numbers, file names and record

[Main] tab window

Division No. 0

Memory D606

Key Display Location BASE

Process Cycle Low Speed
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names, choose where to place the entry keys for [Key Display Location].

Choose one from "OVLP0" (overlap 0), "OVLP1", "OVLP2", and "BASE".

Editing is not conducted on screen II, thus the setting for this option is ignored.

The default "BASE" should remain unchanged.

3) Click [OK].  The [Memory Card] dialog is reduced to an icon and stored in the

[Part] auxiliary tool box in the lower left corner of the screen.

11. Click the [Quit] icon from the memory card parts tool bar.

12. 12. Create a data display part to check data transfer from the memory card (file No.

0) to the PLC memory.

The following is the data set for file No. 0 on the memory card.  (Select [System

Setting] from the [Item] menu.  Open the [0] tab window in the [Memory Card]

dialog.  Refer to page Option-3.)

No. of Data 12

Bytes for Record 6

Transfer Mode Data + Record Name

Memory D610

From the above setting, memory addresses D610, D611, and D612 are used for

record name storage, and D613 to D624 are used for data storage.

1) Set up a character display part for record names to be stored in the PLC memory

using the steps below.

Character

display part

Bytes 6

Flush L

[Char. Prop.] tab window

Char. Type Normal

Transparent  unchecked
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•[Char. Display] dialog

Part selection  No. 0 in file [Parts_e.z7p]

Click the [Char. Display] icon from the tool bar.  The [Char. Display] dialog

is displayed.  Set as shown below:

[Main] tab window

Division No. 0

Memory D610

[Type] tab window

Display Function No
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Place the part as shown on the previous page.

2)    Set up a numerical data display part.

Click [Num. Data Display] icon from the tool bar.  The [Num. Display]

dialog is displayed.  Set as shown below:

[Num. Display] dialog

Part selection  No. 0 in file [Parts_e.z7p]

Numerical data

display part

Italic  unchecked

Rotate Normal

Direction RGT

Spacing  unchecked

Enlarge X:2  Y:2

[Char. Prop.] tab window

Char. Type Normal

Transparent  unchecked

Italic  unchecked

Char. Size 1-Byte

 Rotate Normal

Direction RGT

Spacing  unchecked

Enlarge X:1 Y: 1

Foreground White

Background Slate blue

(No. 3 from the right)

[Detail] tab window

Process Cycle High Speed

Quantity X 3

Quantity Y 4

Memory INC  checked

Num. Data Memory D613

Step 1

Place the part as shown above.

3) Create the remaining 11 numerical data display parts using the [Multi Copy]

function. Click  [Multi Copy] icon.

[Main] tab window

Division No. 0

Memory D613

[Type] tab window

Display Function No

Digits 4

Decimal Point 0

Display Type DEC (w/o sign)

Input Type DEC

Data Length 1-Word

Zero Suppress  checked
Flush R

Dot

Interval

Direction
①②③�
④⑤⑥�

X Distance 25

Y Distance 20

Foreground White

Background Green

[Detail] tab window

Process cycle High speed



Option-25

O
p

tio
n

Memory card/Memory manager function

•[Box]

Foreground Blue

Tile No. 0 (extreme left)

Paint  checked

Frame  unchecked

•[Box]

Foreground Black

Tile No. 0 (extreme left)

Paint  checked

Frame  unchecked

•[Text]

"Data Transfer   Memory Card <->Data"

Foreground Yellow

Background Blue

Rotate Normal

Direction RGT

Enlarge X 2

Enlarge Y 2

Transparent Italic

Normal

•Set the texts "Card No.", "Card Name", "File No.",

"File Name", "Record No.", and "Record Name"

as shown below, and place them in their

respective positions.

Foreground Blue

Background White

Rotate Normal

Direction RGT

Enlarge X 1

Enlarge Y 1

Transparent Italic

Bold

•[Box]

Foreground White

Frame Color Purple

Tile No. 0 (extreme left)

Line Type No. 1 (2nd from the left)

Paint  checked

Frame  checked

•[Line]

Color Purple

Line Style No. 1

(2nd from the left)

•[Box]

Foreground White

Paint  unchecked

Line Type No. 0 (extreme left)

•[Line]

Color White

Line Style No. 0

(extreme left)
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Setting of the Screen Title and Boxes
Create the screen title and boxes as shown below:
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Display of Error Messages

Add a lamp and message display part to screen I (in the [Screen [10] Edit] window).  If

an error related to the memory card arises, the lamp will flash and a corresponding error

message will be indicated.

Clicking [OFF]: No setting

Clicking [ON]:

No.0 "Error"

No.1 "Occurring"

[Char. Prop.] dialog for both text Nos. 0 and 1

Char. Type Normal

Foreground Black

Check [B] (blink).

Transparent  checked

Italic  unchecked

Rotate Normal

Direction RGT

Enlarge X:1  Y:1

[Color] tab window

ON Color Yellow

OFF Color Silvercolor

Frame Type No Frame

1. Click the [Preview] icon.  The [Screen [10] Edit] window is displayed.  Specify

"1" for [Division No.] in the upper right corner of the screen.

2. Create a lamp using the steps below.

1) Click the [Lamp] icon from the tool bar.  The [Lamp] dialog is displayed.

Set properties as shown below:
Part selection  No. 0 in file [Parts_e.z7p]

Division No. 1

Draw Mode REP

Function Normal

Lamp Memory D600-00

Process Cycle High Speed

Lamp Message display part

Addition

2) Click [Place] and place the lamp on the screen as shown in the figure above.

They are displayed when an

error arises.

For checking, click the  icons  of

[ON(O)] to turn on the lamp on the screen.

Select [Switch/Lamp
Display] from the
[Display] menu, and
click [ON].  The
created lamp can be
checked on the screen.

ZM-70For
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3. Create the message display part.

1) Click the [Message Mode] icon from the tool bar.  The message mode parts

tool bar is displayed.

2) Click the [Display Area] icon from the message mode parts tool bar.  Set the

[Display Area] dialog as shown below:
Part selection  No. 0 in file [Parts_e.z7p]

Division No. 1

In area Propaty

Foreground Silvercolor

Tile No.0

3) Click [Place] and place the part on the screen in the same manner as the

following.

4) Modify the size of the display part.

Bring up grids to be referred to for modifying the display part size.

Select [Display Environment] from the [Display] menu.  Open the [Grid] tab

window in the [Display Environment] dialog.  Set as shown below:

Grid Dsp.  Chiecked.

Grid Color Red

Grid Type 1-Byte

Set the Y size approximately to 2 grids and the X size to 45 grids.

4. 4. Click the [Detail] icon from the message mode parts tool bar. The [Message]

dialog is displayed.
•[Message] dialog

[Main] tab window

Display Area Detail

      Message GNo. 0

Memory D601

Process Cycle Low Speed

Message

display part O
p
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Messages appear in
this display part when
errors arise.  The part
location can be
checked on the screen.
Select [Display
Environment] from the
[Display] menu.  Open
the [Detail] tab window
in the [Display
Environment] dialog,
and choose [Area].

Division No. 1

Action Area Area

Type Page

Action Select Message



Option-28

Memory card/Memory manager function

Error No. Details

No. 0 (blank)

No. 1 There is an error occurring within the memory card I/F board.

No. 2 ZM-1REC is not connected.

No. 3 ZM-80 and ZM-1REC are not connected.

No. 4 No memory card is inserted.

No. 5 Memory card format is different from the setting data.

No. 6 Memory card capacity is smaller than the setting data.

No. 7 The memory card is not compatible.

No. 8 (blank)

No. 9 (blank)

No. 10 Attempted to write to a memory card of FLASH ROM.

No. 11 The memory card is write-protected.

No. 12 There is an error in writing data to the memory card.

No. 13 (blank)

No. 14 The selected record or file number does not exist.

[Char. Prop.] tab window

Char. Type Normal

Transparent  checked

Italic  unchecked

Enlarge X: 1 Y: 2

Foreground Red, B (blink)

1)   Memory card status is written from the ZM-80 to the memory address specified for [I/F

Memory] in the [Memory Card] dialog.  (Select [System Setting] from the [Item]

menu, and click [Memory Card Setting].  The dialog is displayed.)

When memory address "n" is specified for [I/F memory], an error number, if arisen, is

stored in address "n + 1".  Specify address "n + 1" for [Memory] in the [Main] tab

window.

2)    Specify a message group number for [Message GNo.].  Register messages in this

group corresponding to the error numbers which can be stored in "n + 1".

Click [OK].  The [Message] dialog is reduced to an icon and stored in the [Part]

auxiliary tool box in the lower left corner of the screen.

5. Register the error messages as message edit group No. 3.

1) Select [Message] from the [Item] menu.  The [Message] dialog is displayed.

Specify "3" and click [OK].

2) The [Message [3] Edit] window is displayed.  Register the following

messages.

Error numbers which can
be stored in memory
address "n + 1" ([I/F
Memory]: "n"), and the
corresponding messages

3) Close the [Message [3] Edit] window and go back to the [Screen [10] Edit]

window.
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6. The lamp and the message display part should be displayed on screen II as well.

Copy these parts using the steps below:

1) Select [Item List] from the [Tool] menu.  The item list is displayed.

2) Division No. 1 is specified for the lamp and the message mode.  Select [By

Division] from the [Display] menu.

3) Select the lines for the lamp, error message, and message display part

belonging to division No. 1 as follows and copy them.

7. Open the [Screen [11] Edit] window.  Right-click the mouse and select [Paste]

from the pop-up menu.  The lamp and message display part are pasted to the

screen.

8. Double-click the lamp.  The [Lamp] dialog is displayed.  In the [Color] tab

window, click slate blue (No. 3 from the right) for [OFF Color].  Click [OK].

9. Double-click the display part.  The [Display Area] dialog is displayed.  Click slate

blue (No. 3 from the right) for [Foreground].  Click [OK].

Screen I and screen II have been completed.  Save the data.
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15 14 13

0000 0000 0 0 0 0 0 0

12 11 10 09 08 07 06 05 04 03 02 01 00

①Error②Battery voltage

n　CFM_STAT

ZM-80 Operation Check

While referring to "Chapter 3 Screen Data Transference", transfer the created screen

data to the ZM-80 and check that the ZM-80 operates properly.

1. Open the "Memory Card Edit Screen" (screen I).  The error indicator

lamp at the lower-left corner blinks, and the current error message

"Memory card format is different from the setting data." also blinks.

2. Monitor memory addresses D600 (specified for [I/F memory]) and D601.

D600 H0001

Indicates that an error is occurring on the memory card.

D601 H0005

Indicates that error No. 5 "Memory card format is different from the setting data."

(or "The memory card is not formatted".) has occurred.

About [I/F Memory]
Memory card status is written from the ZM-80 to the PLC.  The top memory address is
specified for [I/F Memory].  Memory is allocated as follows:

These addresses become
effective only when memory card
mode is set on the screen.

n CFM_STAT

n+1 CFM_ERRNo

n+2 CFM_CARDNo

n+3 CFM_FILENo

n+4 CFM_RECODNo

n+5 CFM_TRFIN

The newest data is always
written here.

1)    Error (bit 0)
If an error related to the memory card has occurred, this bit is set (ON).  The error
number is stored in "CFM_ERRNo" (n + 1).

2)    Battery voltage (bit 7)
When battery voltage of the memory card decreases, this bit is set (ON).  Replace
the memory card as soon as possible.

n+1    CRM_ERRNo
When bit 0 of "CFM_STAT" (n) is set (an error has occurred), the corresponding
error number is stored in "CFM_ERRNo" (n + 1).   For the details corresponding to
respective error numbers, refer to page Option-28.

Memory Contents[I/F memory]: "n"
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15 14 13

0 0 0 0 0 0 0 0 0

12 11 10 09 08 07 06 05 04 03 02 01 00

①Error②Formatting
Transferring from ZM-80 to PLC

Transferring from PLC to ZM-80

④Format completed
Transfered from ZM-80 to PLC completed

Transfered from PLC to ZM-80 completed

n+5　CFM_STAT

③�

⑤�

n+2    CRM_CARDNo
The current memory card number is stored.

n+3    CRM_CARDNo
The selected or transferred file number is stored.

n+4    CRM_CARDNo
The selected or transferred record number is stored.

1) Error
When an error occurs during formatting or transferring, this bit is set (ON).

2) Formatting
While formatting, this bit is set (ON).

3) Transferring from ZM-80 to PLC/Transferring from PLC to ZM-80
While transferring, respective bits are set (ON).

4) Format completed
When formatting has been completed, this bit is set (ON).

5) Transferring from ZM-80 to PLC completed/Transferring from PLC to ZM-80
         completed When transferring has been completed, respective bits are set (ON).

After checking that transferring has been completed, reset these bits (OFF).

3. Format the memory card.

1) To format the memory card as specified in the [Memory Card] dialog, press

the [Format] switch.

Monitor memory address D605.

While formatting, bit 9 is set (ON).  Upon completion, bit 13 is set (ON).

D605 H0-> H200 (momentarily)-> H2000

2) Once bit 13 (format completed) is set (ON), it remains set.  After checking

that formatting has been completed, reset the bit (OFF).

Format the memory card before starting to use it.

D605 H2000 -> H0000

 Format the memory card before you use it.
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4. The error display goes off.

This confirms that no error is occurring.

Monitor D600 and D601.

D600 H0000 D601 H0000

Memory Card Editing
1. Specify the memory card number.

1) Press the [Card No.] switch.  The overlap with entry keys appears.

2) Key in "1" and press [ENT].  "1" is specified for "Card No.".

2. Specify the memory card name.

Press the [Card Name Edit] switch.  The overlap with entry keys appears.

Key in "C", "A", "R", "D" and "1", and press [ENT].  "CARD 1" is specified for

"Card Name".

0

CARD1
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3. Specify the file name.

1) Check that the [File Select] switch is lit, and press the [File Name Edit]

switch.

2) Press "0." in the display area.  File No. 0 is

selected and "0" is indicated on the screen.

The overlap with entry keys appears at the same

time.

3) Key in "F", "I", "L", "E", "(space)", and "0", and

press [ENT].

"FILE 0" is entered for the file name, and "FILE

0" is indicated in the display area at the same time.

4) Press "1." in the display area.

File No. 1 is selected and "1" is indicated on the screen.

The overlap with entry keys appears at the same time.

5) Key in "F", "I", "L", "E", "(space)", and "1", and press [ENT].  "FILE 1" is

entered for the file name, and "FILE 1" is indicated in the display area.

6) Press the lit [File Name Edit] switch.  It goes off.

4.  Specify the record name.

1) Enter the record names of file No. 0.

Select "0.FILE 0" in the display area.  The [Record Select] switch lights up.

2) Press the [Record Name Edit] switch.  The switch lights up.
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3) Press "0." in the display area.

Record No. 0 is selected, and "0" is indicated on the screen.  The overlap

with entry keys appears at the same time.

4) Key in "A", "A", "A", "A", "A", and "A", and press [ENT].  "AAAAAA" is

entered for the record name, and "AAAAAA" is indicated in the display area.

5) Press ".1" in the display area.

Record No. 1 is selected, and "1" is indicated on the screen.  The overlap

with entry keys appears at the same time.

6) Key in "B", "B", "B", "B", "B", and "B", and press [ENT].  "BBBBBB" is

entered for the record name, and "BBBBBB" is indicated in the display area.

7) Press "2." in the display area.

Record No. 2 is selected, and "2" is indicated on the screen.  The overlap

with entry keys appears at the same time.

8) Key in "C", "C", "C", "C", "C", and "C", and press [ENT].  "CCCCCC" is

entered for the record name, and "CCCCCC" is indicated in the display area.

9) Specify the record names of file No. 1 in the same manner.

Press the [File Select] switch.

Select "1.FILE 1", and specify record names as follows:

Record No. 0 Record name "XXXXXXXX"

Record No. 1 Record name "YYYYYYYY"

10) Press the lit [Record Name Edit] switch.  It goes off.

The above step completes memory card editing.

Open screen II by pressing the [Next] switch.
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Data Transfer between Memory Card & PLC
Data transfer is executed between file No. 0 on the memory card and the PLC (memory:

D610 to D624) on this screen.

The memory card name and number, file names, and record names specified on the

previous screen are stored on the memory card directly.  File No. 0 is so set that record

names are stored in the PLC memory as well.

1. Transfer the record name for file No. 0 and record No. 0 of the memory card to

memory addresses D610 to D612 using the steps below:

1) The [File Select] switch blinks.  Press "0.FILE 0" in the display area.

2) The [Record Select] switch blinks.  Press "0.AAAAAA".

3) Press the [Memory Card > PLC] switch.  The record name and the set data

are transferred to the PLC memory.  The screen appears as shown in the

right-hand figure.

Record 0

Record Name

Data 0

Data 1

Data 2

Data 3

Data 4

Data 5

Data 6

Data 7

Data 8

Data 9

Data 10

Data 11

Data 0

Data 1

Data 2

Data 3

Data 4

Data 5

Data 6

Data 7

Data 8

Data 9

Data 10

Data 11

Data 0

Data 1

Data 2

Data 3

Data 4

Data 5

Data 6

Data 7

Data 8

Data 9

Data 10

Data 11

File 0

Memory Card

Record 1 Record 2

Record Name

D610

D611

D612

D613

D614

D615

D616

D617

D618

D619

D620

D621

D622

D623

D624

Addresses for the
record name

Addresses
for the data

PLC
Memory

Record Name

Record Name

Record Name

Record Name

Record Name

Record Name

Record Name

Card No.
Card Name
File No.
File Name

Record No.
Record Name

Data Transfer　Memory Card<-> Data

Memory Card�
    ＞PLC

      PLC＞�
Memory Card

CARD1

FILE  0

1

0

0

0

0

0

0

0

0

0

0

0

0

0

AAAAAA
0

0.AAAAAA

AAAAAA

1.BBBBBB
2.CCCCC Record Select

File Select

Press this switch.

The record name and data are transferred

to the PLC memory.

The names and numbers of the

selected card, file, and record are

indicated.
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Card No.
Card Name
File No.
File Name

Record No.
Record Name

Data Transfer　Memory Card<-> Data

Memory Card�
    ＞PLC

      PLC＞�
Memory Card

CARD1

FILE  0

1

0

0

0

0

0

0

0

0

0

0

0

0

0

BBBBBB
1

0.AAAAAA

BBBBBB

1.BBBBBB
2.CCCCC Record Select

File Select

1111

4444

7777

1000

2222

5555

8888

1100

3333

6666

9999

1200

BBBBBB

2. Monitor memory address D605.  Bit 10 is set (ON) during the transfer.  Bit 14 is

set (ON) on completion.

D605 H0 -> H400 -> H4000

3. Specify data for memory addresses D613 to D624 as follows:

4. Press the [PLC > Memory Card] switch.

The record name and the set data are transferred to the

memory card.

5. Transfer the record name for file No. 0 and record No. 1 of the memory card to

memory addresses D610 to D612 using the steps below:

1) The [Record Select] switch blinks.  Press "1.BBBBBB".

2) Press the [Memory

Card > PLC] switch.

The record name and

the set data are

transferred to the PLC

memory.  The screen

appears as shown in the

right-hand figure.

6. Specify data for memory addresses D613 to D624 as follows:

7. Press the [PLC > Memory Card] switch.

The record name and the set data are transferred to the memory

card.

Memory D613 D614 D615 D616 D617 D618 D619 D620 D621 D622 D623 D624

Data 1 2 3 4 5 6 7 8 9 10 11 12

Press this switch.

The record name and data are transferred to the PLC memory.

1

4

7

10

2

5

8

11

3

6

9

12

AAAAAA

D613 D614 D615 D616 D617 D618 D619 D620 D621 D622 D623 D624

1111 2222 3333 4444 5555 6666 7777 8888 9999 1000 1100 1200
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About [Memory] in the [Memory Card] dialog
Memory contents from the top address are shown below:

[Memory]: "n" Memory Contents

n RCV_FLAG

n+1 RCV_FILENo

n+2 RCV_RECDNo

n    RCV_FLAG
1) Record name edit prohibited (bit 0)

When this bit is set (ON), record name editing is prohibited.

Card No.
Card Name
File No.
File Name

Record No.
Record Name

Data Transfer　Memory Card<-> Data

Memory Card�
    ＞PLC

      PLC＞�
Memory Card

CARD1

FILE  0

1

1111

4444

7777

1000

2222

5555

8888

1100

3333

6666

9999

1200

0

CCCCCC
2

0.AAAAAA

CCCCCC

1.BBBBBB
2.CCCCC Record Select

File Select

8. Transfer the record name for file No. 0 and record No. 2 of the memory card to

memory addresses D610 to D612 using the steps below:

1) The [Record Select]

switch blinks.  Press

"2.CCCCCC".

2) Press the [Memory Card

> PLC] switch.  The

record name and the set

data are transferred to the

PLC memory.  The screen

appears as in the right-

hand figure.

15 14 13

0 0 0 0 0

12 11 10 09 08 07 06 05 04 03 02 01 00

①Record name edit prohibited

②File name edit prohibited�
�

③Card name and number edit prohibited�
�④Format prohibited�

�⑤Data transfer prohibited�
�

⑥Record lock�
�⑦File lock

⑧File selection�
�⑨Quick selection

⑩Transfer from ZM-80 to PLC

⑪Transfer from PLC to ZM-80

Data Transfer by Commands from the PLC
The previous section described the data transfer procedure between the ZM-80 and a

PLC using the switches on the ZM-80.  Data transfer is also possible by commands

from the PLC.  In such a case, three words from the top memory address specified for

[Memory] in the [Memory Card] dialog are used.  (The dialog is displayed by clicking

the [Detail] icon from the memory card parts tool bar.)
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2) File name edit prohibited (bit 1)
When this bit is set (ON), file name editing is prohibited.

3) Card name and number edit prohibited (bit 2)
When this bit is set (ON), card name and number editing are prohibited.

4) Format prohibited (bit 3)
When this bit is set (ON), memory card formatting is prohibited.

5) Data transfer prohibited (bit 4)
When this bit is set (ON), data transfer between the ZM-80 (memory card) and
the PLC is prohibited.

6) Record lock (bit 8)
When this bit is set (ON), the use of the [Record Select] switch is prohibited.  In
this case, a record number can be specified directly by "n + 2" [RCV_RECDNo] in
the PLC memory.

7) File lock (bit 9)
When this bit is set (ON), the use of the [File Select] switch is prohibited.  In this
case, a file number can be specified directly by "n + 1" [RCV_FILENo] in the PLC
memory.

8) File selection (bit 10)
This bit determines whether or not to display buffering file names in the display
area for selecting a file.

0: Display 1: Do not display

9) Quick selection (bit 12)
When bit 14 (transferring from the ZM-80 to the PLC) or bit 15 (transferring from

  the PLC to the ZM-80) is set (ON) while this bit is set (ON), data is transferred
  upon selection of a record.

10) Transfer from ZM-80 to PLC (bit 14)
Data is transferred from the ZM-80 (memory card) to the PLC at the edge of [0 -> 1].

11) Transfer from PLC to ZM-80 (bit 15)
Data is transferred from the PLC to the ZM-80 (memory card) at the edge of [0 -> 1].

n+1 RCV_FILENo
This bit is used for specifying a file number from the PLC when bit 9 of
[RCV_FLAG] (n) is set (ON).  File numbers can be specified for this address.

n+2 RCV_RECDNo

This bit is used for specifying a record number from the PLC when bit 8 of

[RCV_FLAG] (n) is set (ON).  Record numbers can be specified for this

address.
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Specify file No. 0 and record No. 1 from the PLC, and transfer data from the ZM-80

(memory card) to the PLC.

1. Set bit 8 and bit 9 of memory address D606.

The [Record Select] switch goes off.

D606 H0300

2.  Specify file No. 0 for D607.

D607 H0000

3. Specify record No. 1 for D608.

Record No. 1 is selected, and "1" is indicated on the screen.

D608 H0001

4. Set bit 14 of D606.

D608 H4000

5. The screen appears as follows:

1111

4444

7777

1000

2222

5555

8888

1100

3333

6666

9999

1200

BBBBBB
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Q&A

Q: When the [Format] switch is pressed, an error sound is emitted (pips) and the

switch does not work.

A: Check bit 3 (format prohibited) of the memory address specified for

[Memory] in the [Memory Card] dialog (displayed by clicking the

[Detail] icon from the memory card parts tool bar).  The bit may be set

(ON).

The division number for the switch may differ from the division number

specified in the [Memory Card] dialog.

Check whether either of the modular port is assigned as "Memory

Card" is chosen in [P2 ] tab of the [Others] in [System Setting]

The memory card may be write-protected.

Q: When changing the file name, the [File Name Edit] switch is pressed and the

overlap with entry keys is displayed.  However, pressing any key creates an error

sound (pips), and the key does not work.

A: Has the entry mode been set on the overlap?

Is "Memory Card" specified for [Type] in the [Entry] dialog?

Is the same division number specified for [Division No.] in the [Entry] dialog

and for the entry keys?

Check the [Type] tab window in the [Char. Display] ([Num. Display]) dialog

set for the display part on the overlap.  Is "Entry Display" specified for

[Display Function]?

Q: When the [File Name Edit] switch is pressed, an error sound is emitted (pips) and

the switch does not work.

A: Check bit 1 (file name edit prohibited) of the memory address specified for

[Memory] in the [Memory Card] dialog.  The bit may be set (ON).
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